THE SPECIFICATIONS AND INFORMATION REGARDING THE PRODUCTS IN THIS MANUAL ARE SUBJECT TO CHANGE WITHOUT NOTICE. ALL STATEMENTS, INFORMATION, AND RECOMMENDATIONS IN THIS MANUAL ARE BELIEVED TO BE ACCURATE BUT ARE PRESENTED WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED. USERS MUST TAKE FULL RESPONSIBILITY FOR THEIR APPLICATION OF ANY PRODUCTS.

THE SOFTWARE LICENSE AND LIMITED WARRANTY FOR THE ACCOMPANYING PRODUCT ARE SET FORTH IN THE INFORMATION PACKET THAT SHIPPED WITH THE PRODUCT AND ARE INCORPORATED HEREIN BY THIS REFERENCE. IF YOU ARE UNABLE TO LOCATE THE SOFTWARE LICENSE OR LIMITED WARRANTY, CONTACT YOUR CISCO REPRESENTATIVE FOR A COPY.

The Cisco implementation of TCP header compression is an adaptation of a program developed by the University of California, Berkeley (UCB) as part of UCB's public domain version of the UNIX operating system. All rights reserved. Copyright © 1981, Regents of the University of California.

NOTWITHSTANDING ANY OTHER WARRANTY HEREIN, ALL DOCUMENT FILES AND SOFTWARE OF THESE SUPPLIERS ARE PROVIDED “AS IS” WITH ALL FAULTS. CISCO AND THE ABOVE-NAMED SUPPLIERS DISCLAIM ALL WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING, WITHOUT LIMITATION, THOSE OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OR ARISING FROM A COURSE OF DEALING, USAGE, OR TRADE PRACTICE.

IN NO EVENT SHALL CISCO OR ITS SUPPLIERS BE LIABLE FOR ANY INDIRECT, SPECIAL, CONSEQUENTIAL, OR INCIDENTAL DAMAGES, INCLUDING, WITHOUT LIMITATION, LOST PROFITS OR LOSS OR DAMAGE TO DATA ARISING OUT OF THE USE OR INABILITY TO USE THIS MANUAL, EVEN IF CISCO OR ITS SUPPLIERS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

Any Internet Protocol (IP) addresses and phone numbers used in this document are not intended to be actual addresses and phone numbers. Any examples, command display output, network topology diagrams, and other figures included in the document are shown for illustrative purposes only. Any use of actual IP addresses or phone numbers in illustrative content is unintentional and coincidental.

All printed copies and duplicate soft copies of this document are considered uncontrolled. See the current online version for the latest version.

Cisco has more than 200 offices worldwide. Addresses and phone numbers are listed on the Cisco website at www.cisco.com/go/offices.

Cisco and the Cisco logo are trademarks or registered trademarks of Cisco and/or its affiliates in the U.S. and other countries. To view a list of Cisco trademarks, go to this URL: www.cisco.com/go/trademarks. Third-party trademarks mentioned are the property of their respective owners. The use of the word partner does not imply a partnership relationship between Cisco and any other company. (1721R)

© 1994–2019 Cisco Systems, Inc. All rights reserved.
Configure the Media Routing PG and PIM 10
Configure Call Type 11
Configure Dialed Number/Script Selector 11
Configure ECC Variables 11
Set up the Media Routing PG and PIM 12
Configure Social Miner for a Voice Callback Agent Request 12
Create Feed 13
Create Campaign 13
Create Notification 14
Agent Request Script 14
Create Agent Request Script 15
Use the Sample Code to Create a Customer Callback Request 16
Agent Request Reporting 17

CHAPTER 3 Agent Greeting 19
Capabilities 19
Agent Greeting Phone Requirements for Local Agents 20
Agent Greeting Call Flows 20
Agent Greeting Considerations 21
Configure Agent Greeting 22
Initial Setup 22
Configuration Requirements 22
Agent Greeting Deployment Tasks 24
Configure Gateway 25
Republish the tcl scripts to VXML Gateway 25
Set Cache Size on VXML Gateway 25
Configure Unified CVP 25
Configure FTP Enabled in Server Manager 25
Configure Unified CVP Media Server 27
Configure the Call Studio Scripts for Record Agent Greeting 28
Configure Unified CCE 29
Create Agent Greeting Play Script 29
Create Agent Greeting Recording Script 30
Import the Example Agent Greeting Scripts 31
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access Context Service Logs</td>
<td>53</td>
</tr>
<tr>
<td>View Context Service Customer Record Statistics</td>
<td>53</td>
</tr>
<tr>
<td>Troubleshooting Context Service Registration Process</td>
<td>54</td>
</tr>
<tr>
<td>Cannot Configure Cisco SocialMiner</td>
<td>54</td>
</tr>
<tr>
<td>Cannot Register Context Service</td>
<td>54</td>
</tr>
<tr>
<td>Cannot Deregister Context Service</td>
<td>54</td>
</tr>
<tr>
<td>Context Service Registration Incomplete</td>
<td>55</td>
</tr>
<tr>
<td>Context Service Registration Status Invalid</td>
<td>55</td>
</tr>
<tr>
<td>Unable to Determine Context Service Registration Status or Client Settings</td>
<td>56</td>
</tr>
<tr>
<td>Context Service Registration Incomplete Due to Page Refresh</td>
<td>56</td>
</tr>
<tr>
<td>Troubleshooting Context Service Connectivity Process</td>
<td>56</td>
</tr>
<tr>
<td>Activity Operation</td>
<td>56</td>
</tr>
<tr>
<td>Context Service Connection Data Not Published</td>
<td>57</td>
</tr>
<tr>
<td>Activity Count Mismatch Between CVP and Other Components</td>
<td>57</td>
</tr>
<tr>
<td>Activity Failure in Debug Mode</td>
<td>57</td>
</tr>
<tr>
<td>Periodic Logging of Context Service SDK Connector Status</td>
<td>58</td>
</tr>
<tr>
<td>Periodic Logging of Context Service JMX Counters</td>
<td>58</td>
</tr>
<tr>
<td>Troubleshooting Context Service Runtime Process</td>
<td>58</td>
</tr>
<tr>
<td>Unable to Access Customer Context Information</td>
<td>58</td>
</tr>
<tr>
<td>Deregister a Component with Context Service</td>
<td>58</td>
</tr>
</tbody>
</table>

**CHAPTER 6**

**Courtesy Callback** 61

- Courtesy Callback 61
- Courtesy Callback Call Flows 61

**Configure Courtesy Callback** 63

- Configure Gateway 63
  - Configure the VXML Gateway for Courtesy Callback 63
  - Configure the Ingress Gateway for Courtesy Callback 64
  - Configure CUBE-E for Courtesy Callback 65

- Configure Unified CVP 66
  - Configure the Reporting Server for Courtesy Callback 66
  - Configure the Call Studio Scripts for Courtesy Callback 67
  - Configure the Media Server for Courtesy Callback 69

- Configure Unified CCE 69
Configure the ICM Script for Courtesy Callback 69

CHAPTER 7  Database Integration  73
  Database Integration  73
  Configure Database Integration  73
  Configure Unified CCE  73
    Configure ICM Database Lookup  73
  Configure Unified CVP  75
  Configure VXML Database Element  75

CHAPTER 8  Music on Hold  79
  Capabilities  79
    Hold and Resume  79
      Multicast Music-on-Hold  79
    Music on Hold with Mobile Agent  79
  Configure Music on Hold  80
    Configure Unified Communication Manager  80
    Configure Music On Hold Server Audio Source  80
    Set up Service Parameters for Music on Hold  81
    Set up Phone Configuration for Music on Hold  81

CHAPTER 9  Precision Queue  83
  Capabilities  83
    Precision Queues  83
  Skill Groups or Precision Queues?  84
  Attributes  85
  Precision Queue Call Flow Example  86
  Scripts for Precision Queues  86
  Precision Queue Script Node  87
  Queuing Behavior of the Precision Queue Node  87
  Dynamic Limits for Skill Groups and Precision Queues Per Agent  87
  Initial Setup  89
    Add Attributes  89
    Search for Agents  90
Assign Attributes to Agents  90
Add Precision Queue  90
Consider If Formula for Precision Queue  93
Build Precision Queue Steps  94
Configure a Static Precision Queue  95
Configure a Dynamic Precision Queue  96

CHAPTER 10
Post Call Survey  97
Post Call Survey  97
Post Call Survey Use Case  97
Post Call Survey Design Impacts  97
Configure Post Call Survey  98
Configure Unified CVP  98
Configure Unified CCE  99
Configure ECC Variable  99

CHAPTER 11
Task Routing  101
Task Routing  101
Task Routing Deployment Requirements  103
Supported Functionality for Third-Party Multichannel Tasks  103
Plan Task Routing Media Routing Domains  104
Plan Dialed Numbers  107
Skill Group and Precision Queue Routing for Nonvoice Tasks  108
Agent State and Agent Mode  108
SocialMiner and Finesse Task States  109
Task Routing API Request Flows  110
Task Routing API Basic Task Flow  110
Task Routing API Agent Transfer Flow  114
Task Routing API RONA Flow  115
Task Routing API Agent Sign Out with Tasks Flows  115
Failover and Failure Recovery  117
Task Routing Setup  120
Initial Setup  120
Configure Finesse with the AW  122
## Contents

**Chapter 12**

- Unified Communications Manager Extension Mobility 135
  - Capabilities 135
  - Configuration 136

**Chapter 13**

- Whisper Announcement 137
  - Capabilities 137
  - While a Whisper Announcement Is Playing 137
  - Whisper Announcement Call Flows 138
  - Whisper Announcement Design Impacts 138
    - Whisper Announcement Media Files 139
    - Whisper Announcement with Transfers and Conferences 139
    - Whisper Announcement Sizing Considerations 139
  - Configure Whisper Announcement 139
    - Configure Gateway 140
    - Configure Unified CVP 140
      - Create Whisper Announcement Audio Files 140
      - Deploy Whisper Announcement Audio Files to Media Server 140
      - Configure the Whisper Announcement Service Dialed Numbers 141
Configure Dialed Numbers 141

Configure Unified CCE 142
  Create Whisper Announcement Script 142
  Specify Whisper Announcement Call Variable 142
  Specify Unified CVP Media Server Information 143
  Specify Whisper File Locale and Application Directories 144
  Test Whisper Announcement File Path 145
  Other Script Settings That Are Required for Whisper Announcement 145
  Fail-Safe Timeout for Whisper Announcement in Unified CCE 146
  Whisper Announcement Sample Scripts 146

Reporting and Serviceability 148
  Component Failure and Whisper Announcement 148
  Failure to Access CVP Media Server 148
  Whisper Announcement in Agent Desktop Software 148
  Using Agent Greeting with Whisper Announcement 148
Preface

- Change History, on page xi
- About This Guide, on page xii
- Audience, on page xii
- Related Documents, on page xiii
- Obtaining Documentation and Submitting a Service Request, on page xiii
- Field Alerts and Field Notices, on page xiii
- Documentation Feedback, on page xiii
- Conventions, on page xiv

Change History

This table lists changes made to this guide. Most recent changes appear at the top.
<table>
<thead>
<tr>
<th>Changes</th>
<th>Section</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial release of this document</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Added the following HCS for CC features:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Agent Greeting</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Whisper Announcement</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Courtesy Callback</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• DB Integration (DB Lookup)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Outbound Option</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Post Call Survey</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• A-law Codec</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• CM Silent Monitoring</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Music on Hold</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Agent Request</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Extension Mobility</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Precision Queue</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Task Routing</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

About This Guide

This guide explains features you can use in conjunction with Cisco Hosted Collaboration Solutions for Contact Center. For each feature, there is a description, procedures for initial setup, and details on the functionality the feature provides.

Audience

This document is prepared for:

• Contact center administrators who configure and run the contact center, manage agents and supervisors, and address operational issues.

• Contact center supervisors, who lead agent teams and are responsible for team performance

This document is written with the understanding that your system has been deployed by a partner or service provider who has validated the deployment type, virtual machines, and database and has verified that your contact center can receive and send calls.
Related Documents

<table>
<thead>
<tr>
<th>Document or resource</th>
<th>Link</th>
</tr>
</thead>
</table>

Obtaining Documentation and Submitting a Service Request

For information on obtaining documentation, using the Cisco Bug Search Tool (BST), submitting a service request, and gathering additional information, see What's New in Cisco Product Documentation.

To receive new and revised Cisco technical content directly to your desktop, you can subscribe to the What's New in Cisco Product Documentation RSS feed. RSS feeds are a free service.

Field Alerts and Field Notices

Cisco can modify its products or determine key processes to be important. These changes are announced through use of the Cisco Field Alerts and Cisco Field Notices. You can register to receive Field Alerts and Field Notices through the Product Alert Tool on Cisco.com. This tool enables you to create a profile to receive announcements by selecting all products of interest.

Sign in www.cisco.com and then access the tool at https://www.cisco.com/cisco/support/notifications.html.

Documentation Feedback

To provide comments about this document, send an email message to the following address: contactcenterproducts_docfeedback@cisco.com.

We appreciate your comments.
# Conventions

This document uses the following conventions:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
</table>
| **boldface** font | Boldface font is used to indicate commands, such as user entries, keys, buttons, and folder and submenu names. For example:  
  - Choose *Edit* > **Find**.  
  - Click **Finish**. |
| **italic** font | Italic font is used to indicate the following:  
  - To introduce a new term. Example: A *skill group* is a collection of agents who share similar skills.  
  - A syntax value that the user must replace. Example: IF *(condition, true-value, false-value)*  
  - A book title. Example: See the *Cisco Unified Contact Center Enterprise Installation and Upgrade Guide*. |
| **window font** | Window font, such as Courier, is used for the following:  
  - Text as it appears in code or that the window displays. Example:  
    `<html><title>Cisco Systems, Inc. </title></html>` |
| `< >` | Angle brackets are used to indicate the following:  
  - For arguments where the context does not allow italic, such as ASCII output.  
  - A character string that the user enters but that does not appear on the window such as a password. |
CHAPTER 1

A-law Codec

- Configure Gateway, on page 1
- Configure Unified CVP, on page 3
- Configure Unified Communication Manager, on page 4

Configure Gateway

- Configure Ingress Gateway, on page 1
- Configure VXML Gateway, on page 2

Configure Ingress Gateway

**Procedure**

**Step 1**  
Add the voice class codec 1 to set the codec preference in dial-peer:

```plaintext
voice class codec 1  
  codec preference 1 g729r8  
  codec preference 2 g711alaw
```

**Example:**

```plaintext
dial-peer voice 70021 voip
  description Used for Switch leg SIP Direct
  preference 1
  max-conn 225
  destination-pattern xxxx..... # Customer specific destination
  session protocol sipv2
  session target ipv4:###.###.###.### # IP Address for Unified CVP
  session transport tcp
  voice class codec 1
  voice-class sip options-keepalive up-interval 12 down-interval 65 retry 2
dtmf-relay rtp-nte
  no vad
```

**Step 2**  
Modify the dial-peer to specify the codec explicitly for a dial-peer:

```plaintext
dial-peer voice 9 voip
  description For Outbound Call for Customer
```
destination-pattern <Customer Phone Number Pattern>
session protocol sipv2
session target ipv4:<Customer SIP Cloud IP Address>
session transport tcp
voice-class sip rel1xx supported "100rel"
voice-class sip options-keepalive up-interval 12 down-interval 65 retry 2
dtmf-relay rtp-nte
codec g711alaw
no vad

dial-peer voice 10 voip
description ***To CUCM Agent Extension For Outbound***
destination-pattern <Agent Extension Pattern to CUCM>
session protocol sipv2
session target ipv4:<CUCM IP Address>
voice-class sip rel1xx supported "100rel"
dtmf-relay rtp-nte
codec g711alaw

---

**Configure VXML Gateway**

 Procedure

Modify the following dial-peer to specify the codec explicitly for a dial-peer:

dial-peer voice 919191 voip
description Unified CVP SIP ringtone dial-peer
service ringtone
incoming called-number 9191T
voice-class sip rel1xx disable
dtmf-relay rtp-nte
codec g711alaw
no vad

dial-peer voice 929292 voip
description CVP SIP error dial-peer
service cvperror
incoming called-number 9292T
voice-class sip rel1xx disable
dtmf-relay rtp-nte
codec g711alaw
no vad

dial-peer voice 7777 voip
description Used for VRU leg #Configure VXML leg where the incoming called
service bootstrap
incoming called-number 7777T
dtmf-relay rtp-nte
codec g711alaw
no vad

dial-peer voice 5 voip
description for SIP TTS Media Call
preference 1
session protocol sipv2
session target ipv4: <ASR primary server IP>
destination uri tts
voice-class sip options-keepalive up-interval 12 down-interval 65 retry 2
Configure Unified CVP

Unified CVP does not require any specific configuration in OAMP.

You must convert the following files to A-law:

1. C:\inetpub\wwwroot\en-us\app
2. C:\inetpub\wwwroot\en-us\app\ag_gr
3. C:\inetpub\wwwroot\en-us\sys
4. C:\Cisco\CVP\OPSConsoleServer\GWDownloads in OAMP server
5. C:\Cisco\CVP\VXMLServer\Tomcat\webapps\CVP\audio

• After converting the files in the OAMP server, access the Unified CVP OAMP page to upload the newly converted A-law files to the gateway.

• If gateways are previously used for u-law, then restart the gateway to clear the u-law files in the gateway cache.
Complete the following procedure to convert mu-law audio files to a-law format:

**Procedure**

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Copy the wav file from Unified CVP to your local desktop.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Go to All programs &gt; Accessories &gt; Entertainment.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Open the Sound Recorder.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Select File and click Open.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Browse for the mu-law audio file and click Open.</td>
</tr>
<tr>
<td>Step 6</td>
<td>Go to Properties.</td>
</tr>
<tr>
<td>Step 7</td>
<td>Click Convert Now.</td>
</tr>
<tr>
<td>Step 8</td>
<td>Select CCITT A-Law from Format.</td>
</tr>
<tr>
<td>Step 9</td>
<td>Click OK.</td>
</tr>
<tr>
<td>Step 10</td>
<td>Select Files &gt; Save As and provide a filename.</td>
</tr>
<tr>
<td>Step 11</td>
<td>Copy the new a-law format file into the following directory of media server: C:\inetpub\wwwroot\en-us\app</td>
</tr>
</tbody>
</table>

**Enable Recording for Agent Greeting and Courtesy Callback**

Complete the following procedure to enable recording for Agent Greeting and Courtesy Callback.

**Procedure**

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Open the call studio and go to the callback entry application.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Double-click app.callflow.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Go to Record Name element settings and change the File Type to other (default is wav).</td>
</tr>
<tr>
<td>Step 4</td>
<td>Set the MIME type to audio/x-alaw-basic.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Set the File extension as wav</td>
</tr>
<tr>
<td>Step 6</td>
<td>Validate, save, and deploy the application.</td>
</tr>
<tr>
<td>Step 7</td>
<td>Restart the Unified CVP services.</td>
</tr>
</tbody>
</table>

**Configure Unified Communication Manager**

Complete the following procedure to provision a-Law through Cisco Unified Communications Manager:

---

*Cisco Hosted Collaboration Solution for Contact Center Features Guide, Release 12.0(1)*
Procedure

**Step 1**  Login to the Cisco Unified Communication Manager Administration page.

**Step 2**  Navigate to System > Service Parameter.

**Step 3**  Choose publisher server from Server drop-down list.

**Step 4**  Choose Cisco CallManager (Active) from Service drop-down list.

**Step 5**  In ClusterWide Parameters (System - Location and region), choose Enabled for All Devices from G.711 A-law Codec Enabled drop-down list.

**Step 6**  Choose Disable from following drop-down lists:

- G.711 mu-law Codec Enabled
- G.722 Codec Enabled
- iLBC Codec Enabled
- iSAC Codec Enabled

**Step 7**  Click Save.
Agent Request Feature Description

The Agent Request feature allows a customer to initiate a request on the web that results in a call from an agent.

To use Agent Request, your solution requires the Cisco SocialMiner optional component. Cisco SocialMiner works in a Contact Center Enterprise (Unified CCE) solution to process the request from its inception through the delivery of the callback.

Important

The Agent Request feature can be used only if the customer or a partner develops a custom application. There is sample code on DevNet (formerly Cisco Developer Network) that you can use to understand how to start building your custom application to submit callback requests to SocialMiner.

SocialMiner and Agent Request

SocialMiner provides the Callback API used by a custom application to request a phone call from a contact center agent.

The API works in conjunction with SocialMiner callback feeds, campaigns, and notifications to pass callback requests to the contact center for routing.

The Callback API:

- Allows custom applications to initiate a callback.
- Forwards the callback request and callback details to Unified CCE using a notification mechanism (the Connection to Unified CCE notification type) through a Media Routing (MR) connection.
• Allows custom applications to retrieve the state of the callback as well as the estimated wait time (EWT) until an agent becomes available.
• Allows custom applications to cancel a requested callback.

The Callback API supports the use of Call variables and ECC variables for callback requests. Call variables and ECC variables send customer-specific information with the request. When you create a callback contact, the social contact associated with the callback contact includes all of the specified variables as extension fields.

**Unified CCE and Agent Request**

When it receives an Agent Request, Unified CCE performs these tasks:

- Process the callback request.
- Route the callback request to an agent and place a call from the agent's phone to the customer.
- Notify SocialMiner that the agent has been selected.

**Agent Desktops and Agent Request**

Cisco Finesse supports Agent Request.

**Enterprise Chat and Email and Agent Request**

To configure prefixes and filters for dialed numbers in Enterprise Chat and Email, you must use the Unified CCE Script Editor.

**Unsupported Environments**

Agent Request is not supported:

- In a Parent/Child deployment
- With Mobile Agents
- In a hybrid deployment

**Agent Request Prerequisites**

Install and configure SocialMiner before implementing Agent Request. SocialMiner must be geographically colocated with one side of the Media Routing Peripheral Gateway (MR PG).

The customer or partner must build a custom application for the Agent Request feature. See Use the Sample Code to Create a Customer Callback Request, on page 16.

SocialMiner is always deployed in a DMZ. Remember to open the port you have configured for the MR PG. See Set up the Media Routing PG and PIM, on page 12.

**Agent Request Call Flow**

The flow proceeds as follows:
1. The customer application initiates an agent request by requesting a callback.

2. SocialMiner sends the request to the Media Routing PG.
   1. The Media Routing PG sends the request to the Router.
   2. The Router sends the request to the Agent PG.
   3. The Agent PG sends the request to the agent.

3. A call is initiated from the agent's phone, on behalf of the agent, dialing the customer's phone number.

Note

The agent does not control when the call is placed.

Figure 1: Agent Request Call Flow

Agent Request Scenarios

1. From the web, the customer requests to speak to an agent.

2. The customer receives feedback that the request is accepted.

3. The customer receives feedback that the call is queued and the estimated wait time.

4. The customer receives feedback that a call is on its way.

5. The agent's phone places an outbound call.
Configure Unified CCE for Agent Request

The following information describes how to configure Agent Request for a Unified CCE deployment.

**Important**
Configure Unified CCE before you configure SocialMiner.

**Configuration Manager**
Use these Configuration Manager tools and procedures to configure Agent Request.

**Configure Network VRU and Network VRU Script**

**Procedure**

**Step 1**
In the Configuration Manager, use the Network VRU Explorer tool to configure and save a type 2 VRU. The Network VRU is used to queue voice callback tasks if an agent is not available to handle them.

**Step 2**
In the Configuration Manager, use the Network VRU Script List tool to add a Network VRU Script that references the Network VRU that you configured in Step 1. The Network VRU Script is used for Estimated Wait Time.

**Configure the Media Routing PG and PIM**

**Procedure**

**Step 1**
In Configuration Manager, open the PG Explorer tool to configure a media routing PG.

**Step 2**
Create a media routing PIM and routing client for SocialMiner.

---

6. The agent is presented with call context.

<table>
<thead>
<tr>
<th>If</th>
<th>Then</th>
</tr>
</thead>
<tbody>
<tr>
<td>The customer is available</td>
<td>The customer receives and answers the call, and speaks to the agent</td>
</tr>
<tr>
<td>The customer is busy when the callback occurs</td>
<td>The agent receives a busy tone</td>
</tr>
<tr>
<td>The customer does not answer when the callback occurs</td>
<td>The agent hears ringing</td>
</tr>
<tr>
<td>The customer cancels the callback before an agent is selected</td>
<td>There is no impact on the agent</td>
</tr>
</tbody>
</table>
Write down the Logical Controller ID and the Peripheral ID. You will use them when you set up the PG.

**Step 3**
On the Peripheral tab in the PG Explorer tool, check the **Enable post routing** check box.

**Step 4**
On the Routing Client tab in the PG Explorer tool, select the **Multichannel** option from the **Routing Type** drop-down list box.

**Step 5**
On the Advanced tab in the PG Explorer tool, select the type 2 Network VRU that you created.

---

### Configure Call Type

**Procedure**

Open the Call Type List tool, and create a call type to handle calls from an agent request voice callback.

---

### Configure Dialed Number/Script Selector

**Procedure**

**Step 1**
Open the Dialed Number/Script Selector List tool, and create a script selector on the routing client that you configured. SocialMiner uses this script selector to request agents for voice callback. (The script selector configured here must be the same as the one entered in the SocialMiner notification.)

**Step 2**
On the Attributes tab, select **Cisco_Voice** from the **Media routing domain** drop-down list box.

**Step 3**
On the **Dialed Number Mapping** tab, map the script selector to the call type you created.

---

### Configure ECC Variables

**Procedure**

**Step 1**
Open the **Expanded Call Variable List** tool.

**Step 2**
Add one or more ECC Variables for the callback request.

**Note**
Arrays are not supported with the Agent Request feature.

CCE solutions support the Latin 1 character set only for Expanded Call Context variables and Call variables when used with CVP, Finesse, and SocialMiner. CCE also supports the use of multi-byte character sets in limited usage for ECC and call variables when setting them in Script Editor using double quotes.
Set up the Media Routing PG and PIM

Procedure

Step 1  From Cisco Unified CCE Tools, select **Peripheral Gateway Setup**.
Step 2  On the Components Setup screen, in the Instance Components panel, select the PG Instance component. If the PG does not exist, click **Add**. If it exists, click **Edit**.
Step 3  In the Peripheral Gateways Properties screen, click **Media Routing**. Click **Next**.
Step 4  Click **Yes** at the prompt to stop the service.
Step 5  From the Peripheral Gateway Component Properties screen, click **Add**, select the next PIM, and configure with the Client Type of Media Routing as follows.
   a) Check **Enabled**.
   b) In the **Peripheral Name** field, enter **MR**.
   c) For **Application Hostname (1)**, enter the hostname or IP address of SocialMiner.
      
      **Note**  The system does not support IP address change. Use the hostname if you foresee a change in IP address. This is applicable for all the **Hostname/ IP Address** fields.
   d) By default, SocialMiner accepts the MR connection on **Application Connection Port** 38001. The Application Connection Port setting on SocialMiner must match the setting on the MR PG; if you change the port on one side of the connection, you must change it on the other side.
   e) Leave the **Application Hostname (2)**, field blank.
   f) Keep all other values.
   g) Click **OK**.
Step 6  On the Peripheral Gateway Component Properties screen, enter the Logical Controller ID that you recorded when you configured the Media Routing PG and PIM.
Step 7  Accept defaults and click **Next** until the Setup Complete screen opens.
Step 8  At the Setup Complete screen, check **Yes** to start the service. Click **Finish**.
Step 9  Click **Exit Setup**.
Step 10 Repeat from Step 1 for Side B.
Step 11 Navigate to **Unified CCE Administration > Inventory**.
Step 12 Add SocialMiner as an external machine.
   a) Click **Add**.
   b) Select SocialMiner from the drop-down list.
   c) Enter the required information.
   d) Click **Save**.
      
      The system automatically enables and completes the **CCE Configuration for Multichannel Routing** settings in SocialMiner Administration, including the **Application Connection Port** you specified.

Configure SocialMiner for a Voice Callback Agent Request

To support a callback request, SocialMiner must be configured with:
Create Feed

Procedure

| Step 1 | Sign in to SocialMiner. |
| Step 2 | Click Configuration. |
| Step 3 | On the Manage Feeds panel, click New. |
| Step 4 | For Type, select Callback. |
| Step 5 | Name the feed. |
| Step 6 | For Reply Template, retain the default, No reply template. |
| Step 7 | Configure the feed to automatically tag all callback requests that come in on that feed. For example, autotag with 'sendtocontactcenter'. Make a note of the tag. It is used to trigger the notification to CCE. |
| Step 8 | Click Save. |

Create Campaign

Procedure

| Step 1 | Sign in to SocialMiner. |
| Step 2 | Click Configuration. |
| Step 3 | On the Manage Campaigns panel, click New. |
| Step 4 | Name the campaign. |
| Step 5 | Enter an optional description. |
| Step 6 | Make no selection in the Chat Invitation Feed drop-down list. |
| Step 7 | Locate the Callback feed in the Available panel and move it to Selected. |
| Step 8 | Click Save. |
Create Notification

Procedure

Step 1  Sign in to SocialMiner.
Step 2  Click Administration.
Step 3  On the Manage Notifications panel, click New.
Step 4  For Type, select Connection to CCE.
Step 5  Name the notification.
Step 6  From the Campaigns drop-down list, select the campaign that you created for the callback.
Step 7  In the Tags field, enter the tag that is automatically applied to callback requests by the feed. In our example 'sendtocontactcenter'.
Step 8  For Request Type, select Callback.
Step 9  In the Dialed Number/Script Selector field, enter the dialed number string that you have configured.
See Configure Dialed Number/Script Selector, on page 11.
Step 10  Click Save.

What to do next


Agent Request Script

The Agent Request Script is used to implement an optional dial-plan, queue a call to the skill group node, and calculate the estimated wait time for a voice callback to a customer.

A customer who requests a voice callback might want to know approximately how long it will be before the call is returned. You can configure voice callback to provide an estimate of the wait time back to the customer. The estimated wait time is calculated once, when the call enters the queue. The time is not updated as the position in the queue changes.

The default estimated wait time algorithm is based on a running five minute window of the rate of calls leaving the queue. Any calls that are routed or abandoned during the first five minutes are taken into account as part of the rate leaving queue. For Precision Queues, the rate leaving queue represents the rate at which calls are delivered or abandoned from the entire Precision queue, not any individual Precision Queue steps. The algorithm computes the wait time for each of the queues against which the call is queued (Skill Groups or Precision Queues) and then returns the minimum estimated wait time. Queue to Agent is not supported.

While the queue builds, the small number of calls in the queue makes the estimated wait time less accurate and the value fluctuates rapidly. As the queue operates with more calls over time, the estimated wait time is more accurate and consistent.
The built-in function also applies to inbound calls that queue.

Create Agent Request Script

To create a Agent Request script:

Procedure

Step 1  Start node: Create the Start node by selecting a new Routing Script from the Script Editor.

Step 2  Set Variable (Call.Calling Line ID) node: (optional). If required, you can set the CallingLineID (CLID/ANI) variable to implement a "dial-plan," pre-pending a set of digits to the phone number provided by the customer so that it can be correctly routed. For example, it is often necessary to add 9 to the phone number to reach an outside line. In other cases, more pre-pended digits may be required to reach the end customer.

You can also set up Unified Communications Manager Route Patterns to respond to a certain set of digits by routing the call to an outside line with a specified area code. To implement a dial-plan, add a Set Variable node before the queue, as shown in this example. In this case, a 9 is pre-pended to the customer phone number using the built-in concatenate function.
Step 3  **Queue to Skill Group node:** The Agent Request call can be queued against one or more Skill Groups, Precision Queues, or a queue-to-agent node. In the example script, the call is queued against a single skill group.

Step 4  **Set Variable (Call.Estimated Wait Time) node:** Set the Call Wait time as follows:
   a) From the Set Variable node, select **Call** from the **Object type** drop-down menu.
   b) From the **Variable** drop-down menu, choose **Estimated Wait Time()**. You can then work with the Formula Editor to use the default estimated wait value or create a formula and use your own value.
   c) Click **Formula Editor**. You can either use the default estimated wait value, by clicking the **Built-In Functions** tab and choosing **EstimatedWaitTime()**. Or to create a formula and use your own estimated time value, click the **Variables** tab, and choose an entry in the **Object type** list and **Object** list. Then double-click a variable in the **Variable** list.

Step 5  **Run Ext Script node:** Apply the **Network VRU** script as follows:
   a) Click the **Queue** tab.
   b) Click **Run External Script**.
   c) Click inside the script. A Run External Script node appears.
   d) Double-click the node and choose the Network VRU script from the list and then click **OK**. The call variable Estimated Wait Time now contains a value in the **EstimatedWaitTime** field and can be passed to peripherals.

   Note that a Run External Script node is required to send the EstimatedWaitTime to SocialMiner.

Step 6  **Wait node:** The wait period for an agent becomes available.

Step 7  **End node:** The script ends if no agent becomes available.

---

**Use the Sample Code to Create a Customer Callback Request**

Cisco Systems has made sample callback application code available to use as a baseline in building your own application. This sample includes retrieving and displaying the estimated wait time, assuming it has been configured in Unified CCE. You can find the sample code on DevNet.

---

**Note**

You cannot copy and paste this code to achieve a working application. It is a only a guideline.

For more information about how to use the Callback API, see the *Cisco SocialMiner Developer Guide* at [https://developer.cisco.com/site/socialminer/documentation/index.gsp](https://developer.cisco.com/site/socialminer/documentation/index.gsp).

---

**Procedure**

---

**Step 1**

Retrieve the feed id by entering this URL in a browser:

https://<SocialMiner_Hostname_or_Ip>/ccp-webapp/ccp/feed.

In the example output below, note that the value in the `<name>` field is "Callback." Look for the number of the feed id identified at the end of the refURL path (in this case, it is 100000) just before the `<refURL>` tag. Copy this number.
Step 2 Access the sample application from DevNet: https://developer.cisco.com/web/socialminer.

Step 3 Enter values in the fields:

- **Title:** A title or subject for the callback request.
- **Author:** The name of the person submitting the callback request.
- **Phone:** The phone number to call back.
- **Feed Id:** The value from the refURL above.

Step 4 Click **Call me back.**

---

**Agent Request Reporting**

Cisco Unified Intelligence Center CCE reports include data for Agent Requests

---

**Note**

Agent requests that fail before being routed to CCE will not be included in the CCE solution-level reports. The SocialMiner search function can be used to identify these requests.

**Call Type and Call Type Skill Group Metrics**

- **Calls Offered** — Incremented when Call Type is entered (through Script Selector or Call Type node).

- **Calls Abandoned in Queue** — Incremented when a Queued Callback request is canceled by the customer prior to when an Agent is selected to handle the Voice Callback call.

- **Calls Answered** — Incremented if the call is placed from the agent and represents work accepted by the agent.

- **Calls Handled** — Incremented if the customer answers the call. Calls Answered minus Calls Handled indicates how many calls failed to reach the intended customer.

- **Service Level Offered** — Incremented for all routed calls, including voice callback calls initiated through the agent request API.

- **ServiceLevelCalls** — Incremented if the call is presented to the agent within a service level.
• **Answer Intervals (1 - 10)** — The appropriate bucket is incremented based on how long the call was in the queue.

**Skill Group Metrics**

Call Type Skill Group and Skill Group metrics are not counted in the same way. The skill group metric treats each call as agent-initiated; therefore, Calls Answered and Calls Handled are not incremented. AgentOutCallsTime, AgentOutCalls, AgentOutCallsTalkTime, AgentOutCallsOnHold, and AgentOutCallsOnHoldTime are incremented.

**Agent Real Time**

The direction in the Agent Real Time table is listed as Outbound.

**Termination Call Detail**

For custom reporting, the Termination Call Detail records contain a PeripheralCallType of 41 - Voice Callback. Calls which do not successfully connect to a customer have a call disposition of **10 - Disconnect/Drop no answer**. This includes agent request calls to busy numbers.
Agent Greeting

Capabilities

With Agent Greeting, you can play a configurable, automated greeting to callers. Every caller receives a clear, well-paced, language-appropriate, and enthusiastic introduction from the answering agent. Agent Greeting relieves your agents from speaking opening scripts. Instead, your agents can spend the time reviewing the desktop screen pop-ups while the greeting plays.

Recording a greeting is much the same as recording a message for voice mail. Depending on how you set up the call center, agents record different greetings that play for different types of callers (for example, an English greeting for English speakers or an Italian greeting for Italian speakers).

Agent Greeting is available to agents and supervisors who use IP Phones with Built-in-Bridge (BiB) that are controlled by the Unified CCE and Unified CM.

*Figure 2: Agent Greeting*
Agent Greeting Phone Requirements for Local Agents

Agent Greeting is available to agents and supervisors who use IP Phones with Built-In Bridge (BIB). These agents are typically located within a contact center. Phones used with Agent Greeting must meet these requirements:

- The phones must have the BIB feature.

**Note**
If you disable BIB, the system attempts to use a conference bridge for agent greeting call flow and raises a warning event.

- Ensure that the phone's firmware is up to date. (Usually, phone firmware upgrades automatically when you upgrade your Unified CM installation.)

- For a list of supported phones for contact center enterprise solutions, see the **Compatibility Matrix** for your solution at https://www.cisco.com/c/en/us/support/customer-collaboration/unified-contact-center-enterprise/products-device-support-tables-list.html.

Agent Greeting Call Flows

*Figure 3: Agent Greeting Call Flow*

1. The incoming call arrives from CUBE or a TDM gateway at CVP.
2. CVP sends the incoming call to Unified CCE.
3. Unified CCE instructs CVP to queue the call.
4. CVP sends the call to the Voice Browser for VRU treatment.
5. When an agent is available, Unified CCE sends the agent number to CVP.
6. CVP sends the call to Unified CM.
7. Unified CM establishes the connection to the agent phone.
8. The caller connects to the agent phone and stops hearing the ringback.
9. Unified CCE determines which CVP to invoke, and instructs Unified CM to tell the phone BIB to open a stream to CVP.
10. Unified CCE and CVP shake hands to set the trigger for CVP to let it know which greeting to play.
11. CVP instructs the Voice Browser to have the Media Server play the greeting.
12. The phone's BIB mixes the greeting. After the greeting plays, CVP disconnects and the agent speaks with the caller.

**Agent Greeting Considerations**

Consider these points when you add Agent Greeting to your solution:

- Agent Greeting does not support outbound calls made by an agent. The announcement plays for inbound calls only.

- Only one Agent Greeting file plays per call.

- Supervisors cannot listen to agent recorded greetings.

- Agent Greetings do not play when the router selects the agent through a label node.

- Agent Greeting supports Unified CM-based Silent Monitoring with this exception: Supervisors cannot hear the greetings themselves. If a supervisor starts a silent monitoring session while a greeting plays, a message appears that a greeting is playing and to try again shortly.

- Use either G.711 a-law or mu-law for the VRU leg on the Voice Browser dial-peer. Do not use the voice-class codec.

- In general, Agent Greeting feature requires shorter latency across the system. For example, the public network has a maximum round-trip latency of 100 ms to support Agent Greeting feature as designed.

**Agent Greeting with Whisper Announcement**

You can use Agent Greeting with the Whisper Announcement feature. Consider these points when using them together:

- The Whisper Announcement always plays first.

- To shorten your call-handling time, use shorter Whisper Announcements and Agent Greetings than if you were using either feature by itself. A long Whisper Announcement followed by a long Agent Greeting equals a long wait before an agent actively handles a call.

- If you use a Whisper Announcement, your agents probably handle different types of calls: for example, “English-Gold Member-Activate Card,” “English-Gold Member-Report Lost Card,” “English-Platinum
Member-Account Inquiry.” Ensure that greetings your agents record are generic enough to cover the range of call types.

Configure Agent Greeting

This section describes how to deploy and configure the Agent Greeting feature.

Initial Setup

This section is intended for system administrators responsible for installing and configuring Unified CCE. It describes the one-time tasks required to set up Agent Greeting.

Configuration Requirements

The following configuration components must be in place to deploy Agent Greeting.

<table>
<thead>
<tr>
<th>Where</th>
<th>What</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unified Communications Manager</td>
<td>For phones that use Agent Greeting, you must set the Built-in-Bridge option to On or Default (if the value of Default is On). To verify, in Unified CM Administration, select Device &gt; Phone &gt; Built in Bridge.</td>
</tr>
</tbody>
</table>
## Agent Greeting

### Configuration Requirements

<table>
<thead>
<tr>
<th>Where</th>
<th>What</th>
</tr>
</thead>
</table>
| Unified CCE | Agent Greeting is supported with Type 10 Network VRUs only. (Type 10 is required to allow CVP to control the call). If your current Unified CCE deployment is not configured for a Type 10 VRU, you must modify it accordingly. Agent Greeting requires at minimum three expanded call variables.  
  - user.microapp.ToExtVXML: This is used twice in an Agent Greeting record script: the first time is to queue the Unified CVP RecordAgentGreeting application; the second time is to tell the recording application where to save greeting files. Configure it as an array with size 3. Use the Unified CCE Administration tool to ensure this variable includes these settings: Maximum Length - 100 and Enabled.  
  - user.microapp.app_media_lib: This is required in Agent Greeting record and play scripts to specify the dedicated directory on the media server where your greeting audio files are stored. Maximum Length - 100 and Enabled.  
  - user.microapp.input_type: This is required in Agent Greeting record scripts to limit the allowable input type to DTMF. Maximum Length - 100 and Enabled.  

No other ECC (Expanded Call Variable) are needed if you serve your files from the Unified CVP default media server, and your files are in the media server default locale directory ("<web_server_root>\en-us\app"). However, if you store your files in a location other than these defaults, you must use one or more of the ECC in the next row in your scripts. |

  - user.microapp.media_server: Use to identify the Unified CVP media server if it is other than the default.  
  - user.microapp.locale: Use to specify the name of the locale directory on the media server if it is other than the default ("en-us")).  
  - user.microapp.UseVXMLParams: Required in your record script if you include the user.microapp.media_server variable. It tells the external VXML recording script to use the name/value pair of the application that you pass in the user.microapp.ToExtVXML variable. |
Agent Greeting Deployment Tasks

**Procedure**

**Step 1** Ensure your system meets the baseline requirements for software, hardware, and configuration described in the System Requirements and Limitations section.

**Step 2** Configure IIS and FTP on Media Server.

**Step 3** In Unified CVP, add media servers, configure FTP connection information, and deploy the media servers.

**Step 4** Configure a Unified CVP media server, if you have not already done so. See Configure Unified CVP Media Server, on page 27.

**Step 5** In Unified CVP Operations Console, republish the VXML Gateway.tcl scripts with updated Agent Greeting support. See Republish the tcl scripts to VXML Gateway, on page 25 for Agent Greeting support.

**Step 6** Set the cache size on the VXML Gateway. See Set Cache Size on VXML Gateway, on page 25.

**Step 7** Record the voice prompts to play to agents when they record a greeting and to deploy the audio files to your media server, see Create Voice Prompts for Recording Greetings, on page 26.

**Step 8** Configure Call Types, on page 31 to record and play agent greetings.

**Step 9** Configure Dialed Numbers, on page 31 to record and play agent greetings.

**Step 10** Schedule the Script, on page 32

**Step 11** In Script Editor:

- To use the installed scripts to record and play agent greetings, see Import the Example Agent Greeting Scripts, on page 31.
- To create your own scripts, see Import the Example Agent Greeting Scripts, on page 31.

**Step 12** Modify the Unified CCE call routing scripts to use Play Agent Greeting script, on page 32.
Configure Gateway

Republish the tcl scripts to VXML Gateway

The .tcl script files that ship with Unified CVP include updates to support Agent Greeting. You must republish these updated files to your VXML Gateway.

Republishing scripts to the VXML Gateways is a standard task in CVP upgrades. You must republish the scripts before you can use Agent Greeting.

Procedure

Step 1
In the Unified CVP Operation Console, select Bulk Administration > File Transfer > Scripts and Media.

Step 2
Set Device to Gateway.

Step 3
Select the gateways you want to update. Typically you would select all of them unless you have a specific reason not to.

Step 4
Select Default Gateway Files.

Step 5
Click Transfer.

Set Cache Size on VXML Gateway

To ensure adequate performance, set the size of the cache on the VXML Gateway to the maximum allowed. The maximum size is 100 megabytes; the default is 15 kilobytes. Failure to set the VXML Gateway cache to its maximum can result in slowed performance to increased traffic to the media server.

Use the following Cisco IOS commands on the VXML Gateway to reset the cache size:

```bash
conf t
http client cache memory pool 100000
exit
wr
```


Configure Unified CVP

Complete the following procedures for Unified CVP configuration:

- Configure FTP Enabled in Server Manager, on page 25
- Configure Unified CVP Media Server, on page 27
- Configure the Call Studio Scripts for Record Agent Greeting, on page 28

Configure FTP Enabled in Server Manager

Complete the following procedure to configure the FTP enabled in server manager.
Create Voice Prompts for Recording Greetings

You must create audio files for each of the voice prompts that agents hear as they record a greeting. The number of prompts you require can vary, but a typical set can consist of:

- A welcome followed by a prompt to select which greeting to work with (this assumes you support multiple greetings per agent)
- A prompt to select whether they want to hear the current version, record a new one, or return to the main menu
- A prompt to play if a current greeting is not found.

To create voice prompts for recording greetings:
### Procedure

#### Step 1
Create the files using the recording tool of your choice. When you record your files:

- The media files must be in .wav format. Your .wav files must match Unified CVP encoding and format requirements (G.711, CCITT A-Law 8 kHz, 8 bit, mono).
- Test your audio files. Ensure that they are not clipped and that they are consistent in volume and tone.

#### Step 2
After recording, deploy the files to your Unified CVP media server. The default deployment location is to the `<web_server_root>`\en-us\app directory.

#### Step 3
Note the names of the files and the location where you deployed them on the media server. Your script authors need this information for the Agent Greeting scripts.

### Built-In Recording Prompts

The Unified CVP Get Speech micro-application used to record Agent Greetings includes the following built-in prompts:

- A prompt that agents can use to play back what they recorded
- A prompt to save the greeting, record it again, or return to the main menu
- A prompt that confirms the save, with an option to hang up or return to the main menu


### Configure Unified CVP Media Server

#### Procedure

#### Step 1
In the CVP Operations Console, navigate to Device Management > Media Server.

#### Step 2
Click Add New.

#### Step 3
On the General tab, configure the following.

- a) Enter the IP address and the hostname of the Unified CVP server.
- b) Check FTP Enabled.
- c) Either Check Anonymous Access or enter the credentials.
- d) Click Test SignIn to validate the FTP access.

#### Step 4
Click Save.

#### Step 5
Repeat Steps 1 through 4 for all CVP Servers.

#### Step 6
In the CVP Operations Console, navigate to Device Management > Media Server.

#### Step 7
Change Default Media Server from None to any one of the Unified CVP servers. Then click Set.

#### Step 8
Click Deploy.
Configure the Call Studio Scripts for Record Agent Greeting

The Record Agent Greeting is controlled by a combination of Call Studio script and ICM script. Complete the following procedure to configure the Call Studio script:

**Procedure**

**Step 1**
Access the .zip file from the CVP OAMP machine from the location C:\Cisco\CVP\OPSConsoleServer\StudioDownloads\RecordAgentGreeting.zip.

**Step 2**
Extract the example Call Studio Record Agent Greeting scripts contained in RecordAgentGreeting.zip to a folder of your choice on the computer running CallStudio. The folder contains a CallStudio project having the same name as the folder.

**Step 3**
Start Call Studio by selecting **Start > Programs > Cisco > Cisco Unified Call Studio**.

**Step 4**
Select **File > Import**.
The **Import** dialog box displays.

**Step 5**
Expand the **Call Studio** folder and select **Existing Call Studio project Into Workspace**.

**Step 6**
Click **Next**.
The Import Call Studio Project From File System displays.

**Step 7**
Browse to the location where you extracted the call studio projects. Select the folder and select **Finish**.

**Example:**

RecordAgentGreeting

**Step 8**
Follow the below steps, to save the file in a defined path:

a) In the **Call Studio Navigator** panel, open the RecordAgentGreeting project and double click **app.callflow** to display the application elements in the **script** window.

b) Select the **Record Greeting With Confirm** node.

c) In the **Element Configuration** panel, choose the **Setting** tab and modify the default path settings to c:\inetpub\wwwroot\en-us\app\ag_gr. Save the project after you modify it.

d) Validate the project associated with the **Record Agent Greeting** and deploy them to your VXML Server.

**Step 9**
Right-click on **Record Agent Greeting** project in the **Navigator** window and select **Validate**.

**Step 10**
Right-click on the **Record Agent Greeting** project and click **Deploy**.

**Step 11**
In the **Deploy Destination** area, select **Archive File** and click **Browse**.

**Step 12**
Navigate to the archive folder that you have set up:

**Example:**

C:\Users\Administrator\Desktop\Sample.

**Step 13**
Enter the name of the file.

**Example:**

Samplefile.zip

**Step 14**
Click **Save**.

**Step 15**
In the **Deploy Destination** area click **Finish**.

**Step 16**
Log in to **OAMP** and choose **Bulk Administration\File Transfer\VXML Applications**.

**Step 17**
Select the **VXML Server** to which you want to deploy the applications.

**Step 18**
Select the zip file that contains the applications.
Example:
Samplefile.zip

Step 19  Click Transfer.

Step 20  Right-click on the project and click Deploy, then click Finish.

Step 21  Using windows explorer, navigate to %CVP_HOME%\VXMLServer\applications\RecordAgentGreeting, open the project's admin folder and double-click deployApp.bat to deploy the application to the VXML Server.

Step 22  Verify that the application is running in the following path %CVP_HOME%\VXMLServer\applications\RecordAgentGreeting\admin and double-click status.bat. The application should display under Application Name and with the status Running.

Configure Unified CCE

Complete the following procedures for Unified CCE configuration:

• Create Agent Greeting Play Script, on page 29
• Create Agent Greeting Recording Script, on page 30
• Import the Example Agent Greeting Scripts, on page 31

Create Agent Greeting Play Script

A dedicated routing script plays the Agent Greeting. This script is invoked by the PlayAgent Greeting dialed number on the specific routing client. You must create the dialed number and associate it with a call type that executes the script.

Figure 4: Agent Greeting Play Script
Create Agent Greeting Recording Script

The Agent Greeting Recording script lets agents record a greeting. The agent desktop calls the script when an agent clicks the Record Agent Greeting button, prompting the agent to select which greeting to play or record. Create the dialed number RecordAgentGreeting for the specific routing client and associate it with a call type that then executes this script.

Figure 5: Agent Greeting recording script

Unified CCE Configuration for Record Agent Greeting

- **user.microapp.ToExtVXML**: This is used twice in an Agent Greeting record script, the first time is to queue the Unified CVP Record Agent Greeting application and the second time is to tell the recording application where to save greeting files. Configure it as an array with size 3. Use the Unified CCE Administration tool to ensure this variable includes Maximum Length as 100 and Enabled.

- **user.microapp.app_media_lib**: This is required in Agent Greeting record and play scripts to specify the dedicated directory on the media server where your greeting audio files are stored. Maximum Length is 100 and Enabled.

- **user.microapp.input_type**: This is required in Agent Greeting record scripts to limit the allowable input type to DTMF. Maximum Length is 100 and Enabled.

**Note**
For more information on how to enable the ECC variables, see the Cisco Hosted Collaboration Solution for Contact Center Configuration Guide at
Import the Example Agent Greeting Scripts

To view or use the example Agent Greeting scripts, you must first import them into the Unified CCE Script Editor. Complete the following procedure to import the example Agent Greeting scripts:

Procedure

Step 1 Launch Script Editor.
Step 2 Select File > Import Script and select a script to import. The scripts are located in the icm/bin directory on the data server (DS) node.
Step 3 In addition to importing the script, Script Editor maps imported objects. You must manually create some objects referenced in the example scripts, such as the external Network VRU scripts or the skill group, or change these references to point to existing scripts and skill groups in your system.
Step 4 Repeat for the remaining scripts.

Note For Small Contact Center Deployment Model, Default Routing Scripts are available in the partners Community. Download the Routing Scripts to the Desktop where ISE is Installed and Login as the Sub Customer User into the ISE to perform the Step 2 and 3. To Download the Routing Script, see https://communities.cisco.com/docs/DOC-35245.

Note For Small Contact Center Deployment Model ensure the resources used in this Routing script, like Network VRU Scripts, ECC variables etc are specific to the sub customer.

Configure Call Types

Procedure

Step 1 Sign-in to Unified CCDM Portal as Tenant or Sub Customer user.
Step 2 Click the burger icon and select Provisioning > Resource Manager
Step 3 Select the folder where you want to create the call type.
Step 4 Click Resource, then click Call Types.
Step 5 Create a call type to record agent greetings and enter RecordAgentGreeting as the name.
Step 6 Create a call type to play agent greetings and enter PlayAgentGreeting as the name.

Configure Dialed Numbers

Procedure

Step 1 Sign-in to Unified CCDM Portal as Tenant or Sub Customer user.
Step 2 Click the burger icon and select Provisioning > Resource Manager
Step 3 Select the folder where you want to create the dialed number.
Step 4 Click Resource, then click Dialed Number.
Step 5 Create a dialed number to record agent greetings and enter `RecordAgentGreeting` as the name.

Step 6 Create a dialed number to play agent greetings and enter `PlayAgentGreeting` as the name.

Step 7 Complete the following for each dialed number:
   a) Select **Internal Voice** for the Routing type.
   b) Retain the default domain value.
   c) Select the call type appropriate to the dialed number.

This helps to associate each number to its call type and to a script that executes.

---

**Schedule the Script**

**Procedure**

**Step 1** In the **Script Editor**, select **Script > Call Type Manager**.

**Step 2** From the Call Type Manager screen, select the **Schedules** tab.

**Step 3** From the Call type drop-down list, select the call type to associate with the script; for example, `PlayAgentGreeting`.

**Step 4** Click **Add** and select the script you want from the Scripts box.

**Step 5** Click **OK** twice to exit.

---

**Modify the Unified CCE call routing scripts to use Play Agent Greeting script**

For an Agent Greeting play script to run, you must add an AgentGreetingType Set Variable node to your existing Unified CCE call routing scripts: This variable's value is used to select the audio file to play for the greeting. Set the variable before the script node that queues the call to an agent (that is, the Queue [to Skill Group or Precision Queue], Queue Agent, Route Select, or Select node).

**Specify AgentGreetingType Call Variable**

To include Agent Greeting in a script, insert a Set Variable node that references the AgentGreetingType call variable. The AgentGreetingType variable causes a greeting to play and specifies the audio file it should use. The variable value corresponds to the name of the greeting type for the skill group or Precision Queue. For example, if there is a skill group or Precision Queue for Sales agents and if the greeting type for Sales is '5', then the variable value should be 5.

You can use a single greeting prompt throughout a single call type. As a result, use one AgentGreetingType set node per script. However, as needed, you can set the variable at multiple places in your scripts to allow different greetings to play for different endpoints. For example, if you do skills-based routing, you can specify the variable at each decision point used to select a particular skill group or Precision Queue.

---

**Note**

Only one greeting can play per call. If a script references and sets the AgentGreetingType variable more than once in any single path through a script, the last value to be set is the one that plays.

Use these settings in the Set Variable node for Agent Greeting:
• Object Type: Call.
• Variable: Must use the AgentGreetingType variable.
• Type: Must use the PersonID_AgentGreetingType type.
• Value: Specify the value that corresponds to the greeting type you want to play. For example: “2” or “French”
  • You must enclose the value in quotes.
  • The value is not case-sensitive.
  • The value cannot include spaces or characters that require URL encoding.

The following script example illustrates how to include Agent Greeting in a script using the Set Variable node:

Figure 6: Modified Call Routing Script to Enable Greeting Play

Scripting Agent Greeting for Multiple Customers

In the out-of-box method for deploying Agent Greeting, Unified CCE uses the customer information from the built-in “PlayAgentGreeting” dialed number to choose the correct network VRU to play the greeting. If your deployment has multiple customers configured within your Unified CCE instance and you want to use Agent Greeting with all of them, you must configure things differently to work around customer associations.

Configure Custom Dialed Number for Agent Greeting Play

To play Agent Greetings for multiple customer instances, configure the built-in PlayAgentGreeting dialed number for each Unified CM routing client, but do not associate it with a specific customer. The Unified CM
Peripheral uses this number to initiate Agent Greeting play. If you want your greetings to be played from a different network VRU, use the TranslationRouteToVRU node in your routing scripts to explicitly choose the network VRU.

Configure Custom Dialed Number for Agent Greeting Record

To record Agent Greetings when you have multiple customers, you must create your own custom dialed number for recording. You may want to create different dialed numbers for different customers. As with Agent Greeting play, if you want to use different network VRUs to record Agent Greetings for different customers, use the TranslationRouteToVRU node in your routing script to explicitly select the network VRU.

Create your own custom button or have your agents enter the record dialed number using the dial pad on their desktops.

Configure Unified Communications Manager

Built-in-Bridge

Built-in-Bridge (BIB) is not enabled by default for the phones. It is disabled at the system level as it is not used by all the customer by default. It is used only by the customers having Contact Center.

The provider has to perform the following procedures to enable BIB for the customers having contact center.

**Note**

Create a new Field Display Policies at the customer level and add Built-in Bridge to the list.

- [Configure the Built-in-Bridge](#), on page 34
- [Enable or Disable the Built-in-Bridge](#), on page 35

Configure the Built-in-Bridge

**Procedure**

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Login to Cisco Unified Communication Domain Manager as provider.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Navigate Role Management &gt; Field Display Policies.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Ensure that hierarchy is set to the appropriate customer.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Select the SubscriberPhoneMenuItemProvider.</td>
</tr>
<tr>
<td>Step 5</td>
<td>In the details page, go to Action menu and click Clone.</td>
</tr>
<tr>
<td>Step 6</td>
<td>Enter SubscriberPhoneMenuItemProvider as the name.</td>
</tr>
<tr>
<td>Step 7</td>
<td>Select relation/SubscriberPhone from the Target Model Type drop-down list.</td>
</tr>
<tr>
<td>Step 8</td>
<td>Expand Groups section and enter Phone for Title.</td>
</tr>
<tr>
<td>Step 9</td>
<td>Select builtInBridgeStatus from the Available list and click Select.</td>
</tr>
<tr>
<td>Step 10</td>
<td>Click Save.</td>
</tr>
</tbody>
</table>
Enable or Disable the Built-in-Bridge

Before you begin
Ensure that you configure Built-in-Bridge. See, Configure the Built-in-Bridge, on page 34.

Procedure

Step 1  Login to Cisco Unified Communication Domain Manager as a provider.
Step 2  Ensure that hierarchy is set to the appropriate customer.
Step 3  Navigate Subscriber Management > Phones and select the appropriate phone.
Step 4  In the Phone tab:
   • To enable BIB choose On from the Built in Bridge drop-down list.
   • To disable BIB choose Off from the Built in Bridge drop-down list.
Step 5  Click Save.

Reporting

In agent, skill group, and precision queue reports, greeting time is not specifically broken out. The period during which the greeting plays is reported as talk time. Record time is counted as an internal call by the default skill group.

Calls that involve Agent Greeting consist of two call legs: the inbound call from the customer and the call to Unified CVP for the greeting. Both of these legs have the same RouterCallKeyDay and RouterCallKey values in the TCD and RCD tables in the database. You can use these values to link the two legs together for reporting purposes.

Greeting Call Statistics

To view greeting call statistics, create a separate call type and associate it with the routing script that plays agent greeting. New Cisco Unified Intelligence Center templates for the agent greeting call type are created based on the data in the existing Call_Type_Real_Time and Call_Type_Interval table in the database.

Peripheral Call Types for Agent Greeting

There are two peripheral call types specific to Agent Greeting that you can use to track and report on the feature.

• Call Type 39: Play Agent Greeting. Route request to play an Agent Greeting.
• Call Type 40: Record Agent Greeting. Agent call for recording an Agent Greeting.

Extra TCDs and RCDs are generated for the agent greeting call leg, and they can be linked to the first call leg by the same RouterCallKeyDay and RouterCallKey.
Serviceability

Serviceability for Agent Greeting includes SNMP events captured by your Network management software that indicate reasons for greeting failures and counters to track the number of failed greeting events.

---

**Note**

There is no counter for the number of failed agent greeting calls.

When system components fail, Agent Greeting may be impacted. For example, if a requested greeting audio file cannot be found for any reason, the call proceeds normally without the Agent Greeting.
Unified CM-based Silent Monitoring

- Capabilities of Silent Monitoring, on page 37
- Configure Silent Monitoring, on page 38

Capabilities of Silent Monitoring

Silent Monitoring

Silent monitoring allows supervisors to monitor the conversations of agents within their team. Supervisors cannot participate actively in the conversations and agents and callers are not aware that they are being monitored. Cisco Finesse provides solution support for silent monitoring.

Cisco Finesse supports Unified Communications Silent Monitoring only. You configure silent monitoring on Unified Communications Manager. No additional configuration is required on the Cisco Finesse server.

Note

Even for regions that are configured to use G.711, Unified CCE uses G.722 as the default codec for devices that support G.722. However, G.722 is not supported with Silent Monitoring and Call Recording based on Unified Communications Manager. To disable this default, in Unified Communications Manager Administration, go to Enterprise Parameters and set Advertise G.722 Codec to disabled.

Note

If voice streams are encrypted, silent monitoring does not work correctly. Although the voice streams can still be captured, the silent monitoring service cannot decode them correctly.

Unified CM-Based Silent Monitoring

Unified Communications Manager accomplishes silent monitoring with a call between the supervisor (monitoring) device and the agent (monitored) device. The agent phone mixes and sends the agent's conversation to the supervisor phone, where it is played out to the supervisor.

Unified CCE supports the Silent Monitoring functionality available in Unified CM. Unified CM Silent Monitoring supports only one silent monitoring session and one recording session for the same agent phone.
Unified CMSilentMonitoring does not support mobile agents.

Unified CMSilentMonitoring can monitor any Unified CCE agent desktop, including Siebel, if the following conditions exist:

- The contact center uses a compatible version of Cisco Unified CM. For more information, see the Compatibility Matrix for your solution.

Unified CMSilentMonitoring works the same as other call control functionality provided by Unified CM (such as conference and transfer). When the silent monitoring session begins, the desktop sends a message through Unified CCE, through Unified CM, and out to the phones where silent monitoring is executed. Messaging through Unified CCE and Unified CM impacts Unified CCE performance.

Configure Silent Monitoring

Add Monitoring Calling Search Space

**Before you begin**

Ensure that agent phones are added.

**Procedure**

1. Log in to Unified Communication Domain Manager as provider, reseller or customer.
2. Add Calling Search Space for monitoring purpose.
3. Edit Lines, choose newly added Calling Search Space from the drop-down list.
4. Click Save.

**Example**

Context Service

Cisco Context Service is a cloud-based, omnichannel solution. Context Service captures customer interaction history and provides flexible storage of the customer interaction data across all channels (including voice, chat, email, and Internet of Things).
Context Service provides an out-of-the-box integration with Unified Contact Center Enterprise. You do not need to install any additional components. With Context Service integrated with your contact center, agents can access a customer's previous interactions with your organization. Context Service provides this information to your agents through the Customer Context gadget in the Cisco Finesse desktop.

Context Service provides a flexible data store for storing customer interaction data. You can define what data you want to store and how to store it. Cisco hosts and manages the service, eliminating the need for your organization to deploy and manage servers. Your organization owns the data, even though it's stored in the cloud. Your organization controls access to sensitive data. Cisco partners cannot access protected data unless you grant them access.

The Context Service object stores context data:

- Customer data—Describes who the customer is and includes information such as name, address, and phone number. A Customer provides a way to link personally identifiable information (PII) with a
customer ID. It can link to an existing data store that contains your customer data with key fields, such as name or account number, stored in Context Service. The agent's desktop displays these details in the Customer Context gadget.

- Activity—Describes a specific interaction associated with a customer or request. An activity reflects one or more steps in the customer journey. Activities tie together all objects within a particular customer journey. For example:
  - VRU menu that a customer selects.
  - Notes made by the agent.
  - A website URL that the customer visited.
  - Chat metadata.

- Request data—Describes what the customer wants. Requests are about one or more customer interactions for a specific issue. The request reflects the customer's view of an issue, indexes the customer journey and interaction, and groups related requests together. For example, a customer goes online to make a credit card payment and runs into an issue. The customer decides to call to make the payment instead. The separate requests represent the two interactions but belong to the same request (making a credit card payment).

The following contact center components integrate with Context Service:

- Cisco Unified CVP—Looks up customer and creates or updates activities for every voice call.
- Cisco Enterprise Chat and Email—Creates activities for every nonvoice chat and email task.
- Cisco SocialMiner—Creates customer records for every Task Routing task.
- Cisco Finesse—Contains the Customer Context gadget where agents can view and update customers and activities for the tasks that they handle.

Omnichannel Customer Journey

The omnichannel customer journey captures and displays a customer's complete interaction history.

A customer purchases a motorcycle from a company (Cumulus Motorcycle). The customer now has a problem with the motorcycle, so he needs to schedule an appointment with Cumulus Motorcycle for repair. The customer browses the Cumulus web site to locate the nearest service center and chats with a Cumulus agent to determine if the service center that he selected is open on Sundays. In the chat, he tells the agent that he will call when he is ready to schedule an appointment.

The customer calls to schedule a service appointment. The VRU detects his chat and sends his call to a Cumulus Motorcycle agent who is context aware. The customer agrees on a date for service. The agent confirms the appointment, and sends the appointment details to the customer. When the customer realizes that he has a conflict with the appointment, he sends the SMS a new proposed date. The agent receives a screen pop with the customer's proposed date. The agent sends the customer the details for the new appointment. The customer
brings his motorcycle into Cumulus Motorcycle for the scheduled service appointment, then picks up his repaired motorcycle.

**Table 1: Components that enable the omnichannel customer journey**

<table>
<thead>
<tr>
<th>Activity</th>
<th>Components</th>
</tr>
</thead>
<tbody>
<tr>
<td>The motorcycle dashboard indicates an error, and instructs the customer to contact Cumulus Motorcycle Customer Service immediately.</td>
<td>The motorcycle sends diagnostic metadata to the Cumulus data center which is connected to Context Service.</td>
</tr>
</tbody>
</table>
| The customer browses the Cumulus website to locate the nearest service center. He clicks the **Schedule Service Appointment** link to view the Cumulus Service Centers located near him. The customer views the nearest Cumulus Service Center and clicks the link to chat with a Cumulus agent. | Enterprise Chat and Email  
Finesse  
The Cumulus backend server sends the IoT event data and creates an activity to show the current breadcrumbs in Context Service. |
| The customer calls to schedule a service appointment. The VRU detects his chat and sends his call to an agent. | SMS  
Unified CVP  
Finesse  
Other components |
| The customer receives the appointment details. | SMS |
| The customer has a conflict with the scheduled date. The customer proposes a new date. The agent receives a screen pop with the customer's new date. | SMS  
Finesse |
| The customer receives a SMS confirmation with the new date. | SMS (for example, Tropo). |
| The customer picks up his repaired motorcycle. | |

**Task Flow to Enable Context Service**

To enable Context Service in your contact center solution, follow this task flow:

<table>
<thead>
<tr>
<th>Sequence</th>
<th>Task</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Enable Context Service</strong></td>
<td></td>
</tr>
</tbody>
</table>
| 1 | Work with your Cisco account partner to onboard your organization:  
*Enable Context Service for Your Organization, on page 45* |
| **Configure and Register Components** | |
| 2 | Register your Unified CVP Call Servers:  
*Register Unified CVP with Context Service, on page 47.* |
<table>
<thead>
<tr>
<th>Sequence</th>
<th>Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Configure connection data in CVP Call Studio: Configure Context Service Connection Data in Call Studio, on page 49.</td>
</tr>
<tr>
<td>4</td>
<td>Register your Cisco Finesse Servers: Register Cisco Finesse with Context Service, on page 49.</td>
</tr>
<tr>
<td>5</td>
<td>Set the principal Administration &amp; Data Server: Set the Principal AW for Context Service, on page 50.</td>
</tr>
<tr>
<td>6</td>
<td>Register Unified CCE Administration to support SocialMiner and ECE servers: Register Unified CCE Administration to Support Components, on page 51.</td>
</tr>
<tr>
<td>7</td>
<td>Enable the POD.ID expanded call variable: Enable the POD.ID Expanded Call Variable, on page 52.</td>
</tr>
</tbody>
</table>

### Create scripts


---

# Context Service Setup

## Context Service Prerequisites

Complete the following tasks before you enable Context Service.

- Install and configure your contact center solution and any components that you plan to integrate with Context Service (Unified CVP, SocialMiner, ECE, and Cisco Finesse).
- Ensure that port 443 (HTTPS) is available for Context Service to use.
- Add the following URLs to your allowed list in your firewall so that your contact center components can connect to, and receive data from, the internet:
  
  - *.webex.com
  - *.wbx2.com
  - *.ciscoccservice.com

---

### Note

You must use wildcard URLs in your allowed list because Context Service is accessed through multiple subdomains. Context Service subdomain names can dynamically change.
Enable Context Service for Your Organization

Context Service enables you to store and access customer interaction data in the cloud, creating a flexible and seamless omnichannel customer journey experience. To use Context Service:

- Work with your Cisco account partner to enable Context Service for your organization.
- Register Context Service for your organization to use with your contact center application.
- Connect your contact center application to Context Service.

**Note**

You need Java Runtime Environment (JRE) version to 1.8.0_151 or later to use Context Service. Refer to the Compatibility Information for your specific release and update accordingly.

**Create a Customer Organization and Enable Context Service**

Your Cisco account partner can provide Context Service entitlement to your Cisco Webex Control Hub account.

This example shows how a partner adds a Context Service subscription to a customer organization. The example assumes that:

- The partner is a full administrator or sales administrator and can add trials.
- The Cisco Webex Control Hub account or the organization and accounts associated with the organization have been created.

**Example: Add a Trial Service**

Context Service is not tied to the trial services, and does not expire when the trial period is complete.

1. Log in with your partner credentials to the Cisco Webex Control Hub.
2. Click Start Trial on the Overview page. The Start New Trial window opens.
3. Enter details about the trial:
   
   - **Customer Information**: Enter the name of the customer company and an email for the administrator.
   
   - **Trial Services**: Select the trials to add to this customer. To enable Context, select **Message**.
   
   - **Licenses Quantity**: Specify the number of licenses required for this customer trial. This number is usually the number of users who use this service. This option applies only to the Trial Services. Context Service is not bound by the number of licenses specified here.
   
   - **Trial duration**: Specify the duration the trial lasts before you must purchase the service. This option applies only to the Trial Services and not Context Service.

   **Note**
   
   Context Service entitlement does not expire when the specified trial period ends. The organization can continue to use Context Service beyond the date of the specified Trial Duration.

   **Note**
   
   You cannot change the customer name and administrator email after you create the trial. You can modify the other terms of the trial as needed.

   Make sure that the email you provide is not already associated with a [Cisco Webex Control Hub](https://www.webex.com) account.
4. Scroll down to the **Non Trial Services** section and select **Enable Context Service for Cisco Unified Contact Center**.

5. Click **Next**.

6. A message is displayed that asks if you want to set up the services for the customer. Click **No**.

You now have provided Context Service entitlement to the organization. The customer now receives a welcome email at the specified email address with the subject line **Welcome to Cisco Spark Service**.

---

The customer must click **Get Started** in the email and sign in to **Cisco Webex Control Hub** to begin their trial. The customer uses the credentials in the email to sign in and is prompted to create a password.

Your Cisco Context Service is ready. To use the service, connect to Cisco Contact Center with Context Service Enabled. See **Register Context Service** for more information.

---

**Component Configuration and Registration**

**Register Unified CVP with Context Service**

The registration process has an inactivity session timeout of 10 minutes. If the session times out, sign in again.

---

**Note**

For Unified CVP, Context Service is not supported for a VXML Server that is deployed in a standalone mode.
Before you begin

- Ensure that Unified CVP 11.6 is installed.
- Ensure that your web browser allows popups.
- If you are using Microsoft Internet Explorer, add a registry key, TabProcGrowth, at HKEY_CURRENT_USER\Software\Microsoft\Internet Explorer\Main. Set the type to String or DWORD (32-bit) and set the value to 0.
- When your organization was entitled for Cisco Context Service, you received an email requesting a sign-in and a password change. Sign in using the registration email, and change the password. Now your organization is entitled to use Context Service.

Procedure

Step 1  In the CVP Operations Console, choose System > Cloud Services > Context Service to launch the Context Service Management page.

Step 2  Provide the following information for the CVP VXML server:

- Proxy server URL—Specify the URL if your solution uses an optional proxy server to reach Context Service.
- Timeout—The amount of time, in milliseconds, that the system waits for a response from Context Service for each operation.

  See the application's online help for the minimum, maximum, and default values for this setting for the component you are registering. Test this setting and tune it to match the latency for your solution.

- Lab Mode—Indicates whether Context Service is in lab mode. In lab mode, you can test, develop, and debug Context Service. Lab mode allows you to delete objects from Context Service.

Step 3  Click Register.

A popup window appears in your browser prompting you to sign in to Cisco Spark.

Step 4  Enter your Cisco Webex Control Hub admin credentials and complete the registration. (See https://help.webex.com/docs/DOC-4165 for more information.)

Note Use the same organization admin account to register all components in one contact center solution.

Step 5  Check the Allow Access to Your Hybrid Services Node check box and then click Continue.

Cisco Webex Control Hub redirects the browser back to the application from which you began the registration.

If the registration is successful, the connection details are deployed on all running VXML Servers in the pool.

If you add a VXML Server after registration, click Save & Deploy on the VXML server device configuration page to deploy the connection data to the new server.
Configure Context Service Connection Data in Call Studio

To debug a solution that uses Context Service, Call Studio requires your Context Service credentials and connection details.

**Procedure**

**Step 1** Go to CVP Server and navigate to the C:\Cisco\CVP\conf folder.

**Step 2** Copy the connection data from the vxml.properties file to clipboard.

VXML.ContextService.ConnectionData: <connection data>

**Step 3** Launch Cisco Unified Call Studio.

**Step 4** Choose **Window > Preferences**.

**Step 5** On the **Preferences** window, choose **Call Studio > Debug Preferences**.

**Step 6** In the Context Service area enter the following connector properties:

a) In the **Connection Data** field, paste the connection data from the clipboard.

b) In the **Proxy URL** field, enter the Proxy URL in the format: hostname:port or IP_address:port.

c) In the **Timeout** field, enter how long the client waits for a response from Context Service. The allowed values are from 1200ms to 5000ms, with a default of 2400ms.

**Step 7** Click **OK**.

**Note** To check the validity of connection data through the Proxy URL, click **Test connection**.

---

Register Cisco Finesse with Context Service

**Before you begin**

- Ensure that your web browser allows popups.

- When your organization was entitled for Cisco Context Service, you received an email requesting a sign-in and a password change. Sign in using the registration email, and change the password. Now your organization is entitled to use Context Service.

- If you wish to configure a proxy server for Context Service, configure the browser proxy with the proxy server URL you specified. Refer to your browser’s documentation for information about configuring proxy settings.

**Procedure**

**Step 1** Register Cisco Finesse with Context Service from the Finess administration console **Context Service Management** gadget.

**Note** Ensure to register all Finess primary nodes.
Step 2 Provide the following information:

- **Proxy server URL**—Specify the URL if your solution uses an optional proxy server to reach Context Service.

- **Timeout**—The amount of time, in milliseconds, that the system waits for a response from Context Service for each operation.

  See the application's online help for the minimum, maximum, and default values for this setting for the component you are registering. Test this setting and tune it to match the latency for your solution.

- **Lab Mode**—Indicate whether Context Service is in lab mode. In lab mode, you can test, develop, and debug Context Service. Lab mode allows you to delete objects from Context Service.

Step 3 Click **Register**.

A popup window appears in your browser prompting you to sign in to Cisco Spark.

Step 4 Enter your **Cisco Webex Control Hub** admin credentials. Complete the registration in **Cisco Webex Control Hub**. (See **Register Your Application with Context Service** for more information.)

**Note** Use the same organization admin account to register all components in one contact center solution.

Cisco Webex Control Hub redirects the browser back to the application from which you initiated the registration.

---

**What to do next**

To change any of the settings after you register, edit the setting and save your change. You do not need to reregister.

After you register Cisco Finesse, agents can use the Context Service desktop gadget. It is available on the **Manage Customer** tab in the default agent desktop layout. If the gadget is not in your layout, you can add the gadget with the following XML:

```xml
<tab>
  <id>manageCustomer</id>
  <label>finesse.container.tabs.agent.manageCustomerLabel</label>
  <gadgets>
    <gadget>/desktop/gadgets/CustomerContext.xml</gadget>
  </gadgets>
</tab>
```

---

**Set the Principal AW for Context Service**

Set which Administration & Data Server (AW) manages the credentials for Context Service before registering with Context Service in Unified CCE Administration.

**Note** This procedure is applicable only for Packaged CCE 4K or 12K deployment type.
Procedure

Step 1 In **Unified CCE Administration**, navigate to **System > Deployment**.
Step 2 In the **System Inventory**, click the AW that you want to manage the Cisco Spark Control Hub admin credentials for Context Service.
Step 3 In the **Edit AW** popup window, check the **Principal** check box.
Step 4 Enter your solution's **Diagnostic Framework** credentials.
Step 5 Click **Save**.

Register Unified CCE Administration to Support Components

You register Unified CCE through the Unified CCE Administration tool. This enables Unified CVP, Finesse, SocialMiner and Enterprise Chat and Email to access Context Service in a single operation.

**Note**
Before you register with Context Service through Unified CCE Administration, upgrade the JRE on your primary AW to version 1.8.0_151 or higher. For information on upgrading JRE, see the Cisco Unified Contact Center Enterprise Installation and Upgrade Guide.

Before you begin

- Use the **System Inventory** in **Unified CCE Administration** to set the Principal AW before registering Unified CCE. The Principal AW manages the Context Service credentials.
- When your organization was entitled for Cisco Context Service, you received an email requesting a sign-in and a password change. Sign in using the registration email, and change the password. Now your organization is entitled to use Context Service.

Procedure

Step 1 Register from the Unified CCE Administration **Overview > Features > Context Service**.
Step 2 Provide the following information:

- **Proxy server URL**—Specify the URL if your solution uses an optional proxy server to reach Context Service.
- **Timeout**—The amount of time, in milliseconds, that the system waits for a response from Context Service for each operation.

Valid Timeout range is from 200ms to 15000 ms, with a default of 1200 ms. For the CVP component, the valid Timeout range is from 1200ms to 5000ms, with a default of 2400ms. If the timeout value is less than 1200ms or greater than 5000ms, the Unified CVP sets the minimum value to 1200ms or maximum value to 5000ms.
- **Lab Mode**—Indicate whether Context Service is in lab mode. In lab mode, you can test, develop, and debug Context Service. Lab mode allows you to delete objects from Context Service.
Step 3  Click Register.
Your browser displays the Cisco Spark sign-in page.

Step 4  Enter your Cisco Webex Control Hub admin credentials. Complete the registration in Cisco Webex Control Hub. (See Register Your Application with Context Service for more information.)

Note  Use the same organization admin account to register all components in one contact center solution.

Cisco Webex Control Hub redirects the browser back to the application from which you initiated the registration.

What to do next
Set up the ECE services in the System Console. For more information, see the Enterprise Chat and Email Deployment and Maintenance Guide (for Unified Contact Center Enterprise) at https://www.cisco.com/c/en/us/support/customer-collaboration/cisco-enterprise-chat-email/products-maintenance-guides-list.html.


If you register CCE Context Service after it is deregistered, restart the ECE Context Service Process and Instance from the ECE System Console Page. To set up ECE services in the System Console, see the Enterprise Chat and Email Deployment and Maintenance Guide (for Unified Contact Center Enterprise) at https://www.cisco.com/c/en/us/support/customer-collaboration/cisco-enterprise-chat-email/products-maintenance-guides-list.html.

After you register Cisco Finesse, agents can use the Context Service desktop gadget. It is available in Unified CCE Administration, under Desktop > Resources > Desktop Layout tab. If the gadget is not in your layout, you can add the gadget with the following XML:

```xml
<tab>
  <id>manageCustomer</id>
  <label>finesse.container.tabs.agent.manageCustomerLabel</label>
  <gadgets>
    <gadget>/desktop/gadgets/CustomerContext.xml</gadget>
  </gadgets>
</tab>
```

Add Context Service credentials and connection details to Call Studio. See Configure Context Service Connection Data in Call Studio, on page 49.

Enable the POD.ID Expanded Call Variable
Enable the built-in POD.ID expanded call variable to send task context data through the system.

Note  For a new incoming call, CVP creates a new POD and passes that POD information to CCE in POD.ID ECC Variable. In order for CVP to send POD.ID ECC variable to CCE, the Call Studio script must contain CVP Subdialog_Start at the beginning of the script with the business logic for creating or updating POD and .must end with CVP Subdialog_Return. CVP Subdialog_Return captures the caller input and passes the POD ID to CCE Application.

After enabling the ECC variable, you must add it to an ECC payload to use it in your solution.
Procedure

Step 1  
In the Configuration Manager, navigate to Tools > List Tools, and open the Expanded Call Variable List.

Step 2  
Click Retrieve.

Step 3  
Click the POD.ID expanded call variable to open that record in the Attributes panel.

Step 4  
Check the Enabled check box.

Step 5  
Click Save.

Solution Serviceability

This section provides the information and resources to troubleshoot Context Service.

You can view service status for Context Service and subscribe to updates at https://status.ciscospark.com.


Access Context Service Logs

The log file from Context Service is CCBU-runtime.<YYYY-MM-DDTHH-MM-SS.sss>.log.
The path to the log file is /opt/cisco/mmca/logs/runtime.
Context Service logs are stored at C:\icm\tomcat\logs\ContextService.*.log on the Principal AW.
CVP OAMP logs are stored at CVP_HOME\logs\OAMP
CVP VXML logs are stored at CVP_HOME\logs\VXML
Fusion Management Connector logs are stored at /opt/cisco/ccbu/logs/fusion-mgmt-connector directory
Cisco Finesse logs are stored at /opt/cisco/desktop/logs/finesse-auth
Cisco SocialMiner logs are stored at /opt/cisco/mmca/logs/runtime


View Context Service Customer Record Statistics

You can check Context Service customer record statistics from the VXML logs.
Verify the VXML logs for any exceptions. Search the log $CVP_HOME/logs/VXML for the instances “Context service client stats summary” - Verify the reachability /connectivity. The report displays the count, latency, etc for each record. Alerts are captured in syslogServer.
Troubleshooting Context Service Registration Process

This section lists the issues and the possible solutions during registration of the components with the Context Service Cloud.

Cannot Configure Cisco SocialMiner

You cannot configure Cisco SocialMiner, if Context Service fails to connect with it.

Check the Context service logs at C:\icm\tomcat\logs\ContextService. If there are connectivity errors, the Context Service logs provide information similar to this:

0000001306:.*.*.*: Aug 12 2016 16:58:15.629 -0400:
%CCBU_pool-1-thread-35-Infrastructure-1548-3-REST_API_EXCEPTION:
%[exception=com.sun.jersey.api.client.ClientHandlerException:
java.net.SocketTimeoutException: connect timed out][message_string=Failed to make request. Exception is caught for rest call:GET https://.*.*.*:443/ccp-webapp/ccp/contextServiceConfig]: The REST API has caught an exception

To fix the issue, check to see if Cisco SocialMiner is up and running. If Cisco SocialMiner is up and running, check its connection with the principal AW Machine.

If your issue is still unresolved, contact Cisco customer support.

Cannot Register Context Service

When you try to register with Context Service, if registration fails with the following error, check to see if you have an internet connection.

Failed to register with the Context Service because of a connection error. Verify that the server has internet access and/or the proxy server URL is correct.

If your registration fails due to incorrect proxy server URL, check the proxy server configuration in your browser.

If you are still unable to register, the Context Service SDK could have been corrupted, when an automatic update was run.

To recover the corrupted Context Service SDK:

1. Stop the Cisco Tomcat service.
2. Delete the C:\icm\ContextService directory.
3. Restart the Cisco Tomcat service. The Context Service directory is recreated.

If your issue is still unresolved, contact customer support.

Cannot Deregister Context Service

If the AW-HDS-DDS side A can access only the key management system but not the rest of Context Service, registration succeeds. However, deregistration fails because the cluster was not created.
Check the Context Service logs on the Principal AW at:
C:\icm\tomcat\logs\ContextService.*.log. If the cluster was not created, the SDK logs provide information similar to this:

https://hercules-a.wbx2.com/v1/connectors


To fix this issue, check to see if your server is up and running.

If you are still unable to deregister, the Context Service SDK could be corrupt.

To recover the corrupted Context Service SDK:

1. Stop the Cisco Tomcat service.
2. Delete the C:\icm\ContextService directory.
3. Restart the Cisco Tomcat service.

The Context Service directory is recreated. If the issue is still unresolved, contact Cisco support.

**Context Service Registration Incomplete**

When registering or de-registering Context Service, the process stops responding and continues to display one of the following messages:

Registration is in progress

OR

Deregistration is in progress

These messages could occur for the following reasons:

- The proxy is invalid or not reachable. Make sure that the proxy URL is correct and reachable from Finesse.

- The browser pop-up is disabled. Ensure the browser pop-up is enabled.

- The Context Service Cloud services may not be reachable. For more information, see the Fusion Management Connector (FMC) logs located at:
  /opt/cisco/ccbu/logs/fusion-mgmt-connector directory.

- Fusion Management Connector (FMC) is still in the loading state.

**Context Service Registration Status Invalid**

Registering Context Service can fail with this error:

The Context service registration status is invalid. Check the Settings and try again.
This error could occur for the following reasons:

- An invalid client setting update results in an invalid registration state. To ensure that the update keeps the connector in registered state, perform the following:
  1. Correct the client settings.
  2. Save and refresh the page.

  If the update is unsuccessful, try restarting the Cisco Tomcat service. If the issue still persists, re-register Context Service.

- Connection data is invalid. Restart Cisco Tomcat service. If that doesn't help, contact Cisco Support.

Unable to Determine Context Service Registration Status or Client Settings

Errors occur when the Fusion Management web application, deployed on the Platform Tomcat is down, or the Cisco Tomcat service is down.

When this occurs:

- Verify that the Cisco Tomcat service is up and running. The service may not respond with an XML in some error scenarios.
- Restart Platform Tomcat and try again.
- Check the logs under: /opt/cisco/ccbu/logs/fusion-mgmt-connector for more information.

Context Service Registration Incomplete Due to Page Refresh

As part of Context Service registration process, do not refresh the pop up page while the registration or deregistration process is in progress. This may result in an Undefined state for that respective component.

Troubleshooting Context Service Connectivity Process

This section describes the various connectivity related issues that are encountered and the troubleshooting that can be performed for a possible solution.

Activity Operation

Exception related to Activity operation failure

Deployment failure, dynamic jar download failure, context service client initialization failure, or incorrect connection data.

Check that the Context Service extension jar dynamically downloads in the following path:

CVP_HOME/VXMLServer/Tomcat/webapps/CVP/WEB-INF/contextservice/context-service-sdk-downloads

- Check the network connectivity.
- If you use a proxy server, make sure that it is working.

Ensure that the Context Service client initialization is successful.
• Restart the VXML Server service.

Verify that the customer ID is valid and exists.

• Create valid customers.

Verify the VXML logs for any exceptions. Search the log $CVP_HOME/logs/VXML for the instances “CS_SDK_STATUS” - Verify the reachability /connectivity. Alerts are captured in syslogServer.

Context Service Connection Data Not Published

The connection data is published to the configured subscribers in the following scenarios:

• De-registering or cancelling Context Service.

• Registering with Context Service.

• Updating connection data when Context Services sends a notification.

This issue can occur when there is a change in the connection data in the cloud. Also, check for the following log statements in the fusion-management-connector logs at /opt/cisco/ccbu/logs/fusion-mgmt-connector/:

• Error occurred while fetching runtime connector information from DB

• There are no runtime connectors registered in system currently

• Exception occurred while fetching connection data

• Exception occurred while publishing connection data

If the issue persists, contact Cisco Support.

Activity Count Mismatch Between CVP and Other Components

This issue can occur if there is a count mismatch between CVP and other components due to a break in network or cloud connectivity. You will get this error message Activity Failed.

Check the statistics. Context Service Statistics: Unified CVP fetches the customer record related statistics every 30 minutes and writes in the VXML logs and syslogs. These statistics are flushed out immediately post fetching.

Verify the VXML logs for any exceptions. Search the log $CVP_HOME/logs/VXML for the instances “CS_SDK_STATUS” - Verify the reachability /connectivity. Alerts are captured in syslogServer.

Activity Failure in Debug Mode

Error/Exception in VXML logs

Network issue, incorrect connection data

• Verify that the proxy is correct.

• Check if the proxy is working on the web browser.

• Check if the connection data is valid.
Verify the VXmL logs for any exceptions. Search the log "$CVP_HOME/logs/VXML" for the instances "CS_SDK_STATUS" - Verify the reachability / connectivity. Alerts are captured in syslogServer.

**Periodic Logging of Context Service SDK Connector Status**

- Context Service status information is logged periodically into the respective log files.
- The periodic interval is 30 minutes, and this is synchronized to the wall clock time. The log should appear at 1100hrs, 1130hrs, 1200hrs and so on.
- The status message lists the overall status, services used by the connector, information on whether it is reachable, latency and so on.
- Fusion Management Connector logs are located at
  `/opt/cisco/ccbu/logs/fusion-mgmt-connector`
- Finesse Auth logs are located at: `/opt/cisco/desktop/logs/finesse-auth`.

**Periodic Logging of Context Service JMX Counters**

The JMX statistics information is logged into the logs located at `/opt/cisco/desktop/logs/finesse-auth` directory with the text "CS_SDK_STATS_SUMMARY".

---

**Note**

This statistics information is not logged into the Fusion Management Connector logs.

**Troubleshooting Context Service Runtime Process**

This section describes the runtime related issues that are encountered during the runtime connection with the Context Service Cloud. The troubleshooting tips and the possible solution for each are presented.

**Unable to Access Customer Context Information**

In the Cisco Finesse desktop gadget, there may be instances where the customer's context information is not accessible and the following error message is displayed:

**Experiencing issues with accessing customer's context information**

This error message could occur due to the following reasons:

- Invalid client settings. Check and correct the client settings.
- Due to connectivity issues. Check if the Context Service connectivity is accessible from Cisco Finesse.
- Cisco Finesse is not registered with Context Service. Check your Context Service registration. If Context Services is not registered, try again

**Deregister a Component with Context Service**

After registering a server, you can deregister it if you decide to stop using Context Service with that server.
Before you begin

Ensure that your web browser allows popups.

Procedure

Step 1  In Unified CCE Administration, choose Overview > Features > Context Service.
Step 2  Click Deregister.

Your browser displays the Cisco Spark sign-in page.

Step 3  Sign in with your Cisco Webex Control Hub admin credentials and confirm the removal of your Hybrid Services cluster.

You are redirected to the application page for the completion of the deregistration process. The browser window closes automatically after a successful deregistration. Avoid making any changes to the client settings until the deregistration is completed successfully.
Courtesy Callback

- Courtesy Callback, on page 61
- Configure Courtesy Callback, on page 63

Courtesy Callback

Courtesy Callback gives a caller the option to have an agent return their call. This option limits the time a caller waits on the phone for an agent to answer.

Each call has a calculated Estimated Wait Time (EWT). When a caller's EWT approaches zero, the script places a call back to the caller. When the caller answers, the script inserts the caller back into the queue with their original order. The caller reaches an agent in the same time as if they had stayed on the phone.

Figure 7: Courtesy Callback

Courtesy Callback Call Flows

If the caller opts for a callback, they leave their name and phone number. Their request remains in the system. The system places a callback to the caller when the Estimated Wait Time (EWT) reaches the correct value.
The caller answers the call and confirms that they are the original caller, and the system connects the caller to the agent after a short wait.

**Note**

Courtesly Callback is also supported for IP-originated calls.

A typical call flow for this feature follows this pattern:

1. The call arrives at Unified CVP and the call is treated in the normal VRU environment.
2. The Call Studio and Unified CCE Courtesy Callback scripts determine if the caller is eligible for a callback based on your rules.
3. If the caller is eligible, the system announces the EWT and offers the caller a callback when an agent is available.
4. The caller chooses what to do:
   1. If the caller chooses not to use the callback feature, queuing continues as normal.
   2. If the caller chooses to receive a callback, the system prompts the caller to record their name and to key in their phone number.
5. The system writes a database record to log the callback information.

**Note**

If the database is not accessible, the system does not offer a callback to the caller.

6. The caller disconnects from the TDM side of the call. However, the IP side of the call in Unified CVP and Unified CCE is still active. This keeps the call in the same queue position. No queue music plays, so Voice Browser resources used during this time are less than for a caller actually in the queue.
7. When an appropriate agent is close to being available (as determined by your callback scripts), then the system calls the person back. The system announces the recorded name when the callback is made to ensure that correct person accepts the call.
8. A VRU session asks the caller to confirm that they are the correct person and that they are ready for the callback.
   If the system cannot reach the callback number (for example, busy lines, RNA, or network problems), then the call is not sent to an agent. The call also does not go to the agent if the caller does not confirm that they are the correct person. The agent is guaranteed that someone is waiting when they take the call. The system assumes that the caller is already on the line by the time the agent gets the call.
   This feature is called preemptive callback because the system assumes that the caller waits a minimal time for the agent and the caller is on the line when the agent answers.
9. The system presents the call context on the agent screen-pop, as normal.

If the system cannot reach the caller after a configurable number and frequency of retries, the callback cancels and the database status updates appropriately. You can run reports to determine if any manual callbacks are necessary based on your business rules.

**Configure Courtesy Callback**

**Configure Gateway**

**Configure the VXML Gateway for Courtesy Callback**

Complete the following procedure to configure the VXML gateway for Courtesy Callback:

**Procedure**

**Step 1**  
Copy `cvp_ccb_vxml.tcl` from the CVP Operations Console to the flash memory of the gateway, as follows:  
a) Select **Bulk Administration > File Transfer > Scripts and Media.**  
b) In Device Association, select **Gateway** for Device Type.  
c) Select the required gateway from the Available list.  
d) Click the right arrow icon to move the available gateway to the Selected list.  
e) From the default gateway files, highlight `cvp_ccb_vxml.tcl`.  
f) Click **Transfer.**

**Step 2**  
Log on to VXML gateway.

**Step 3**  
Add the `cvp_cc` service to the configuration `service cvp_cc flash:cvp_ccb_vxml.tcl`.  
This service does not require any parameters.

**Step 4**  
Enter the following command to load the application:  
```
call application voice load cvp_cc
```

**Step 5**  
On the VoIP dial-peer that defines the VRU from Unified ICM, verify that the codec can be used for recording.  
**Example:**  
The following example verifies that g711ulaw can be used for recording in Courtesy Callback:  
```
dial-peer voice 123 voip  
service bootstrap  
incoming called-number 123T  
dtmf-relay rte-nte  
h245-signal  
h245-alphanumeric  
codec g711ulaw  
no vad!
```

**Step 6**  
Configure the following to ensure that SIP is setup to forward SIP INFO messaging:  
```
voice service voip  
signaling forward unconditional
```

**Step 7**  
To play the beep to prompt the caller to record their name in the BillingQueue example script add the following text to the configuration:
Configure the Ingress Gateway for Courtesy Callback

Complete the following procedure to configure the ingress gateway for courtesy callback:

Procedure

Step 1  
Copy surviability.tcl from the Operations Console to the flash memory of the gateway, as follows:

a) Select Bulk Administration > File Transfer > Scripts and Media.

b) In Device Association, select Gateway for Device Type.

c) Select the required gateway from the Available list.

d) Click the right arrow icon to move the available gateway to the Selected list.

e) From the default gateway files, highlight surviability.tcl.

f) Click Transfer.

Step 2  
Log onto the ingress gateway.

Step 3  
Add the following to the survivability service:

param ccb id:<host name or ip of this gateway>;loc:<location name>;trunks:<number of callback trunks>

• id - A unique identifier for this gateway and is logged to the database to show which gateway processed the original callback request.

• loc - An arbitrary location name specifying the location of this gateway.

• Trunks - The number of DS0's reserved for callbacks on this gateway. Limit the number of T1/E1 trunks to enable the system to limit the resources allowed for callbacks.

Example:

The following example shows a basic configuration:

service cvp-survivability flash:survivability.tcl
param ccb id:10.86.132.177;loc:doclab;trunks:1!

Step 4  
Create the incoming POTS dial peer, or verify that the survivability service is being used on your incoming POTS dial peer.

Example:
For example,

dial-peer voice 978555 pots
service cvp-survivability
incoming called-number 9785551234
direct-inward-dial!

**Step 5** Create outgoing POTS dial peers for the callbacks. These are the dial peers that place the actual call back out to the PSTN.

**Example:**

For example,

dial-peer voice 978555 pots
destination-pattern 978555....
no digit-strip port 0/0/1:23!

**Step 6** Use the following configuration to ensure that SIP is set up to forward SIP INFO messaging:

`voice service voip signaling forward unconditional`

### Configure CUBE-E for Courtesy Callback

**Note** If you are using CUBE-E then you need sip profile configuration and apply it on outgoing dial-peer through cvp. See the below the example:

A "sip-profile" configuration is needed on ISR CUBE E for the courtesy callback feature. To configure the "sip-profile", the following must be added

```
voice class sip-profiles 103
request INVITE sip-header Call-Info add "X-Cisco-CCBProbe: <ccb param>"
```

where "<ccb param>" is the "ccb" parameter defined in the survivability service. Add this "sip-profile" to the outgoing dial-peer to the CVP.

The following is a configuration example

```
voice class sip-profiles 103
request INVITE sip-header Call-Info add "X-Cisco-CCBProbe: id:10.10.10.180;sydlab;trunks:4"
dial-peer voice 5001 voip
description Comprehensive outbound route to CVP
destination-pattern 5001
session protocol sipv2
session target ipv4:10.10.10.10
dtmf-relay rtp-nnte
voice-class sip profiles 103
codec g711ulaw
```
Configure Unified CVP

Configure the Reporting Server for Courtesy Callback

A reporting server is required for the Courtesy Callback feature. Complete the following procedure to configure a reporting server for Courtesy Callback:

Before you begin
Install and configure the Reporting Server.

Procedure

Step 1 In the Operations Console, select System > Courtesy Callback. The Courtesy Callback Configuration page displays.

Step 2 Choose the General tab.

Step 3 Click the Unified CVP Reporting Server drop-down, and select the Reporting Server to use for storing Courtesy Callback data.

Step 4 If required, select Enable secure communication with the Courtesy Callback database.

Step 5 Configure allowed and disabled dialed numbers. These are the numbers that the system should and should not call when it is making a Courtesy Callback to a caller.

    Note Initially, there are no allowed dialed numbers for the Courtesy Callback feature. Allow Unmatched Dialed Numbers is de-selected and, the Allowed Dialed Numbers window is empty.

Step 6 Adjust the Maximum Number of Calls per Calling Number to the desired number. By default, this is set to 0 and no limit is imposed. This setting allows you to limit the number of calls that are eligible to receive a callback from the same calling number.

    If this field is set to a positive number (X), then the Courtesy Callback Validate element only allows X callbacks per calling number to go through the preemptive exit state at any time.

    If there are already X callbacks offered for a calling number, new calls go through the none exit state of the Validate element.

    In addition, if no calling number is available for a call, the call always goes through the none exit state of the Validate element.
Step 7 Choose the **Call Server Deployment** tab and move the Call Server you want to use for Courtesy Callbacks from the Available box to the Selected box.

Step 8 Click **Save**.

The configuration becomes active (is deployed) the next time the Reporting Server is restarted.

Step 9 You can also deploy the new Reporting Server configuration immediately by clicking **Save & Deploy**.

**Note** After all the updates are configured, restart the Reporting Server to update the configuration.

---

**Configure the Call Studio Scripts for Courtesy Callback**

The Courtesy Callback feature is controlled by a combination of Call Studio scripts and ICM scripts. Complete the following procedure to configure the Call Studio scripts:

**Procedure**

**Step 1** Access the .zip file from the CVP OAMP machine from the location

C:\Cisco\CVP\OPSConsoleServer\StudioDownloads\CourtesyCallbackStudioScripts.zip.

**Step 2** Extract the example Call Studio Courtesy Callback scripts contained in CourtesyCallbackStudioScripts.zip to a folder of your choice on the computer running CallStudio.

Each folder contains a Call Studio project having the same name as the folder. The five individual projects comprise the Courtesy Callback feature.

**Note** Do not modify the scripts CallbackEngine and CallbackQueue.

**Step 3** Modify the scripts **BillingQueue**, **CallbackEntry**, and **CallbackWait** to suit your business needs.

**Step 4** Start Call Studio by selecting **Start > All Programs > Cisco > Cisco Unified Call Studio**.

**Step 5** Select **File > Import**.

The Import dialog box displays.

**Step 6** Expand the **Call Studio** folder and select **Existing Call Studio Project Into Workspace**.

**Step 7** Click **Next**.

The Import Call Studio Project From File System displays.

**Step 8** Browse to the location where you extracted the call studio projects. For each of the folders that were unzipped, select the folder (for example BillingQueue) and select **Finish**.

The project is imported into Call Studio.

**Step 9** Repeat the action in previous step for each of the five folders.

The five projects display in the upper-left of the Navigator window.

**Step 10** Update the Default Audio Path URI field in Call Studio to contain the IP address and port value for your media server.

**Step 11** For each of the Call Studio projects previously unzipped, complete the following steps:

a) Select the project in the Navigator window of Call Studio.

b) Choose **Project > Properties > Call Studio > Audio Settings**.
c) On the Audio Settings window, modify the Default Audio Path URI field to http://<media-server>/en-us/VL/.
d) Click Apply then click OK.

**Step 12**
Under CallbackEntry Project, if required, modify the caller interaction settings in the SetQueueDefault_01 node.
a) In the Call Studio Navigator panel, open the CallbackEntry project and double-click app.callflow to display the application elements in the script window.
b) Open the Start of Call page of the script using the tab at the bottom of the script display window.
c) Select the SetQueueDefault_01 node.
d) In the Element Configuration panel, choose the Setting tab and modify the default settings as required.

**Step 13**
In the CallbackEntry project, on the Wants Callback page, configure the following:
a) Highlight the Record Name node and choose the Settings tab.
b) In the Path setting, change the path to the location where you want to store the recorded names of the callers.
c) Highlight the Add Callback to DB 1 node.
d) Change the Recorded name file setting to match the location of the recording folder that you created in the previous step.
e) Ensure the keepalive Interval (in seconds) is greater than the length of the queue music being played. In the Start of Call page.
   The default is 120 seconds for the SetQueueDefaults_01 node.
f) Save the CallbackEntry project.
g) In the CallbackWait Project, modify values in the CallbackWait application.
   In this application, you can change the IVR interaction that the caller receives at the time of the actual callback. The caller interaction elements in CallbackWait > AskIfCallerReady page may be modified.
   Save the project after you modify it.
h) Validate each of the five projects associated with the Courtesy Callback feature and deploy them to your VXML Server.

**Step 14**
Right-click each Courtesy Callback project in the Navigator window and select Validate.

**Step 15**
Right-click each of the projects and click Deploy, then click Finish.

**Step 16**
Using windows explorer, navigate to %CVP_HOME%\VXMLServer\applications.

**Step 17**
For each of the five Courtesy Callback applications, open the project's admin folder, in %CVP_Home%\VXMLServer\applications, and double-click deployApp.bat to deploy the application to the VXML Server.

**Step 18**
Verify that all the applications are running by going into %CVP_HOME%\VXMLServer\admin and double-clicking status.bat. All five applications should display under Application Name and with the status Running.

**Step 19**
Click Deploy.

**Step 20**
In the Deploy Destination area, select Archive File and click Browse.

**Step 21**
Navigate to the archive folder that you have set up.

**Example:**
C:\Users\Administrator\Desktop\Sample.

**Step 22**
Enter the name of the file.
Configure the Media Server for Courtesy Callback

SeveralCourtesyCallbackspecificmedia files are included with the sample scripts for Courtesy Callback. Complete the procedure to configure the Media Server for Courtesy Callback:

Procedure

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>During the Unified CVP installation, the media files are copied as:</td>
</tr>
<tr>
<td></td>
<td>%CVP_HOME%\OPSConsoleServer\CCBDownloads\CCBAudioFiles.zip.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Unzip the special audio files and copy to your media server \VXMLServer\Tomcat\webapps\CVP\audio.</td>
</tr>
<tr>
<td></td>
<td>The sample scripts are set up to use the default location &quot;\CVP\audio&quot; for the audio files.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Change the default location of the audio files in the sample scripts to be your media server path.</td>
</tr>
</tbody>
</table>

Configure Unified CCE

Configure the ICM Script for Courtesy Callback

Following figure shows the sample Courtesy Callback ICM script.
Configure the ICM Script for Courtesy Callback

![Diagram of ICM Script Flowchart]

Complete the following procedure to configure ICM to use the sample Courtesy Callback ICM script:

**Procedure**

**Step 1**
Copy the CCE example script, **CourtesyCallback.ICMS** to the CCE Admin Workstation. The example CCE script is available in the following locations:

- On the CVP install media in `{CVP\Downloads and Samples}`.
- From the Operations Console in `%CVP_HOME%\OPSConsoleServer\ICMDownloads`.
- In the Import Script - Manual Object Mapping window, map the route and skill group to the route and skill group available for courtesy callback.

**Note** For Small Contact Center Deployment Model, copy the CourtesyCallback.ICMS Routing Script on the desktop where Internet Script editor is installed.

**Step 2**
In Script Editor, select **File > Import Script...**

**Note** For Small Contact Center Deployment Model follow the below steps.

1. Log In to ISE by sub customer user and Click on File>Import Script.
2. Select the Routing script which is copied in the desktop **CourtesyCallback.ICMS**.
Step 3
In the script location dialog, select the CourtesyCallback.ICMS script and click Open.

Note You can bypass the set variable "Set media server" Highlighted as number 1 node in the Figure 57: SampleCourtesyCallbackICMscript, as VXML Server, Call Server, and Media Server are collocated.

Step 4
Define a new ECC variable for courtesy callback.
A new ECC variable is used to determine if a caller is in a queue and can be offered a callback.

Step 5
Navigate to ICM Admin Workstation > ICM Configuration Manager > Expanded Call Variable List tool to create the ECC Variable user.CourtesyCallbackEnabled specific to Courtesy Callback.

Step 6
Set up the following parameters that are passed to CallbackEntry (VXML application):

Example:

- ToExtVXML[0] = concatenate("application=CallbackEntry",";ewt="+Call.user.microapp.ToExtVXML[0])
- ToExtVXML[1] = "qname=billing";
- ToExtVXML[2] = "queueapp=BillingQueue;"
- ToExtVXML[3] = concatenate("ani="+Call.CallingLineID,";");

CallbackEntry is the name of the VXML Server application that will be executed:

ewt is calculated in Block #2.

qname is the name of the VXML Server queue into which the call will be placed. There must be a unique qname for each unique resource pool queue.

queueapp is the name of the VXML Server queuing application that will be executed for this queue.

ani is the caller’s calling Line Identifier.

Step 7
Create Network VRU Scripts.

Step 8
Navigate to ICM Configuration Manager > Network VRU Script List tool, create the following Interruptible Script Network VRU Scripts.

Name: VXML_Server Interruptible

Network VRU: Select your Type 10 CVP VRU

VRU Script Name: GS,Server,V,interrupt

Timeout: 9000 seconds

Interruptible: Checked

Step 9
Choose ICM Configuration Manager > Network VRU Script List tool to create the following Non-Interruptible Script Network VRU Scripts.

Name - VXML_Server NonInterruptible

Network VRU - Select your Type 10 CVP VRU

VRU Script Name - GS,Server,V, nointerrupt

Timeout - 9000 seconds (must be greater than the maximum possible call life in Unified CVP)

Interruptible: Not Checked
Step 10  Verify that the user.microapp.ToExtVXML:ECC variable is set up for an array of five items with a minimum size of 60 characters and the user.microapp.FromExtVXML variable is set up for an array of four with a minimum size of 60 characters.

Note
Verify that you have at least one available route and skill group to map to the route and skillgroup in the example script.

Step 11  Save the script, then associate the call type and schedule the script.

Note  For Small Contact Center Deployment Model ensure the resources used in this Routing Script, like Network VRU Scripts, ECC variables etc are specific to the sub customer.
Database Integration

You can integrate your contact center with an external database. Database integration provides create, update, and retrieve operations on tables in the external database. Database integration uses the Database Element in the CVP Call Studio.

Configure Database Integration

Configure Unified CCE

Configure ICM Database Lookup

Complete the following procedure to configure ICM Database Lookup.

Procedure

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Step 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Enable Database Routing in Router options to edit Router setup for database lookup changes.</td>
<td>Configure Database Lookup explorer:</td>
</tr>
<tr>
<td></td>
<td>a) Click Start &gt; All programs &gt; Cisco Unified CCE Tools &gt; Administration Tools &gt; Configuration Manager.</td>
</tr>
<tr>
<td></td>
<td>b) Open Tools &gt; Explorer Tools &gt; Database Lookup Explorer.</td>
</tr>
<tr>
<td></td>
<td>c) Configure Script Table and Script Table Column as shown in the following example:</td>
</tr>
<tr>
<td></td>
<td>Script Table:</td>
</tr>
<tr>
<td></td>
<td>Name: AccountInfo</td>
</tr>
<tr>
<td></td>
<td>Side A: \dblookup\DBLookup.AccountInfo</td>
</tr>
<tr>
<td></td>
<td>Side B: &lt;Update Side B of database here&gt;</td>
</tr>
</tbody>
</table>
Configure ICM Database Lookup

Description: <Provide description here>

dlookups is external database server name, DBLookup is external database name, and AccountInfo is the table name.

Script Table Column:

Column name: AccountNo

Description: <Provide description here>

Step 3 Configure the following to change the registry settings in Unified CCE:

a) Navigate to HKEY_LOCAL_MACHINE > SOFTWARE > Cisco Systems, Inc. > ICM > <<Instance Name> > RouterA > Router > CurrentVersion > Configuration > Database registry.

   **Instance Name** is the name of the Instance that is configured.

b) Set the SQLLogin registry key as shown in the following example:

   **Example:**
   \dblookup1\DBLookup=(sa,sa)

   Where DBLookup is the external database name and (sa,sa) are the SQL server authentication.

Step 4 Create the ICM script with the database lookup node with the respective table and lookup value.

The following figure shows AccountInfo as the table name and Call.CallingLineID as the lookup value.
Configure Unified CVP

Configure VXML Database Element

You need to configure Java Database Connectivity (JDBC) for VXML Database Element configuration. Complete the following procedures for JDBC configuration:

- Install JDBC driver, on page 76
- Add JNDI Context, on page 76
Install JDBC driver

Complete the following procedure to install the JDBC driver:

Procedure

Step 1
Download the .exe file for Microsoft JDBC Driver for SQL Server
Example:
1033\sqljdbc_3.0.1301.101_enu.exe

Step 2
Run the executable and install the .exe file in the location C:\temp\n
Step 3
Copy the file C:\temp\sqljdbc\3.0\enu\sqljdbc4.jar to the Unified CVP VXXML servers' folder C:\Cisco\CVP\VXMLServer\Tomcat\common\lib

Add JNDI Context

Complete the following procedure to add the Java Naming and Directory Interface (JNDI) context configuration:

Procedure

Step 1
Go to the context.xml file located at C:\Cisco\CVP\VXMLServer\Tomcat\conf\context.xml file.

Step 2
Enter the JNDI name, SQL server address, SQL database name, username and password.
The following is an example of the SQL authentication context.xml file:

```xml
<Context>
  <WatchedResource>WEB-INF/web.xml</WatchedResource>
  <Manager pathname="" />
  <Resource name="jdbc/dblookup"
    auth="Container"
    type="javax.sql.DataSource"
    DriverClassName="com.microsoft.sqlserver.jdbc.SQLServerDriver"
    url="jdbc:sqlserver://<dblookupnode_ipaddress>:1433;databaseName=DBLookup;user=sa;password=sa"
  />
</Context>
```

Step 3
Perform following steps to restart VXML server services:
a) Goto Run window and enter services.msc command.
b) Select Cisco CVP VXXML Server option.
c) Right-click and select Restart option.

---

**Configure VXML Studio Script**

Complete the following procedure to configure the VXML studio script:

**Procedure**

**Step 1** Configure the following to create the VXML application with the database element.

a) Select single under Type.

b) Enter the database lookup name in JNDI Name.

c) Query SQL:

For example, select AccountNo from AccountInfo where CustomerNo = {CallData.ANI}

Where AccountNo = Value to be retrieved

AccountInfo = Table name

CustomerNo = condition to be queried

Data:

Create a database element with the following values:

Name = AccountNo

Value = {Data.Element.Database_01.AccountNo}

**Step 2** Deploy the script to the local computer or to the remote computer (VXML call server directly) to create CVP Subdialog return element.

**Step 3** If you saved this to the local machine, copy the whole folder to the following location:

<Install dir>\Cisco\CVP\VXMLServer\applications and deploy it using deployApp windows batch file located inside the admin folder of applications.

---

**Create ICM Script**

Create an ICM script similar to the one shown in the following figure:
Figure 10: Sample Script with ICM database Lookup

1. **Start**
2. **Set Variable**
   - `user.microapp.ToLineVN = "application=VXMLint"`
3. **Release Call**
4. **Run Ext Script**
   - `Run the 'VXMLint' application`
5. **End**
CHAPTER 8

Music on Hold

Capabilities

Hold and Resume

Agents use Hold to suspend a call temporarily. If Music on Hold resources are available, the caller hears music while on hold. Otherwise, the caller hears a tone.

Multicast Music-on-Hold

As an alternative to the unicast Music-on-Hold (MOH), you can multicast MOH with supplementary services on Unified CM. You have these options when deploying MOH with this feature:

- With Unified CM multicasting the packets on the local LAN
- With the branch gateway multicasting on their local LAN

Use branch gateway multicasting when you have configured survivable remote site telephony (SRST) on the gateway. This method enables the deployment to use MOH locally and avoid MOH streaming over the WAN link.

Note


Music on Hold with Mobile Agent

You can use Music on Hold (MoH) for mobile agents just as you do for traditional agents. To let callers hear music, assign MoH resources to the Ingress Voice Gateway. Specify the user or network audio source on the local CTI port configuration. To let the agent hear music when on hold, assign MoH resources to the Egress Voice Gateway. Specify the user or network audio source on the remote CTI port configuration.
Always assign the MoH resources to the gateways. Do not assign MoH resources to local and remote CTI ports. It is unnecessary and can have a performance impact on the system.

A Mobile Agent remote call over a nailed connection is put on hold when there is no active call to the agent. In general, enable MoH to the mobile agent phone for nailed connection calls. If MoH resources are an issue, consider multicast MoH services.

For a nailed connection, disabling MoH for the remote phone might lead to the hold tone playing instead. This depends on the call processing agent that controls the remote phone. For Unified CM, the hold tone is enabled by default and is similar to the Mobile Agent connect tone. With the Unified CM hold tone enabled, it is difficult for the agent to identify if a call has arrived by listening for the Mobile Agent connect tone. Therefore, disable the hold tone for Unified CM by changing the setting of the Tone on Hold Timer service parameter on Unified CM.

For additional information about MoH design, see the Cisco Collaboration System Solution Reference Network Designs.

Configure Music on Hold

Configure Unified Communication Manager

A Unified Communications Manager Music On Hold (MoH) server can generate MoH stream from an audio file or a fixed source. Either of this can be transmitted as unicast or multicast.

MoH server can be deployed in two modes.

1. Along with Unified CM on the same server for HCS deployments with less than 1250 users in a CM Cluster.

2. As standalone node (TFTP/MoH Server) for HCS deployments with more than 1250 users in a CM Cluster
   - Configure Music On Hold Server Audio Source, on page 80
   - Set up Service Parameters for Music on Hold, on page 81
   - Set up Phone Configuration for Music on Hold, on page 81

Configure Music On Hold Server Audio Source

Procedure

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Login to Cisco Unified Communications Manager Administration page.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Select Media Resources &gt; Music On Hold Audio Source.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Retain the default sample audio source.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Select Initial Announcement from drop down list (optional).</td>
</tr>
<tr>
<td>Step 5</td>
<td>Click Save.</td>
</tr>
</tbody>
</table>
**Set up Service Parameters for Music on Hold**

**Procedure**

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Login to Cisco Unified Communications Manager Administration page.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Select System &gt; Service Parameters.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Select the MoH server from the drop-down list.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Select the app service from Cisco IP Voice Media Streaming App Service drop-down list.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Select the required codec in the Supported MOH Codecs field and click Ok.</td>
</tr>
<tr>
<td>Step 6</td>
<td>Click Save.</td>
</tr>
</tbody>
</table>

**Set up Phone Configuration for Music on Hold**

**Procedure**

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Login to Cisco Unified Communications Manager Administration page.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Select Device &gt; Phone.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Select the phone to configure MOH.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Select a audio source from User Hold MOH Audio Source drop-down list.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Select a audio source from Network Hold MOH Audio Source drop-down list.</td>
</tr>
<tr>
<td>Step 6</td>
<td>Click Save and click Apply and reset the phone.</td>
</tr>
</tbody>
</table>
Set up Phone Configuration for Music on Hold
Precision Queue

Capabilities

Precision Queues

Precision routing offers a multidimensional alternative to skill group routing: using Unified CCE scripting, you can dynamically map the precision queues to direct a call to the agent who best matches the caller's precise needs. Precision queues are the key components of precision routing.

To configure Precision Routing, you must do the following:

1. Create attributes. Attributes are characteristics that can be assigned a True | False value or a Proficiency rating from 1 to 10.
2. Assign attributes to agents.
3. Create precision queues.
4. Create routing scripts.

There is no need to add an agent to a precision queue; agents become members of precision queues automatically based on their attributes. If a precision queue requires an agent who lives in Boston, who speaks fluent Spanish, and who is proficient in troubleshooting a specific piece of equipment, an agent with the attributes Boston = True, Spanish = True, and Repair = 10 is automatically part of the precision queue. A Spanish caller in Boston who needs help with equipment is routed to that agent.

A precision queue includes:

- **Terms**: A term compares an attribute against a value. For example, you can create the following term: Spanish == 10. The term of the attribute is the highest proficiency in Spanish.

  Each precision queue can have multiple attributes, and these attributes can be used in multiple terms. For example, to select an agent with a Spanish proficiency value between 5 and 10, you would create one term for Spanish > 5 and another for Spanish < 10.

- **Expressions**: An expression is a collection of one or more terms. The terms in an expression must share the same operator—they must all be AND or must all be OR relationships.
Steps: A precision queue step is a time-based routing point within the precision queue. A step is a collection of one or more expressions.

A step may also include wait time and a Consider If formula. Use wait time to assign a maximum amount of time to wait for an available agent. Use a Consider If formula to evaluate the step against predefined criteria, for example, another queue.

Navigate to Unified CCE Administration > Manage > Precision Queues to configure precision queues. Administrators can see and manage attributes. Supervisors can configure attributes for their supervised agents on the Attributes tab of the Agents tool.

Skill Groups or Precision Queues?

Should you use skill groups or precision queues for the routing needs of your organization? This section distinguishes the two methods.

Use a Skill Group

A skill group represents a competency or responsibility. For example, it could be a predefined collection of traits, such as salespeople who are in charge of selling to England. The skill group could be called “English sales”. If you wanted to divide the agents in this group into two types of proficiencies (perhaps based on experience), you would need to set up two separate skill groups; for example, English Sales 1 and English Sales 2. You would then associate an agent with one of them, based on the agent's proficiency. Do this by accessing the skill group and locating the agent that you want to add to it (or add that skill group to the agent). To summarize, creating a skill group involves first building a concept of what combinations of traits you want for each agent, like English Sales 2.

Use a Precision Queue

In contrast to skill groups, a precision queue breaks down attribute definitions to form a collection of agents at an attribute level. The agents that match the attribute level of the precision queue become associated with that precision queue.
With precision queues, the preceding English sales example involves defining the attributes English and Sales, and associating agents that have those traits to them. The precision queue English Sales would dynamically map all those agents that had those traits to the precision queue. In addition, you can define more complex proficiency attributes to associate with those agents. This would allow you to build, in a single precision queue, multiple proficiency searches like English language proficiency 10 and sales proficiency 5.

To break down the precision queue example into skill groups, you would need to set up two separate skill groups: English language proficiency 10 and sales proficiency 5. With precision queues, you can refine agents by attributes. With skill groups, you define a skill group and then assign agents to it.

**Decide on Skill Groups or a Precision Queue**

Precision routing enhances and can replace traditional routing. Traditional routing looks at all of the skill groups to which an agent belongs and defines the hierarchy of skills to map business needs. However, traditional routing is restricted by its single-dimensional nature.

Precision routing provides multidimensional routing with simple configuration, scripting, and reporting. Agents are represented through multiple attributes with proficiencies so that the capabilities of each agent are accurately exposed, bringing more value to the business.

If your routing needs are not too complex, consider using one or two skill groups. However, if you want to conduct a search involving as many as ten different proficiency levels in one easily managed queue, use precision queues.

**Attributes**

Attributes identify a call routing requirement, such as language, location, or agent expertise. You can create two types of attributes: Boolean or Proficiency.

When you create a precision queue, you identify which attributes are part of that queue and then implement the queue in a script. When you assign a new attribute to an agent and the attribute value matches the precision queue criteria, the agent is automatically associated with the precision queue.

You must take system limits into account when you assign attributes to agents, and satisfy both of the following conditions:

- A) an agent can have a maximum of 50 attributes
- B) an agent can belong to a maximum total of 50 combined precision queues and skill groups

Failure to meet both of these conditions will result in an unsuccessful configuration operation.

For example, if a particular attribute is used in many precision queues, and that attribute is assigned to an agent, that agent belongs to all of those precision queues. It is therefore possible to exceed condition B by assigning just a few attributes to an agent, if those attributes are used in many precision queues.

It is therefore prudent to plan carefully and to keep system limits in mind when creating attributes and adding them to precision queues.

Navigate to **Unified CCE Administration > Manage > Attributes** to configure attributes.

Administrators can see and manage attributes. Supervisors can configure attributes for their supervised agents on the Attributes tab of the Agents tool.
## Precision Queue Call Flow Example

At a high level, consider a 5-step precision queue with a Consider If formula for *Caller is Premium Member* attached to the Step 1:

- **Step 1 - Attribute**: Skill > 8 - Consider If: Caller is Premium Member
- **Step 2 - Attribute**: Skill > 6
- **Step 3 - Attribute**: Skill > 4
- **Step 4 - Attribute**: Skill > 3
- **Step 5 - Attribute**: Skill >= 1

Caller John, who is not a premium customer, calls 1-800-repairs. John's call is routed to this precision queue.

- Since John is not a premium customer, he is immediately routed out of Step 1 (because of the Consider If on Step 1) and into Step 2 where he waits for his call to be answered.
- After the Step 2 wait time has expired, John's call moves to Step 3 to wait for an agent.
- After the Step 3 wait time has expired, John's call moves to Step 4 to wait for an agent.
- When it arrives at Step 5, John's call will wait indefinitely for an available agent. This step cannot be avoided by any call because there is no routing logic past this.

The overarching idea is that customer will use each successive step to expand the pool of available agents. Eventually, when you reach the "last" step (the step with the highest number), the call is waiting in a potentially very large pool of agents. With each extra step, the chances of the call being handled increase. This also puts the most valuable and skilled agents in the earlier precision queue steps. Calls come to them first before moving on the less appropriate agents in later steps.

---

### Note

When two or more agents have the same proficiently level for the attributes the PQ step leverages the Longest Available Agent (LLA).

## Scripts for Precision Queues

To implement Precision Routing in your contact center, you must create scripts.

You can create and use configured (static) and dynamic precision queue nodes in your scripts.

- **Static precision queue nodes** target a single, configured precision queue. When the script utilizes a single precision queue, use static precision queues.

- **Dynamic precision queue nodes** are used to target one or more previously configured precision queues. Use dynamic precision queues when you want a single routing script for multiple precision queues (for example, when the overall call treatment does not vary from one precision queue to another). Dynamic precision queues can simplify and reduce the overall number of routing scripts in the system.
**Precision Queue Script Node**

Use the Precision Queue script node to queue a call based on caller requirements until an agent with desired proficiency become available. This node contains multiple agent selection criteria which are separated into steps.

A single call can be queued on multiple precision queues. If an agent becomes available in one of the precision queues, the call is routed to that resource. You cannot reference multiple precision queues with a single Precision Queue node. However, you can execute multiple Precision Queue nodes sequentially to achieve this.

The Precision Queue node includes a Priority field, which sets the initial queuing priority for the calls processed through this node versus other calls queued to the other targets using different nodes. The priority is expressed as an integer from 1 (top priority) to 10 (least priority). The default value is 5.

If more than one call is queued to a precision queue when an agent becomes available, the queued call with the lowest priority number is routed to the target first. For example, assume an agent in a precision queue becomes available and two calls are queued to that precision queue. If one call has priority 3 and the other has priority 5, the call with priority 3, the lower value, is routed to the precision queue while the other call continues to wait. If the priorities of the two calls are same, then the call queued first is routed first.

VRU (voice response unit) script instructions are not sent to the VRU. If a call enters the precision queue node and no resource is available, the call is queued to the precision queue and the node transfers the call to the default VRU, if the call is not already on a VRU. The script flow then exits immediately through the success branch. The script should then continue with a run external script node to instruct the VRU what to do while holding the call until an agent becomes available. Typically, this invokes a network VRU script that plays music-on-hold, possibly interrupted on a regular basis with an announcement. The script flow can also use other queuing nodes to queue the same call to other targets, for example, Queue to Skill Group and Queue to Agent.

**Queueing Behavior of the Precision Queue Node**

Precision queues internally are configured with one or more time-based steps, each with a configured wait time. After a call is queued, the first step begins and the timer starts. This occurs although the execution path of the script exited the success node and a new node may be targeted (for example, Run Ext. Script).

If the timer for the first step expires, control moves to the second step (assuming one exists), and so on. As long as the call remains in queue and there are steps left to execute, the call internally continues to move between steps regardless of the path the call takes after it leaves the precision queue node. If a call is queued to two or more precision queues, the call internally walks through the steps for each precision queue in parallel. After the call reaches the last step on a precision queue, it remains queued on that step until the call is routed, abandoned, or ended.

**Dynamic Limits for Skill Groups and Precision Queues Per Agent**

The number of skill groups and precision queues per agent significantly affects the following subcomponents of Unified CCE:

- Cisco Finesse servers
- Agent PGs
- Router
• Logger

Note

We use queue as a common term for skill groups and precision queues.

To maintain the performance of your solution, periodically remove unused queues.

The Reference Designs set a standard limit for the average queues per agent on each PG. On a particular PG, some agents can have more queues than other agents. As long as the average across all the agents on the PG is within the limit, you can still have the maximum active agents on that PG.

For example, assume that you have three groups of agents on a PG in a 4000 Agent Reference Design:

• Group A has 500 agents with five queues each.
• Group B has 1000 agents with 15 queues each.
• Group C has 500 agents with 25 queues each.

These three groups average to 15 queues per agent, so you can have them all on a single PG under the standard limits.

You can also exceed that standard limit if you reduce the number of agents on each PG and on the whole system.

Note

See the configuration tables in the configuration limits chapter for the standard limits.

The Cisco Finesse server does not display statistics for unused queues. So, the active queues affect the performance of the Cisco Finesse server more than the total configured queues.

The Cisco Finesse desktop updates queue (skill group) statistics at 10-second intervals. The Cisco Finesse Desktop also supports a fixed number of queue statistics fields. You cannot change these fields.

This table shows the approximate reduction in the number of agents your solution can support with more queues per agent:

Table 2: Dynamic Agents and Queues Limits

<table>
<thead>
<tr>
<th>Queues per Agent</th>
<th>Maximum Agents per PG</th>
<th>Maximum Agents for 2000 Agent Reference Design</th>
<th>Maximum Agents for 4000 Agent Reference Design</th>
<th>Maximum Agents for 12000 Agent Reference Design</th>
<th>Maximum Agents for 24000 Agent Reference Design</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>2000</td>
<td>2000</td>
<td>4000</td>
<td>12000</td>
<td>24000</td>
</tr>
<tr>
<td>15</td>
<td>2000</td>
<td>2000</td>
<td>4000</td>
<td>12000</td>
<td>16000</td>
</tr>
<tr>
<td>20</td>
<td>1500</td>
<td>1500</td>
<td>3000</td>
<td>9000</td>
<td>12000</td>
</tr>
<tr>
<td>30</td>
<td>1000</td>
<td>1000</td>
<td>2000</td>
<td>6000</td>
<td>8000</td>
</tr>
<tr>
<td>40</td>
<td>750</td>
<td>750</td>
<td>1500</td>
<td>4500</td>
<td>6000</td>
</tr>
<tr>
<td>50</td>
<td>600</td>
<td>600</td>
<td>1200</td>
<td>3600</td>
<td>4800</td>
</tr>
</tbody>
</table>
1 You cannot have more than 4000 Agents on a Rogger deployment.

Unified CCE supports a maximum of 50 unique skill groups across all agents on a supervisor’s team, including the supervisor’s own skill groups. If this number is exceeded, all skill groups that are monitored by the supervisor still appear on the supervisor desktop. However, exceeding this number can cause performance issues and is not supported.

Note

Each precision queue that you configure creates a skill group for each Agent PG and counts toward the supported number of skill groups per PG. The skill groups are created in the same Media Routing Domain as the precision queue.

Initial Setup

When you configure precision queues associated with a large number of agents, the system avoids potential overload conditions by updating the agent associations as system resources allow. Updates may take a few minutes. If you submit multiple configuration updates, the system has a threshold of five concurrent configuration updates, and will reject any updates that exceed the threshold.

Add Attributes

Procedure

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Navigate to Unified CCE Administration Manage &gt; Attributes.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>In the List of Attributes window, click New.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Complete the following fields on the General tab:</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>yes</td>
<td>Type a unique attribute name. For example, to create an attribute for mortgage insurance, type mortgage.</td>
</tr>
<tr>
<td>Description</td>
<td>no</td>
<td>Enter a maximum of 255 characters to describe the attribute.</td>
</tr>
<tr>
<td>Type</td>
<td>no</td>
<td>Select the type: Boolean or Proficiency.</td>
</tr>
<tr>
<td>Default</td>
<td>no</td>
<td>Select the default (True or False for Boolean, or a number from 1 to 10 for Proficiency).</td>
</tr>
</tbody>
</table>

Step 4 Click Save.
Search for Agents

The Search field in the Agents tool offers an advanced and flexible search.

Click the + icon at the far right of the Search field to open a popup window, where you can:

- Select to search for agents only, supervisors only, or both.
- Enter a username, agent ID, first or last name, or description to search for that string.
- Enter one or more site names separated by spaces. (Site is an OR search.)
- Enter one or more peripheral set names separated by spaces (Peripheral Set is an OR search). The search is case-insensitive and does not support partial matches.

Note: Search by department is available only when departments are configured.

Assign Attributes to Agents

Procedure

Step 1
With the selected agent displayed, click the Attributes tab.

Step 2
Complete the Attributes tab:

This tab shows the attributes associated with this agent and their current values.

Click Add to open a popup list of all attributes, showing the name and current default value for each.

a) Click the attributes you want to add for this agent.
b) Set the attribute value as appropriate for this agent.

Add Precision Queue

Procedure

Step 1
Navigate to Unified CCE Administration > Manage > Precision Queues.

This opens a List of Precision Queues window showing all precision queues that are currently configured.

Step 2
Click New to open the New Precision Queue window. Complete the fields.

<table>
<thead>
<tr>
<th>Name</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>no</td>
<td>Enter up to 255 characters to describe the precision queue.</td>
</tr>
<tr>
<td>Name</td>
<td>Required</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>----------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Media Routing Domain</td>
<td>no</td>
<td>MRDs organize how requests for media are routed. The system routes calls to skill groups or precision queues that are associated with a particular communication medium; for example, voice or email. This field defaults to <em>Cisco_Voice</em>.</td>
</tr>
<tr>
<td>Service Level Type</td>
<td>yes</td>
<td>Select the service level type used for reporting on your service level agreement. Service level type indicates how calls that are abandoned before the service level threshold affect the service level calculation.</td>
</tr>
</tbody>
</table>

- **Ignore Abandoned Calls** (the default): Select this option if you want to exclude abandoned calls from the service level calculation.

- **Abandoned Calls have Negative Impact**: Select this option if you want only those calls that are answered within the service level threshold time to be counted as treated calls. The service level is negatively affected by calls that abandon within the service level threshold time.

- **Abandoned Calls have Positive Impact**: Select this option if you consider a call that is abandoned within the service level threshold time as a treated call. With this configuration, abandoned calls have a positive impact on the service level.
<table>
<thead>
<tr>
<th>Name</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Level Threshold</td>
<td>yes</td>
<td>Enter the time in seconds that calls are to be answered based on your service level agreement, from 0 to 2,147,483,647. The time you enter in this field is used to report on service level agreements and does not affect how long a call remains in a precision queue. The length of time a call remains in a step is determined by the wait time for each individual step.</td>
</tr>
<tr>
<td>Agent Order</td>
<td>yes</td>
<td>Select an option to determine which agents receive calls from this queue. The ordering of agents does not dictate the agents who are selected into a Precision Queue step. Agents are included or excluded based on the conditions specified for the step.</td>
</tr>
</tbody>
</table>

- **Longest Available Agent** (the default): The default method of agent ordering for a precision queue. The call is delivered to the agent who has been in the available (or ready) state the longest.

- **Most Skilled Agent**: The call is delivered to the agent who has the highest competency sum from all the attributes pertinent to the Precision Queue step. In an agent-rich environment, this can mean that more competent agents would be utilized more than less competent agents.

- **Least Skilled Agent**: The call is delivered to the agent who has the lowest competency sum from all the attributes pertinent to the Precision Queue step.
<table>
<thead>
<tr>
<th>Name</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bucket Intervals</td>
<td>no</td>
<td>Select the bucket interval whose bounds are to be used to measure the time slot in which calls are answered. The field defaults to the system default. To select a different bucket interval:</td>
</tr>
</tbody>
</table>

**Step 3**  
Click the numbered Step Builder link (Step 1, Step 2, and so on) to build a precision queue step in the **Step Builder** popup window.

**Step 4**  
When you have finished adding, click **Save**.

---

**Consider If Formula for Precision Queue**

If you are not on the last step of the precision queue, then you can enter a **Consider If** formula for that step. A Consider If formula evaluates a call (within a step) against additional criteria. Each time a call reaches a step with a Consider If expression, the expression is evaluated. If the value for the expression returns as true, the call is considered for the step. If the value returns as false, the call moves to the next step. If no expression is provided for a step, the step is always considered for calls.

To add a Consider If formula, type the formula into the **Consider If** box. Alternatively, you can use the Script Editor to build the formula and then copy and paste it into the **Consider If** box. Objects used in Consider If formulas are case-sensitive. All Consider If formulas that you add to a precision queue must be valid. If you add an invalid formula, you cannot save the precision queue. To ensure that the formula is valid, use Script Editor to build and validate the formula.

Only the following scripting objects are valid in a Consider If formula:

- Call
- PQ
- Skillgroup
- ECC
- PQ Step
- Call Type
- Custom Functions (You can create custom functions in Script Editor.)

It is possible that a valid Consider If formula can become invalid. For example, if you delete an object used in the formula after you create or update the precision queue, the formula is no longer valid.

**Consider If Formula Examples**

- PQ.PQ1.LoggedOn > 1--Evaluates whether there is more than one agent logged in to this queue.
• CallType.CallType1.CallsRoutedToday > 100--Evaluates whether more than 100 calls of this call type were routed today.

• PQStep.PQ1.1.RouterAgentsLoggedIn > 1--Evaluates whether there is more than one router agent logged in to this queue for Step 1.

• CustomFunction(Call.PeripheralVariable1) > 10--Evaluates whether this formula using a custom function returns a value greater than 10.

### Build Precision Queue Steps

Every precision queue must have a step, and every step must have an Expression. An Expression is a collection of attribute terms.

#### Procedure

**Step 1**
Click the numbered step link in the **Steps** panel (Step 1, Step 2, and so on).

The step number popup window opens.

**Step 2**
Build the first step as follows.

a) Click the magnifying glass icon to the right of the Select Attribute field in the Expression 1 panel.

b) Select an attribute from the list.

c) Use the two Select fields to establish the terms of the attribute. Click the first Select field to choose an operator.

   • For Boolean attributes, choices are the operators for Equal and Not Equal.

   • For Proficiency attributes, choices are the operators for True, False, Less Than, Less Than or Equal To, Greater Than, and Greater Than or Equal To.

d) Click the second Select field to choose a value.

   • For Boolean attributes, values are True and False.

   • For Proficiency attributes, values are numbers from 1 to 10.

Your selection creates an attribute term for the Expression.

**Step 3**
To add a second attribute to the first Expression, click **Add Attribute** in the **Expression 1** row.

a) Select AND or OR to establish the relationship between the first and second attributes.

b) Repeat steps 2b, 2c, and 2d.

**Step 4**
Continue to add attributes to Expression 1.

All attributes within an expression must be joined by the same logical operator. They must all be ANDs, or they must all be ORs.

**Step 5**
To add a second Expression, click the **Add Attribute** drop-down in the **Expression 1** row and select **Add Expression**.

**Step 6**
Select AND or OR to establish the relationship between the first and second Expressions.

**Step 7**
Add attributes to Expression 2.
Step 8  Continue to add Expressions as needed.

In this example, a Spanish caller located in the Boston area needs an onsite visit from a technician to repair his ServerXYZ. An ideal agent should be fluent in Spanish and have the highest proficiency in ServerXYZ. This can be seen in Expression 1. Expression 2 allows us to specify that the selected agent must also be from either Boston or the New England area.

Step 9  When you have completed the step, click OK to add it to the precision queue.

Step 10 To build the next step, click Add Step.

Each successive step is prepopulated with the Expressions and attributes of its predecessor. Decrease the attribute qualifications and competencies in successive steps to lower the bar such that the pool of acceptable agents increases.

Step 11 When you have created all steps, you can open any step except the last and enter values in the Consider if and Wait for fields.

- Consider if is a formula that evaluates a call within a step against additional criteria. (See Consider If Formula for Precision Queue, on page 93 for more information about Consider If.)

- Wait for is a value in seconds to wait for an available agent. A call will queue at a particular step and wait for an available agent matching that step criteria until the number of seconds specified. A blank wait time indicates that the call will proceed immediately to the next step if no available agents match the step criteria. Wait time defaults to 0 and can take a value up to 2147483647.

---

Configure a Static Precision Queue

**Procedure**

**Step 1** In the Precision Queue Properties dialog box, select the Statically option.

**Step 2** From the list, select a precision queue to which to route all calls that enter this node.
Configure a Dynamic Precision Queue

Procedure

Step 1 In the Precision Queue Properties dialog box, select the Dynamically option.
Step 2 In the Priority selection section, select the initial queuing priority for calls processed through this node. You can select from 1 - 10. The default is 5.
Step 3 Check the Enable target requery check box to enable the requery feature for calls processed through this node.
Step 4 Select a queue option:
  • To dynamically route calls that enter this node to a precision queue name, select the Precision Queue Name option.
  • To dynamically route calls that enter this node to a precision queue ID, select the Precision Queue ID option.
Step 5 Click Formula Editor to create a formula that determines the precision queue name or ID to which to route calls.
Post Call Survey

A Post Call Survey takes place after normal call treatment. Typically, you use the survey to determine whether a customer was satisfied with their experience. You configure a call flow that, after the agent disconnects from the caller, optionally sends the call to a DNIS for the Post Call Survey.

Your VRU asks callers whether they want to participate in a Post Call Survey. If they choose to do so, they are automatically transferred to the Post Call Survey after the normal call flow completes.

Post Call Survey Use Case

The caller is typically asked if they want to participate in a survey during the call. Your solution can determine based on dialed numbers to invoke the post call survey at the end of a call. When the customer completes the conversation with an agent, the customer is automatically redirected to a survey. The hang-up event from the last agent in the call triggers the post call survey.

A customer can use the keypad on a touch tone phone and voice with ASR/TTS to respond to questions asked during the survey. For the solution, the post call survey call is just like another regular call. The post call survey retrieves the call context information from the original customer call.

Post Call Survey Design Impacts

Observe the following conditions when designing a Post Call Survey:

- A Post Call Survey triggers at the hang-up event from the last agent. When the agent hangs up, the call routing script launches a survey script.

- The mapping of a dialed number pattern to a Post Call Survey number enables the Post Call Survey feature for the call.

- The value of the expanded call variable `user.microapp.isPostCallSurvey` controls whether the call transfers to the Post Call Survey number.
• If `user.microapp.isPostCallSurvey` is set to `y` (the implied default), the call transfers to the mapped post call survey number.

• If `user.microapp.isPostCallSurvey` is set to `n`, the call ends.

• To route all calls in the dialed number pattern to the survey, your script does not have to set the `user.microapp.isPostCallSurvey` variable. The variable is set to `y` by default.

• You cannot have a REFER call flow with Post Call Survey. REFER call flows remove Unified CVP from the call. But, Post Call Survey needs Unified CVP because the agent has already disconnected.

• For Unified CCE reporting purposes, the Post Call Survey call inherits the call context for the initial call. When a survey starts, the call context of the customer call that was transferred to the agent replicates into the call context of the Post Call Survey call.

Configure Post Call Survey

Configure Unified CVP

Complete the following procedure to configure Unified CVP.

Procedure

Step 1 Log in to the Unified CVP Operations Console and choose System > Dialed Number Pattern.

Step 2 Enter the following configuration settings to associate incoming dialed numbers with survey numbers:

• **Dialed Number Pattern** - Enter the appropriate dialed number.

  The incoming Dialed Number for calls being directed to a Post Call Survey Dialed. This is the Dialed Number you want to redirect to the survey.

• **Enable Post Call Survey for Incoming Calls** - Select to enable post call survey for incoming calls.

• **Survey Dialed Number Pattern** - Enter the dialed number of the Post Call Survey. This is the dialed number to which the calls should be transferred to after the normal call flow completes.

  • Click **Save** to save the Dialed Number Pattern.

Step 3 Click **Deploy** to deploy the configuration to all Unified CVP Call Server devices.
Configure Unified CCE

Configure ECC Variable

You need not configure Unified CCE to use Post Call Survey, however, you can turn the feature off (and then on again) within an ICM script by using the ECC variable user.microapp.isPostCallSurvey and a value of n or y (value is case insensitive) to disable and re-enable the feature.

Configure the ECC variable to a value of n or y before the label node or before the Queue to Skillgroup node. This sends the correct value to Unified CVP before the agent transfer. This ECC variable is not needed to initiate a Post Call Survey call, but you can use it to control the feature when the Post Call Survey is configured using the Operations Console.

When the DN is mapped in the Operations Console for Post Call Survey, the call automatically transfers to the configured Post Call Survey DN.

Complete the following procedure to enable or disable the Post Call Survey:

**Procedure**

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>On the Unified ICM Administration Workstation, using configuration manager, select the Expanded Call Variable List tool.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Create a new ECC Variable with Name:user.microapp.isPostCallSurvey.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Set Maximum Length to 1.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Select the Enabled check box then click Save.</td>
</tr>
</tbody>
</table>
Task Routing

Task Routing describes the system's ability to route requests from different media channels to any agents in a contact center.

You can configure agents to handle a combination of voice calls, emails, chats, and so on. For example, you can configure an agent as a member of skill groups or precision queues in three different Media Routing Domains (MRD) if the agent handles voice, e-mail, and chat. You can design routing scripts to send requests to these agents based on business rules, regardless of the media. Agents signed into multiple MRDs may switch media on a task-by-task basis.

Enterprise Chat and Email provides universal queue out of the box. Third-party multichannel applications can use the universal queue by integrating with CCE through the Task Routing APIs.

Task Routing APIs provide a standard way to request, queue, route, and handle third-party multichannel tasks in CCE.

Contact Center customers or partners can develop applications using SocialMiner and Finesse APIs in order to use Task Routing. The SocialMiner Task API enables applications to submit nonvoice task requests to CCE. The Finesse APIs enable agents to sign into different types of media and handle the tasks. Agents sign into and manage their state in each media independently.

Cisco partners can use the sample code available on Cisco DevNet as a guide for building these applications (https://developer.cisco.com/site/task-routing/).
SocialMiner and Task Routing

Third-party multichannel applications use SocialMiner's Task API to submit nonvoice tasks to CCE.

The API works in conjunction with SocialMiner task feeds, campaigns, and notifications to pass task requests to the contact center for routing.

The Task API supports the use of Call variables and ECC variables for task requests. Use these variables to send customer-specific information with the request, including attributes of the media such as the chat room URL or the email handle.

**Note**

CCE solutions support only the Latin 1 character set for Expanded Call Context variables and Call variables when used with Finesse and SocialMiner. Arrays are not supported.

CCE and Task Routing

CCE provides the following functionality as part of Task Routing:

- Processes the task request.
- Provides estimated wait time for the task request.
- Notifies SocialMiner when an agent has been selected.
- Routes the task request to an agent, using either skill group or precision queue based routing.
- Reports on contact center activity across media.
Finesse and Task Routing

Finesse provides Task Routing functionality via the Media API and Dialog API. With the Media API, agents using third-party multichannel applications can:

• Sign into different MRDs.
• Change state in different MRDs.

With the Dialog API, agents using third-party multichannel applications can handle tasks from different MRDs.

Task Routing Deployment Requirements

Task Routing for third-party multichannel applications deployment requirements:

• Finesse and SocialMiner are required. Install and configure Finesse and SocialMiner before configuring the system for Task Routing.


• You can install only one SocialMiner machine in the deployment.

• SocialMiner must be geographically colocated with one side of the Media Routing Peripheral Gateway (MR PG).

  SocialMiner must be geographically colocated with one side of the Media Routing Peripheral Gateway (MR PG).

• Install SocialMiner in a location from which CCE, Finesse, and the third-party multichannel SocialMiner Task Routing application can access it over the network.

  If you install SocialMiner in the DMZ, open a port for CCE and Finesse to connect to it. The default port for CCE to connect to SocialMiner is port 38001. Finesse connects to SocialMiner over HTTPS, port 443.

  Install the third-party multichannel application locally with SocialMiner, or open a port on the SocialMiner server for the application to connect to it.

Supported Functionality for Third-Party Multichannel Tasks

Blind transfer is supported for third-party multichannel tasks submitted through the Task Routing APIs. We do not support the following functionality for these types of tasks:

• Agent-initiated tasks.
• Direct transfer.
• Consult and conference.
Plan Task Routing Media Routing Domains

Media Routing Domains (MRDs) organize how requests for each communication medium, such as voice and email, are routed to agents. You configure an MRD for each media channel in your deployment.

Finesse agents can sign into any of the multichannel MRDs you create for Task Routing.

Important factors to consider when planning your MRDs include the following:

- Whether the MRD is interactive.
- The maximum number of concurrent tasks that an agent can handle in an MRD.
- Whether the MRDs are interruptible.
- For interruptible MRDs, whether Finesse accepts or ignores interrupt events.

To configure the settings and parameters described in the following sections, see the following documents:

- Unified CCE Administration, ICM Configuration Manager, and Unified CCDM Portal Configuration, on page 128
- Unified CCE Administration and Configuration Manager Tools, on page 126

Interactive and Non-interactive MRDs

Interactive tasks are tasks in which an agent and customer communicate in real time with each other, such as chats and SMS messages. The customer usually engages with the agent through an application, like a chat window, and leaves this application open while waiting to be connected to an agent. Non-interactive tasks are asynchronous, such as email. The customer submits the request and then may close the application, checking later for a response from an agent.

<table>
<thead>
<tr>
<th>API Parameter or Setting</th>
<th>API/Tool</th>
<th>Possible Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>requeueOnRecovery</td>
<td>SocialMiner Task Submission API</td>
<td>False - customers are not waiting at an interface for an agent, and there is no way to alert them that there was a problem. You need to resubmit these tasks.</td>
</tr>
<tr>
<td>API Parameter or Setting</td>
<td>API/Tool</td>
<td>Possible Values</td>
</tr>
<tr>
<td>-------------------------</td>
<td>----------</td>
<td>-----------------</td>
</tr>
<tr>
<td><strong>dialogLogoutAction</strong></td>
<td>Finesse Media Sign In API</td>
<td>Interactive Task/MRD: Close - customers are engaged with an agent, and can be notified that the task has ended.</td>
</tr>
<tr>
<td><strong>Start Timeout</strong></td>
<td>Media Routing Domains tool in Unified CCE Administration</td>
<td>Shorter duration - customer is waiting at an interface for the agent</td>
</tr>
<tr>
<td><strong>Monitoring status of submitted tasks</strong></td>
<td>SocialMiner Task API or XMPP BOSH eventing</td>
<td>Use SocialMiner Task API status polling for MRDs when you want to monitor the status of a single contact/task.</td>
</tr>
</tbody>
</table>

**Maximum Concurrent Tasks Per Agent**

Specify the maximum number of concurrent tasks for an agent in an MRD when the agent signs into the Finesse application, using the **maxDialogLimit** parameter in the **Finesse Media - Sign In API**.


For agents handling interactive tasks, consider how many concurrent tasks an agent can handle reasonably. How many simultaneous chat sessions, for example, can an agent handle and provide good customer care? If you are using precision queue routing, keep in mind that CCE assigns tasks to agents who match attributes...
for step one, **up to their task limit**, until all of those agents are busy. CCE then assigns tasks to agents who match attributes for step two, up to their task limit, and so on.

**Interruptible and Non-Interruptible MRDs**

When you create an MRD in the Unified CCE Administration Media Routing Domains tool, you select whether the MRD is interruptible.

- **Interruptible**: Agents handling tasks in the MRD can be interrupted by tasks from other MRDs. Non-interactive MRDs, such as an email MRD, are typically interruptible.

- **Non-interruptible**: Agents handling tasks in the MRD cannot be interrupted by tasks from other MRDs. The agents can be assigned tasks in the same MRD, up to their maximum task limits. For example, an agent can handle up to three non-interruptible chat tasks; if the agent is currently handling two chat tasks, CCE can assign the agent another chat, but cannot interrupt the agent with a voice call. Interactive MRDs, such as a chat MRD, are typically non-interruptible. Voice is non-interruptible.

When an agent is working on a non-interruptible task, CCE does not assign a task to any other MRD to the agent. Any application handling the non-voice MRDs must follow the same rule. In certain cases, it is possible that a task from another media routing domain gets assigned to an agent who is working on a non-interruptible task in an MRD.

For example, if an agent is working on a non-interruptible chat MRD and makes an outbound call (internal or external) using the desktop or phone, CCE cannot prevent the agent from making that call. Instead, the system handles this situation differently. CCE marks the agent temp not routable across all media domains until the agent has completed all non-interruptible tasks the agent is currently working on. Because of this designation, the agent is not assigned any new tasks from any MRDs until finishing all current tasks. Even if the agent tries to go ready or routable, the agent's temp not routable status is cleared only after all tasks are complete.

---

**Note**

If you change the MRD from interruptible to non-interruptible or vice versa, the change takes effect once the agent logs out and then logs back in on that MRD.

**Accept and Ignore Interrupts**

Specify whether an MRD accepts or ignores interrupt events when an agent signs into the Finesse application, using the `interruptAction` parameter in the [Finesse Media - Sign In API](https://www.cisco.com/c/en/us/support/docs/unified-calling-experience/Finesse-Media-API-Reference-Guide-12.0.1.html). This setting controls the agent's state in an interrupted MRD and ability to work on interrupted tasks. The setting applies only when a task from a non-interruptible MRD interrupts the agent.

- **Accept**: When an agent is interrupted by a task from a non-interruptible MRD while working on a task in an interruptible MRD, Finesse accepts the interrupt event.

  The agent, CCE task, and Finessedialog state in the interrupted MRD change to INTERRUPTED.

  The agent cannot perform dialog actions while a task is interrupted.

  **Important**

  The application is responsible for disabling all dialog-related activities in the interface when an agent's state changes to INTERRUPTED.

  The agent's time on task stops while the agent is interrupted.
Example: An agent has an email task for 20 minutes, and is interrupted for 3 of those minutes with a chat task. The handled time for the email task is 17 minutes, and the handled time for the chat task is 3 minutes.

- **Ignore:** When an agent is interrupted by another task while working on a task in an interruptible MRD, Finesse ignores the interrupt event.

The new task does not affect any of the agent's other assigned tasks. The agent, CCE task, and Finesse dialog state in the interrupted MRDs do not change.

The agent can perform dialog actions on original task and the interrupting task at the same time. The agent's time on the original task does not stop while the agent is handling the interrupting task.

Example: An agent has an email task for 20 minutes, and is interrupted for 3 of those minutes with a chat task. The handled time for the email task is 20 minutes, and the handled time for the chat task is 3 minutes. This means that during a 20-minute interval, the agent handled tasks for 23 minutes.

If an agent is working on a task in an interruptible MRD and is routed a task in another interruptible MRD, CCE does not send an interrupt event. Therefore, interruptAction setting does not apply.

**Plan Dialed Numbers**

Dialed numbers, also called script selectors, are the strings or numbers submitted with Task Routing task requests through SocialMiner. Each dialed number is associated with a call type, and determines which routing script CCE uses to route the request to an agent.

Dialed numbers are media-specific; you associate each one with a Media Routing Domain.

For Task Routing, plan which dialed numbers the custom SocialMiner application will use when submitting new task requests. Consider whether you will use the same dialed numbers for transfer and tasks that are requeued on RONA, or if you need more dialed numbers.
You must associate each Task Routing dialed number with a call type. The default call type is not supported for Task Routing.

**Skill Group and Precision Queue Routing for Nonvoice Tasks**

Routing to skill groups and precision queues is largely the same for voice calls and nonvoice tasks. However, the way that contact center enterprise distributes tasks has the following implications for agents who can handle multiple concurrent tasks:

- **Precision queues**—In precision queue routing, Unified CCE assigns tasks to agents in order of the precision queue steps. Unified CCE assigns tasks to agents who match attributes for step one, up to their task limit, until all those agents are busy. Unified CCE then assigns tasks to agents who match attributes for step two, and so on. If you configure agents to handle three concurrent tasks, Unified CCE assigns three tasks to each agent in the first step. It then moves on to the second step and assigns any remaining tasks to those agents.

- **Overflow skill groups**—Routing scripts can specify a preferred skill group and an overflow skill group. Unified CCE assigns tasks to all agents in the preferred skill group, up to their task limit, before assigning any tasks in the overflow skill group. If you configure agents to handle three concurrent tasks, Unified CCE assigns three tasks to each agent in the preferred skill group. It then moves on to the overflow skill group and assigns any remaining tasks to those agents.

**Agent State and Agent Mode**

An agent's state and routable mode in an MRD work together to determine whether CCE routes tasks to the agent in that MRD.

**Agent Routable Mode**

The agent's routable mode controls whether CCE can assign the agent tasks in that MRD. If the agent is routable, CCE can assign tasks to the agent. If the agent is not routable, CCE cannot assign tasks to the agent.

The agent changes to routable/not routable through Finesse Media - Change Agent to Routable/Not Routable API calls.

**Agent State**

The agent's state in an MRD indicates the agent's current status and whether the agent is available to handle a task:

- **Ready**: The agent is available to handle a task.
- **Reserved/Active/Paused/Work Ready/Interrupted**: The agent is available to handle a task if the agent has not reached their maximum task limit in the MRD.
- **Not Ready**: The agent is not available to handle a task.

The agent changes to Ready and Not Ready through calls to the Finesse Media - Change Agent State API. The agent's state while working on a task depends on the actions the agent performs on the Finesse dialog related to the task, through calls to the Finesse Dialog - Take Action on Participant API.
How Mode and State Work Together to Determine if an Agent Receives Tasks

CCE will route an agent a task in the MRD if ALL of the following are true:

- The agent's mode is routable, and
- The agent is in any state other than NOT_READY, and
- The agent has not reached the maximum task limit in the MRD, and
- The agent is not working on a task in a different and non-interruptible MRD.

CCE will NOT route an agent a task in the MRD if ANY of the following are true:

- The agent's mode is not routable, or
- The agent is NOT_READY, or
- The agent has reached the maximum task limit in the MRD, or
- The agent is working on a task in a different and non-interruptible MRD.

Why Change the Agent's Mode to Not Routable?

By changing the agent's mode to not routable, you stop sending tasks to the agent without changing the agent's state to Not Ready. You may want to make an agent not routable if the agent is close to ending the shift, and needs to complete in progress tasks before signing out.

If an agent changes to Not Ready state while still working on tasks, CCE reports show those tasks as ended; time spent working on the tasks after going Not Ready is not counted. By making the agent not routable instead of Not Ready, the agent's time on task continues to be counted.

In RONA situations, in which agents do not accept tasks within the Start Timeout threshold for the MRD, Finesse automatically makes agents not routable. Finesse resubmits the tasks through for routing through SocialMiner. The application must make the agent routable in order for the agent to receive tasks again.

SocialMiner and Finesse Task States

In most cases, SocialMiner social contact states do not map directly to Finesse dialog states. For SocialMiner, social contacts are created when the customer submits a task request. For Finesse, the dialog with which the agent engages with the customer is created when the task is routed to the agent.

This table shows the relationships between SocialMiner social contact task states and Finesse dialog states.

<table>
<thead>
<tr>
<th>SocialMiner Social Contact Task State</th>
<th>Finesse Dialog State</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unread: The task request has not been submitted to the contact center.</td>
<td>None</td>
</tr>
<tr>
<td>Queued: The task request is successfully submitted to the contact center as a result of creating a new task or resubmitting a task due to agent transfer, automatic transfer on agent logout, or automatic transfer for RONA.</td>
<td>None</td>
</tr>
</tbody>
</table>
### Task Routing API Request Flows

#### Task Routing API Basic Task Flow

This topic provides the SocialMiner and Finesse API calls and events when an active email task is interrupted by a chat request.

In this scenario, the email MRD is interruptible. When the agent signs into the email MRD, the application uses the Finesse Media API to accept interrupts. The chat MRD is non-interruptible.

1. The email application submits a new email task request to CCE, and polls for status and Estimated Wait Time (EWT).

---

<table>
<thead>
<tr>
<th>SocialMiner Social Contact Task State</th>
<th>Finesse Dialog State</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Reserved:</strong> The task is assigned to an agent. This state includes all work on a task.</td>
<td><strong>Offered:</strong> The dialog is being offered to the agent.</td>
</tr>
<tr>
<td><strong>Accepted:</strong> The agent accepted the dialog but has not started working on it.</td>
<td><strong>Reserved:</strong> The task is assigned to an agent. This state includes all work on a task.</td>
</tr>
<tr>
<td><strong>Active:</strong> The agent is working on the dialog.</td>
<td><strong>Offered:</strong> The dialog is being offered to the agent.</td>
</tr>
<tr>
<td><strong>Paused:</strong> The agent paused the dialog.</td>
<td><strong>Accepted:</strong> The agent accepted the dialog but has not started working on it.</td>
</tr>
<tr>
<td><strong>Wrapping Up:</strong> The agent is performing wrap up activity on the dialog.</td>
<td><strong>Active:</strong> The agent is working on the dialog.</td>
</tr>
<tr>
<td><strong>Interrupted:</strong> The agent is interrupted with a task from a non-interruptible Media Routing Domain. The agent cannot work on this task until the interrupting task is complete.</td>
<td><strong>Paused:</strong> The agent paused the dialog.</td>
</tr>
</tbody>
</table>

**Handled:** SocialMiner receives a handled notification from Finesse indicating that the task ended.

**Closed:** The agent ended the task. Finesse sends a handled notification to SocialMiner.
2. An agent signs in to the email MRD and changes state to Ready.

3. CCE assigns the agent the email task. The Call and ECC variables used to create the task are included in the dialog’s media properties, and contain information such as the handle to the email. The variables can be used to reply to the email. The agent starts work on the email dialog in Finesse.
4. The chat application submits a new chat request, and polls for status and EWT. The same agent logs into the chat MRD.

5. The agent changes state to Ready in the chat MRD. CCE assigns the chat task to the agent. The Call and ECC variables used to create the task are included in the dialog's media properties, and contain information such as the chat room URL. The variables can be used to join the chat room with the customer. The agent starts the chat dialog in Finesse. The Email dialog is interrupted.
6. The agent completes work on the chat dialog and closes the dialog. Finesse sends a handled event to SocialMiner for the chat task. The application is responsible for closing the chat room. The agent is not handling other non-interruptible dialogs, and the email dialog becomes active.

7. The agent continues working on the email dialog, including pausing, resuming, and wrapping up the dialog. The agent closes the dialog. Finesse sends a handle event to SocialMiner for the email task. The application is responsible for sending the email reply to the customer.
Task Routing API Agent Transfer Flow

This illustration provides the SocialMiner and Finesse API calls and events when an agent transfers a task.
1. The agent transfers the dialog from the Finesse application, selecting the script selector to which to transfer the task.

2. Finesse resubmits the task to SocialMiner, and the task is queued to the script selector as a new task.

3. Finesse puts the original dialog in the CLOSED state, with the disposition code CD_TASK_TRANSFERRED. Finesse does not send a handled notification to SocialMiner.

**Task Routing API RONA Flow**

This illustration provides the SocialMiner and Finesse API calls and events in a RONA scenario, in which an agent does not accept an offered task within the Start Timeout threshold for the MRD.

1. The task is routed to an agent, and the dialog is offered to the agent.

2. The Media Routing Domain's Start Timeout threshold expires.

3. CCE instructs Finesse to end the dialog. Finesse puts the dialog in the CLOSED state, with the disposition code CD_RING_NO_ANSWER. Finesse does not send a handled notification to SocialMiner.

4. The Finesse server on which the agent was last signed in resubmits the task to SocialMiner with the original script selector. The task is queued to the script selector as a new task.

5. CCE instructs Finesse to make the agent not routable in that Media Routing Domain, so that the agent is not routed more tasks.

**Task Routing API Agent Sign Out with Tasks Flows**

The Finesse Media - Sign Out API allows agents to sign out with assigned tasks. The dialogLogoutAction parameter set by the Media - Sign In API determines whether those tasks are closed or transferred when the agent signs out.
Close Tasks on Sign Out

This illustration provides the SocialMiner and Finesse API calls and events when agents are set to have assigned tasks closed on sign out.

1. The agent requests to sign out of the MRD with an active task.
2. CCE instructs Finesse to end the task. Finesse puts the dialog in CLOSED state, with the disposition code CD_AGENT_LOGGED_OUT_DURING_DIALOG.
3. The agent is signed out of the MRD.

Transfer Tasks on Sign Out

This illustration provides the SocialMiner and Finesse API calls and events when agents are set to have assigned tasks transferred on sign out.

1. The agent requests to sign out of the MRD with an active task.
2. CCE instructs Finesse to end the dialog. Finesse puts the dialog in the CLOSED state, with the disposition code CD_TASK_TRANSFERRED_ON_AGENT_LOGOUT. Finesse does not send a handled notification to SocialMiner.

3. The Finesse server on which the agent was signed in resubmits the task to SocialMiner with the original script selector. The task is queued to the script selector as a new task.

4. The agent is signed out of the MRD.

---

**Failover and Failure Recovery**

<table>
<thead>
<tr>
<th>Component</th>
<th>Failover/Failure Scenario</th>
<th>New Task Request Impact</th>
<th>Queued, Offered, and Active Task Impact</th>
</tr>
</thead>
<tbody>
<tr>
<td>SocialMiner</td>
<td>MR connection fails. For example, there is a networking problem, the PG loses connection, or SocialMiner loses connection. Finesse loses connection with SocialMiner.</td>
<td><strong>New task requests from SocialMiner application:</strong> New task requests fail, and the failures are delivered back to the application. Details of these failures are described in the next column. <strong>Automatic transfer request from Finesse</strong> (for transfer on sign out or RONA): Results in a lost transfer request. <strong>Agent transfer request:</strong> The request fails, and Finesse sends an error back to the application. Finesse retains the task.</td>
<td><strong>Queued tasks:</strong> When tasks are submitted, they can be set to requeue on recovery. Typically, non-interactive tasks, such as email, are set to requeue on recovery because there is not a way to alert the customer that there was a problem while in queue. Interactive tasks, such as chat, are set not to requeue on recovery because the customer is waiting at an interface for an agent, and there is a way to alert the customer that there is a problem. If tasks are set to requeue on recovery, the task is resubmitted when the MR connection is reestablished. The status and statusReason of the contact does not change. If tasks are set NOT to requeue on recovery, the task's contact's status is marked discarded. The task's contact's statusReason is marked as follows: <strong>SocialMiner failure:</strong> NOTIFICATION_CCE_SOCIALMINER_SYSTEM_FAILURE <strong>MR connection failure:</strong> NOTIFICATION_CCE_CONNECTION_LOST <strong>Offered and active tasks:</strong> No impact.</td>
</tr>
<tr>
<td>Component</td>
<td>Failover/Failure Scenario</td>
<td>New Task Request Impact</td>
<td>Queued, Offered, and Active Task Impact</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------</td>
</tr>
<tr>
<td>SocialMiner</td>
<td>SocialMiner overruns the new task queue limit.</td>
<td>New task requests from SocialMiner application: New task requests are discarded with the statusReason NOTIFICATION_RATE_LIMITED.</td>
<td>Queued, offered, and active tasks: No impact.</td>
</tr>
<tr>
<td></td>
<td>See the Cisco SocialMiner Developer Guide for the limit</td>
<td>Automatic or agent transfer requests: No impact</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(<a href="https://developer.cisco.com/site/socialminer/documentation/">https://developer.cisco.com/site/socialminer/documentation/</a>).</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Finesse</td>
<td>Finesse loses connection with Agent PG or CTI Server</td>
<td>New task request from SocialMiner application: No impact</td>
<td>Agents signed into media on the failed Finesse server are put into WORK_NOT_READY state and made not routable. Tasks on that server are preserved in their current state, and time continues to accrue towards the maximum task lifetime. The agent fails over to the secondary Finesse server, and must sign in to the media again. The agent is put into the previous state. If the agent doesn't have tasks, the agent is put in NOT_READY state. Queued tasks: No impact. Offered tasks: These tasks RONA because the agent cannot accept them. Active tasks: These tasks fail over to the other Finesse server and are recovered on that server. Note Any active tasks that were in INTERRUPTED state at the time of the lost connection change are recovered. However, these tasks change to the UNKNOWN state when the task is no longer INTERRUPTED. The agent can only close tasks when they are in the UNKNOWN state.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Component</td>
<td>Failover/Failure Scenario</td>
<td>New Task Request Impact</td>
<td>Queued, Offered, and Active Task Impact</td>
</tr>
<tr>
<td>-------------</td>
<td>------------------------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------</td>
</tr>
<tr>
<td>Finesse</td>
<td>Agent logs out, or presence is lost while agent has active tasks</td>
<td>Queued tasks: No impact.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Offered tasks: These tasks fail over to the other Finesse server and are recovered on that server. If a task's Start Timeout threshold is exceeded during failover, the task RONAs.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Active tasks: If an agent logs out with active tasks, or agent presence is lost with active tasks, the tasks are either closed or transferred to the original script selector depending on how the agent was configured when signing into the MRD.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>If the tasks are transferred, the disposition code is <strong>CD_TASK_TRANSFERRED_AGENT_LOGOUT</strong>.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>If the tasks are closed, the disposition code is <strong>CD_AGENT_LOGGED_OUT_DURING_DIALOG</strong>.</td>
<td></td>
</tr>
<tr>
<td>Finesse</td>
<td>Finesse application fails</td>
<td>Queued tasks: No impact.</td>
<td></td>
</tr>
<tr>
<td>application</td>
<td></td>
<td>Offered tasks: These tasks may RONA depending on how the application is structured. A Task Routing application may prevent an agent from accepting a dialog when the application down because the agent cannot handle the dialog while the application is down. In this case, the dialog RONAs.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Active tasks: Varies by application. Applications are responsible for managing the tasks while the application is down. Finesse retains the tasks, and the tasks are recovered once the application is restored.</td>
<td></td>
</tr>
</tbody>
</table>
### Task Routing Setup

#### Initial Setup

<table>
<thead>
<tr>
<th>Step</th>
<th>Task</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Configure Finesse with the AW, so that Finesse can access SocialMiner connection information.</td>
<td>See Configure Finesse with the AW, on page 122.</td>
</tr>
</tbody>
</table>

#### Task Routing Setup Table

<table>
<thead>
<tr>
<th>Component</th>
<th>Failover/Failure Scenario</th>
<th>New Task Request Impact</th>
<th>Queued, Offered, and Active Task Impact</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTI Server or OPC</td>
<td>One CTI Server or one OPC fails</td>
<td><img src="image" alt="New task request from SocialMiner application: No impact" /> <img src="image" alt="Automatic transfer requests from Finesse: Results in lost transfers." /></td>
<td>Queued tasks: No impact. Offered tasks: These tasks fail over to the other Finesse server and are recovered on that server. If a task's Start Timeout threshold is exceeded during failover, the task RONAs. Active tasks: These tasks fail over to the other Finesse server and are recovered on that server. Note: Any active tasks that were in INTERRUPTED state at the time of the lost connection change are also recovered. However, these tasks change to the UNKNOWN state when the task is no longer INTERRUPTED. The agent only can only close tasks when they are in the UNKNOWN state.</td>
</tr>
<tr>
<td>OPC</td>
<td>Both OPCs fail</td>
<td><img src="image" alt="New task request from SocialMiner application: No impact" /> <img src="image" alt="Automatic or agent transfer requests: Results in lost transfers." /></td>
<td>Queued tasks: No impact. Offered and active tasks: These tasks are lost</td>
</tr>
<tr>
<td>Step</td>
<td>Task</td>
<td>Notes</td>
<td></td>
</tr>
<tr>
<td>------</td>
<td>----------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Configure a Network VRU and Network VRU scripts.</td>
<td>See Configure Network VRU and Network VRU Scripts, on page 123.</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Configure the MR PG and PIM</td>
<td>See Configure the Media Routing PG and PIM, on page 124.</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Set up the MR PG and PIM for SocialMiner.</td>
<td>See Set up the Media Routing PG and PIM, on page 124.</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Add SocialMiner as an External Machine in the System Inventory</td>
<td>The system configures the following settings automatically in SocialMiner Administration:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Enables and configures the <strong>CCE Multichannel Routing settings</strong>.&lt;/p&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Configures the Task feed and the associated campaign and Connection to CCE notification needed for the Task Routing feature.</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Configure the following in Unified CCE Administration or Configuration Manager:</td>
<td>• Media Routing Domains</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Call types</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Dialed numbers</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Skill groups or precision queues</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• ECC variables</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Agent desk settings</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>See Unified CCE Administration and Configuration Manager Tools, on page 126.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>See Unified CCE Administration, ICM Configuration Manager, and Unified CCDM Portal Configuration, on page 128</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Increase the TCDTimeout registry key value, if you are using precision queues and will be submitting potentially long tasks, like email.</td>
<td>See Increase TCDTimeout Value, on page 129.</td>
<td></td>
</tr>
<tr>
<td>Step</td>
<td>Task</td>
<td>Notes</td>
<td></td>
</tr>
<tr>
<td>------</td>
<td>------</td>
<td>-------</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Create routing scripts&lt;br&gt;See Create Routing Scripts for Task Routing, on page 131.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Create SocialMiner and Finesse Applications**

<table>
<thead>
<tr>
<th>Step</th>
<th>Task</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>Create the SocialMiner multichannel application to begin task requests.&lt;br&gt;See Sample SocialMiner HTML Task Application, on page 131.</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Create the Finesse applications to manage nonvoice agent and dialog states.&lt;br&gt;See Sample Finesse Code for Task Routing, on page 132.</td>
<td></td>
</tr>
</tbody>
</table>

**Set up Finesse**

<table>
<thead>
<tr>
<th>Step</th>
<th>Task</th>
<th></th>
</tr>
</thead>
</table>

---

**Configure Finesse with the AW**

Finesse connects to SocialMiner to transfer Task Routing tasks and resubmit tasks for RONA. The Finesse AWDB user requires special database permissions to access SocialMiner connection information. Map the user to the Side A, AWDB, and master databases. In these databases, give the user the db_datareader and public roles.

**Before you begin**

Configure the Contact Center Administration and Data Server Connection Settings on Finesse. You need the Finesse AWDB username to complete this procedure.


Procedure

Step 1 Determine whether the Finesse AWDB user is a domain user or a SQL user. If the user is a domain user, proceed to the last step in the procedure (step 7). Otherwise, complete all of the steps.

Step 2 Launch Microsoft SQL Server Management Studio on the Unified CCE Administration Client workstation.

Step 3 Connect to the Side A Logger using the default credentials.


Step 5 Select the User Mapping page, and perform the following:
   a) Verify that the databases associated with Side A and AWdb are checked.
   b) Check the master database.
   c) Select the Side A database. In the Database role membership for section, check the db_datareader and public roles.

   Repeat this step for the AWdb and master databases.

d) Click OK.

Step 6 Repeat these steps on the Side B Logger.

Step 7 Execute the following SQL queries as the SQL administrative user "sa" or as a user with sysadmin privileges. For <user>, enter the Finesse AWDB username. If the Finesse AWDB user is a domain user, rather than a SQL user, use the <domain\user> format.

```
USE master
GO
GRANT CONTROL ON CERTIFICATE :: UCCESymmetricKeyCertificate TO "<user>"
GRANT VIEW DEFINITION ON SYMMETRIC KEY :: UCCESymmetricKey TO "<user>"
```

Configure Network VRU and Network VRU Scripts

The Network VRU is used to queue nonvoice tasks if an agent is not available to handle them. The Network VRU Script is used to return estimated wait time to customers. For more information on writing routing scripts that return estimated wait time, see the Scripting and Media Routing Guide for Cisco Unified ICM/Contact Center Enterprise at https://www.cisco.com/c/en/us/support/customer-collaboration/unified-contact-center-enterprise/products-user-guide-list.html.

When you configure the Network VRU Script, you specify whether it is interruptible. The Interruptible setting for the Network VRU Script controls whether the script can be interrupted (for example if an agent becomes available). This setting is not related to the Media Routing Domain Interruptible setting, which controls whether an agent working on a task in that MRD can be interrupted by a task from a non-interruptible MRD.

Procedure

Step 1 In Configuration Manager, use the Network VRU Explorer tool to configure and save a type 2 VRU.

Step 2 Use the Network VRU Script List tool to add a Network VRU Script that references this Network VRU.
Configure the Media Routing PG and PIM

Procedure

Step 1 In Configuration Manager, open the PG Explorer tool to configure a media routing PG.

Step 2 Create a media routing PIM and routing client for SocialMiner. Write down the Logical Controller ID and the Peripheral ID. You will use them when you set up the PG.

Step 3 On the Peripheral tab in the PG Explorer tool, check the Enable post routing check box.

Step 4 On the Routing Client tab in the PG Explorer tool, select the Multichannel option from the Routing Type drop-down list box.

Note The Default call type setting is not supported for tasks submitted through the Task Routing APIs.

Step 5 On the Advanced tab in the PG Explorer tool, select the type 2 Network VRU that you created.

Set up the Media Routing PG and PIM

Caution Before performing the step to enable the secured connection between the components, ensure that the security certificate management process is completed.

Procedure

Step 1 From Cisco Unified CCE Tools, select Peripheral Gateway Setup.

Step 2 On the Components Setup screen, in the Instance Components panel, select the PG Instance component. If the PG does not exist, click Add. If it exists, click Edit.

Step 3 On the Components Setup screen, in the Instance Components panel, select the PG Instance component. If the PG does not exist, click Add. If it exists, click Edit.

Step 4 In the Peripheral Gateways Properties screen, click Media Routing. Click Next.

Step 5 Click Yes at the prompt to stop the service.

Step 6 From the Peripheral Gateway Component Properties screen, click Add, select the next PIM, and configure with the Client Type of Media Routing as follows.

a) Check Enabled.

b) In the Peripheral Name field, enter MR.

c) In the Peripheral ID field, enter the Peripheral ID that you recorded when you configured the Media Routing PG and PIM.
d) In the **Peripheral ID** field, enter the Peripheral ID that you recorded when you configured the Media Routing PG and PIM.

e) For **Application Hostname (1)**, enter the hostname or IP address of SocialMiner.

f) By default, SocialMiner accepts the MR connection on **Application Connection Port** 38001. The Application Connection Port setting on SocialMiner must match the setting on the MR PG. If you change the port on one side of the connection, you must change it on the other side.

g) Leave the **Application Hostname (2)**, field blank.

h) Keep all other values.

i) Check the **Enable Secured Connection** option. This establishes a secured connection between MR PIM and Application Server. Ensure that you provide the correct information in the Application Hostname (1) and Application Connection Port (1) fields.

j) Click **OK**.

**Step 7**
On the Peripheral Gateway Component Properties screen, enter the Logical Controller ID that you recorded when you configured the Media Routing PG and PIM.

**Step 8**
On the Peripheral Gateway Component Properties screen, enter the Logical Controller ID that you recorded when you configured the Media Routing PG and PIM.

**Step 9**
Accept defaults and click **Next** until the Setup Complete screen opens.

**Step 10**
At the Setup Complete screen, check **Yes** to start the service. Click **Finish**.

**Step 11**
Click **Exit Setup**.

**Step 12**
Repeat this procedure for Side B.

---

**Add SocialMiner as an External Machine**

When you add SocialMiner as an External Machine in the Unified CCE Administration System Inventory, the system automatically performs the following SocialMiner configuration:

- Enables and completes the **CCE Configuration for Multichannel Routing** settings in SocialMiner Administration.

  These settings include the hostnames of the MR PGs and the Application Connection Port you specified when setting up the MR PG and PIM.

  These settings include the hostnames of the MR PGs and the Application Connection Port you specified when setting up the MR PG and PIM.

- Configures the Task feed and the associated campaign and Connection to CCE notification needed for the Task Routing feature, with the following names:

  - **Task feed**: Cisco_Default_Task_Feed
  
  - **Campaign**: Cisco_Default_Task_Campaign
  
  - **Notification**: Cisco_Default_Task_Notification
  
  - **Tag**: cisco_task_tag
If the Task feed has been configured to use a different tag, the Connection to CCE notification is configured to use that tag.

Procedure

Step 1 Navigate to **Unified CCE Administration** > **System** > **Deployment**.
Step 2 Click Add.
Step 3 Click Add.
Step 4 Select **SocialMiner** from the drop-down list.
Step 5 Enter the fully qualified domain name (FQDN), hostname or IP address in the **Hostname** field.

**Note** The system attempts to convert the value you enter to FQDN.

Step 6 Enter the SocialMiner Administration username and password.
Step 7 Select the **Side A** and **Side B** Media Routing PGs.
Step 8 Enter the Application Port you specified when setting up the MR PG and PIM. The default value is 38001.
Step 9 Select the **Side A** and **Side B** Media Routing PGs.
Step 10 Enter the Application Port you specified when setting up the MR PG and PIM. The default value is 38001.
Step 11 Click **Save**.

**Unified CCE Administration and Configuration Manager Tools**

This topic explains the Unified CCE Administration and Configuration Manager tools you need to configure Task Routing.

**Before you begin**

For details on the procedures for these steps, refer to the Unified CCE Administration online help and the Configuration Manager online help.

**Procedure**

**Step 1** Sign into Unified CCE Administration.
**Step 2** From the **Manage** menu, configure the following:

<table>
<thead>
<tr>
<th>Item to Configure</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Media Routing Domains</td>
<td>Create an MRD for each type of task that the third-party multichannel application submits to CCE (email, chat, and so on).</td>
</tr>
</tbody>
</table>
### Step 3
Launch Configuration Manager.

### Step 4
Configure the following:

<table>
<thead>
<tr>
<th>Item to Configure</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Precision Queues</td>
<td>Configure either skill groups or precision queues. If you configure precision queues:</td>
</tr>
<tr>
<td></td>
<td>• For Media Routing Domain, select one of the Task Routing MRDs you created.</td>
</tr>
<tr>
<td></td>
<td>• Associate agents with attributes that are part of the precision queue steps.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Item to Configure</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call Types</td>
<td>Create call types for Task Routing.</td>
</tr>
<tr>
<td>Dialeed Numbers</td>
<td>Create dialed numbers for Task Routing. Add the numbers or strings that the custom application will use when submitting task requests.</td>
</tr>
<tr>
<td></td>
<td>• On the Attributes tab, select a Task Routing MRD from the Media routing domain drop-down list box.</td>
</tr>
<tr>
<td></td>
<td>• On the Dialed Number Mapping tab, map the script selector to a call type you created for Task Routing.</td>
</tr>
<tr>
<td></td>
<td><strong>Important</strong> Each dialed number must be associated with a call type. Default call type is not supported for tasks submitted with Task Routing APIs.</td>
</tr>
<tr>
<td>Skill Groups</td>
<td>Configure either skill groups or precision queues. If you configure skill groups:</td>
</tr>
<tr>
<td></td>
<td>• For Media Routing Domain, select one of the Task Routing MRDs you created.</td>
</tr>
<tr>
<td></td>
<td>• Assign agents to the skill group.</td>
</tr>
<tr>
<td>Expanded Call Variable</td>
<td>You can use an existing Expanded Call Variable, or you can create an Expanded Call Variable for Task Routing, depending on the needs of your third-party multichannel application.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> Arrays are not supported with the Task Routing feature. CCE solutions support the Latin 1 character set only for Expanded Call Context variables and Call variables when used with Finesse and SocialMiner.</td>
</tr>
</tbody>
</table>
Unified CCE Administration, ICM Configuration Manager, and Unified CCDM Portal Configuration

This topic explains the Unified CCE Administration, Configuration Manager, and Unified CCDM portal tools you need to configure Task Routing.

Before you begin

For details on the procedures for these steps, refer to the Unified CCE Administration online help, Configuration Manager online help, and the Unified CCDM portal online help.

Procedure

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Sign in to Unified CCE Administration.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>From the Manage menu, configure the following:</td>
</tr>
<tr>
<td></td>
<td><strong>Item to Configure</strong></td>
</tr>
<tr>
<td></td>
<td>Agent Desk Settings</td>
</tr>
<tr>
<td></td>
<td>Media Routing Domains</td>
</tr>
</tbody>
</table>

| Step 3 | Launch Configuration Manager. |
|        | Step 4 | Configure the following: |
|        | **Item to Configure** | **Details** |
|        | Agent Desk Settings | If agents will use a Task Routing gadget in the Finesse desktop, leave the Logout inactivity time setting for those agents blank, or remove the existing value. Otherwise, if the agent exceeds the Logout inactivity time in the voice MRD, the agent is logged out of the Cisco Finesse desktop, even if the agent is actively working on tasks from nonvoice MRDs. The agent needs log into the desktop again to continue working on the nonvoice tasks. |

<table>
<thead>
<tr>
<th>Step 5</th>
<th>Log in to the Unified CCDM portal as tenant or sub customer user.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 6</td>
<td>Configure the following:</td>
</tr>
</tbody>
</table>
### Item to Configure | Details
---|---
Call Types | Create call types for Task Routing.
Dial Numbers | Create dialed numbers for Task Routing. Add the numbers or strings that the third-party multichannel application will use when submitting task requests.
  - For **Media Routing Domain**, select one of the Task Routing MRDs.
  - For **Call Type**, select a call type that you created for Task Routing.
    - **Important** Each dialed number must be associated with a call type. Default call type is not supported for tasks submitted with Task Routing APIs.
Skill Groups | Configure either skill groups or precision queues.
  - If you configure skill groups:
    - For **Media Routing Domain**, select one of the Task Routing MRDs you created.
    - Assign agents to the skill group.
Precision Queues | Configure either skill groups or precision queues.
  - If you configure precision queues:
    - For **Media Routing Domain**, select one of the Task Routing MRDs you created.
    - Associate agents with attributes that are part of the precision queue steps.
Expanded Call Variable | You can use an existing Expanded Call Variable, or you can create an expanded call variable for Task Routing, depending on the needs of your third-party multichannel application.
  - **Note** Arrays are not supported with the Task Routing feature.
  - CCE solutions support the Latin 1 character set only for Expanded Call Context variables and Call variables when used with Finesse and SocialMiner.

### Increase TCDTimeout Value

Complete this procedure only if you are using precision queues and routing tasks with potentially long durations, like emails.

Several precision queue fields in the Termination_Call_Detail record are not completed until the end of a task. These precision queue fields are blank for tasks whose durations exceed the TCDTimeout registry key value. The default value of the TCDTimeout registry key is 9,000 seconds (2.5 hours).
If you are configuring a system to handle email or other long tasks, you can increase the TCDTimeout registry key value to a maximum of 86,400 seconds (24 hours).

Change the registry key on either the Side A or B Router.

Change the registry key on either the Side A or B Router.

**Procedure**

Modify the following registry key:

```
HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems, Inc.\Icm\<instance name>\Router\A/B\Router\CurrentVersion\Configuration\Global\TCDTimeout.
```
Create Routing Scripts for Task Routing


Ensure that the routing scripts include skill groups or precision queues from the appropriate Media Routing Domains to handle all of the types of tasks that can be routed with the scripts. For example, if a script is used to route email tasks, be sure that the script includes skill groups or precision queues from an email MRD.

Sample Code for Task Routing

Cisco Systems has made sample Task Routing application code for SocialMiner and Finesse available to use as baselines in building your own applications.

Sample SocialMiner HTML Task Application

The sample SocialMiner HTML Task application:

- Submits task requests to CCE.
- Retrieves and displays the estimated wait time, if it has been configured in CCE.

You cannot copy and paste this code to achieve a working application. It is only a guideline.

The sample application uses the Task API. For more information about how to use the Task API, see the Cisco SocialMiner Developer Guide at https://developer.cisco.com/site/socialminer/documentation/index.gsp.

Procedure

Step 1
Download the sample HTML Task application from DevNet: https://developer.cisco.com/site/task-routing/.

Step 2
Read the sample application's readme.txt file to complete the prerequisites and use the sample application.
Sample Finesse Code for Task Routing

The Finesse sample Task Management Gadget application lets agents perform the following actions in individual nonvoice Media Routing Domains:

• Sign in and out.
• Change state.
• Handle tasks.

The sample gadget also signals the Customer Context gadget to display a customer record.

Note
You cannot copy and paste this code to achieve a working application. It is only a guideline.

For more information about how to use the APIs available for Task Routing, see the Cisco Finesse Web Services Developer Guide at https://developer.cisco.com/site/finesse/.

Procedure

Step 1
Download the sample Task Management Gadget application (TaskManagementGadget-x.x.zip) from DevNet: https://developer.cisco.com/site/task-routing/.

Step 2
Read the sample application's readme.txt file to complete the prerequisites and use the sample application.

For more information about uploading third-party gadgets to the Finesses server, see the "Third Party Gadgets" chapter in the Cisco Finesse Web Services Developer Guide at https://developer.cisco.com/site/finesse/.


Task Routing Reporting

Cisco Unified Intelligence Center CCE reports include data for voice calls and nonvoice Task Routing tasks. You can filter these All Fields and Live Data report templates by Media Routing Domain:

• Agent Real Time
• Agent Skill Group Real Time
• Enterprise Skill Group Real Time
• Enterprise Skill Group Real Time All Fields
• Peripheral Skill Group Real Time All Fields
• Precision Queue Real Time All Fields
• Agent Precision Queue Historical All Fields
• Agent Skill Group Historical All Fields
• Peripheral Skill Group Historical All Fields
• Precision Queue Abandon Answer Distribution Historical
• Precision Queue Interval All Fields
• Skill Group Abandon-Answer Distribution Historical
• Precision Queue - Live Data
• Skill Group - Live Data


Unified Communications Manager Extension Mobility

Capabilities

Extension Mobility is a Unified Communications Manager feature that you can use in Unified CCE. The feature enables users to temporarily configure a phone as their own by logging in to that phone. Once a user logs in, the phone adopts the individual user device profile information, including line numbers, speed dials, services links, and other user-specific properties of a phone.

Cisco Extension Mobility (EM) works on phones that are relocated within the same Cisco Unified Communications Manager cluster. Cisco Extension Mobility Cross Cluster (EMCC) works on phones that are located in different Cisco Unified Communications Manager clusters.

The main documentation on this feature is in the Unified Communications Manager documentation. For more information, see the following sources:

<table>
<thead>
<tr>
<th>Information Type</th>
<th>Sources</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extension Mobility API</td>
<td><a href="https://developer.cisco.com/site/extension-mobility/">https://developer.cisco.com/site/extension-mobility/</a></td>
</tr>
</tbody>
</table>
You configure EM and EMCC in the Cisco Unified Communications Manager. Take into account the following interactions between Unified CCE and Unified Communications Manager for successful implementation of EM and EMCC within a Unified CCE solution:

- For Unified CCE configurations with multiline agent phone line control on the PG, configure all directory numbers for the user profile in Cisco Unified Communications Manager as follows:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Number of Calls</td>
<td>2</td>
</tr>
<tr>
<td>Busy Trigger</td>
<td>1</td>
</tr>
</tbody>
</table>

- For Unified CCE configurations with single-line agent phone line control on the PG, configure the secondary lines (but not the primary ACD line) for the directory number of the user profile in Cisco Unified Communications Manager as follows:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Number of Calls</td>
<td>4</td>
</tr>
<tr>
<td>Busy Trigger</td>
<td>2</td>
</tr>
</tbody>
</table>

- You cannot use phones with an IP Addressing Mode of IPv6 Only for Cisco Extension Mobility. If you want to use Cisco Extension Mobility with the phone, you must configure the phone with an IP Addressing Mode of IPv4 Only or IPv4 and IPv6.

- Agents can log in to multiple devices, depending on the Intra-cluster Multiple Login Behavior service parameter. You can set this parameter for EM implementations. EMCC implementations require that you set this parameter for multiple logins.

If an agent fails to log out of a device, another agent who attempts to access that device gets a "shared line" error. Follow these Unified Communications Manager configuration guidelines to avoid shared line errors:

- For EM implementations with hard phones, set the Intra-cluster Multiple Login Behavior Extension Mobility service parameter to "Auto Logout".

- For EM implementations with a mix of hard and IP phones and for all EMCC implementations, limit the time that an agent can remain logged in to a device. Set the Intra-cluster Maximum LoginTime service parameter to the typical time that an agent remains logged in to a device during a shift.

CHAPTER 13

Whisper Announcement

- Capabilities, on page 137
- Configure Whisper Announcement, on page 139
- Reporting and Serviceability, on page 148

Capabilities

Whisper Announcement plays a brief, prerecorded message to an agent just before the agent connects with each caller. The announcement plays only to the agent; the caller hears ringing (based on existing ring tone patterns) while the announcement plays.

The content of the announcement can contain information about the caller that helps prepare the agent to handle the call. The information can include caller language preference, choices the caller made from a menu (Sales, Service), customer status (Platinum, Gold, Regular), and so on.

After Whisper Announcement is enabled, the played announcements are specified in the call routing scripts. The determination of which announcement to play is controlled in the script and is based on various inputs, such as the dialed number, a customer ID look up in your customer database, or selections you made from a VRU menu.

While a Whisper Announcement Is Playing

Only one Whisper Announcement can play for each call. While a Whisper Announcement is playing, you cannot put the call on hold, transfer, conference, or release the call, or request supervisor assistance. These features become available again after the whisper is complete.
Whisper Announcement Call Flows

The standard call flow with Whisper Announcement is as follows:

1. Incoming call arrives at CVP from the carrier.
2. CVP sends the call to Unified CCE.
3. Unified CCE instructs CVP to queue the call.
4. CVP sends the call to the Voice Browser.
5. Unified CCE sends the agent label with the whisper announcement prompt.
6. CVP sends the call to Unified CM.
7. Unified CM sends the call to the agent phone.
8. The caller continues to hear ringback. The agent hears the whisper announcement.
9. When the whisper announcement ends, the caller connects to the agent.

Whisper Announcement Design Impacts

Whisper Announcement has these limitations:

- Announcements do not play for outbound calls made by an agent. The announcement plays for inbound calls only.
- For Whisper Announcement to work with agent-to-agent calls, use the SendToVRU node before you transfer the call to the agent. Transfer the call to Unified CVP before you transfer the call to another
agent. Then, Unified CVP can control the call and play the announcement, regardless of which node transfers the call to Unified CVP.

- Announcements do not play when the router selects the agent through a label node.
- CVP Refer Transfers do not support Whisper Announcement.
- Whisper Announcement supports Silent Monitoring. However, for Unified Communications Manager-based Silent Monitoring, supervisors cannot hear the announcements themselves. The supervisor desktop dims the Silent Monitor button while an announcement plays.
- Only one announcement can play for each call. While an announcement plays, you cannot put the call on hold, transfer, or conference; release the call; or request supervisor assistance. These features become available again after the announcement completes.
- The codec settings for Whisper Announcement recording and the agent's phone must match. For example, if Whisper Announcement is recorded in G.711 ALAW, the phone must also be at G.711 ALAW. If Whisper Announcement is recorded in G.729, the phone must support or connect using G.729.
- In an IPv6-enabled environment, Whisper Announcement might require extra Media Termination Points (MTPs).

**Whisper Announcement Media Files**

You store and serve your Whisper Announcement audio files from the Cisco Unified Contact Center Enterprise (Unified CCE) media server. This feature supports only the wave (.wav) file type. The maximum play time for a Whisper Announcement is subject to a timeout. Playback terminates at the timeout regardless of the actual length of the audio file. The timeout is 15 seconds. In practice, you may want your messages to be much shorter than that, 5 seconds or less, to shorten your call-handling time.

**Whisper Announcement with Transfers and Conferences**

When an agent transfers or starts a conference call to another agent, the second agent hears an announcement if the second agent's number supports Whisper Announcement. For consultative transfers or conferences, while the announcement plays, the caller hears whatever normally plays during hold. The first agent hears ringing. In the case of blind transfers, the caller hears ringing while the announcement plays.

**Whisper Announcement Sizing Considerations**

The impact of Whisper Announcement on solution component sizing is not as significant as the impact caused by Agent Greeting.

**Configure Whisper Announcement**

Complete the following procedures for Whisper Announcement configuration:

- Configure Gateway, on page 140
- Configure Unified CVP, on page 140
- Configure Unified CCE, on page 142
Configure Gateway

Gateway uses two different dialed numbers for Whisper Announcement.

- 91919191 number calls the ring tone that the caller hears while the whisper plays to the agent
- 9191919100 number calls the whisper itself

Configure a dial peer for incoming number 9191919100 and 91919191 as follows:

dial-peer voice 919191 voip
description CVP SIP ringtone dial-peer
service ringtone
incoming called-number 9191T
voice-class sip rel1xx disable
dtmf-relay rtp-nte
codec g711ulaw
no vad

Configure Unified CVP

Create Whisper Announcement Audio Files

You must create audio files for each different Whisper Announcement you want to use on your system; for example, “Sales, English” or “Soporte Técnico en Español.” Create the files using the recording tool of your choice.

When recording your files, follow these rules:

- The media files must be in wave (.wav) format. Your wave files must match Unified CVP encoding and format requirements (G729, CCITT G.711 A-Law and U-law 8 kHz, 8 bit, mono).
- To avoid cutting off files when they are played, make sure they do not exceed the Whisper Announcement play limit (15 seconds).
- Test your audio files. Ensure that they are not cut off and that they are consistent in volume and tone.
- To reduce the likelihood of scripting errors, decide ahead of time on a file-naming convention that is easy for you and others to remember. For example, en_sales.wav, sp_support.wav.

Deploy Whisper Announcement Audio Files to Media Server

Deploy your whisper audio files to your Unified CVP media server using whatever file-transfer method you prefer. The most important consideration is where on the server to place the files. HTTP requests for media server audio files are constructed as


The CVP defaults for the locale and application directories are en-us/app. Unified CCE automatically adds en-us/app to the server name when making HTTP requests for media files.

For example, if:

- The script node that defines the media server has a value of http://myserver.mydomain.com and
Thescript nodethat defines the audio file to play has a value of en_sales.wav

Then the HTTP request for the file is automatically constructed as

If you store your files in a different locale and application directory, your routing scripts must include variable nodes that define those alternate locations. Make note of the directories in which you place your files and communicate the locations to your script authors.

Make sure that the directories in which you deploy your files have the appropriate permissions to allow Read access.

**CVP with the Streaming Audio (Helix) and Whisper Announcement**

You must set the `user.microapp.media_server` variable, to point to the whisper announcement .wav file, for the CVP Whisper Announcement feature to work while Streaming Audio feature (using Helix) is also on. This is achieved by setting the `Call.WhisperAnnouncement` variable to the complete URL of the whisper announcement wav file. The `Call.WhisperAnnouncement` variable should be put in using the http://<mediaserverio>:80/en-us/app/XXX.wav URL format.

**Using a Default Media Server**

Optionally, CVP lets you define a default media server. (You do this in the CVP Operations Console; see your CVP documentation for more information.) If a default media server is defined in CVP, script authors need not identify the media server in their call routing scripts provided the files that they request are available from that server.

**Configure the Whisper Announcement Service Dialed Numbers**

Unified CVP uses two different dialed numbers for Whisper Announcement:

The first number calls the ring tone service that the caller hears while the whisper plays to the agent. The Unified CVP default for this number is 91919191.

The second number calls the whisper itself. The Unified CVP default for this number is 9191919100.

For Whisper Announcement to work, your dial number pattern must cover both of these numbers. The easiest way to ensure coverage is through the use of wild cards such as 9191*. However, if you decide to use an exact dialed number match, then you must specify both 91919191 and 9191919100.

**Configure Dialed Numbers**

You configure the dialed numbers for Whisper Announcement in the Unified CVP Operations Console at **System > Dialed Number Pattern > Add new**. For the Dialed Number Pattern Types, select `Enable Local Static Route`. Once `Enable Local Static Route` is checked, select either `Route to Device` or `Route to SIP Server Group` for VXML gateways. Then save and deploy the dialed number.

It may be necessary to override the dialed number plan for the default Whisper DN, if the default DN conflicts with the overall dial number plan.

**Change the Whisper Announcement Default Dialed Number**

To override the DN pattern from the SIP subsystem level in CVP OAMP:
Procedure

Step 1  Select Device Management > Unified CVP Server.
Step 2  Select the Call Server on which to override the default whisper DN.
Step 3  Select the SIP tab.
Step 4  Override the default value of 91919191 configured under the DN on the Gateway to play the ringtone field.
Step 5  Click Save & Deploy.

Configure Unified CCE

Create Whisper Announcement Script

It is very important to deploy Whisper Announcement with the Call. Whisper Announcement variable and to set .wav file in your Unified CCE routing scripts.

Specify Whisper Announcement Call Variable

To include Whisper Announcement in a script, insert a Set Variable node that references the Whisper Announcement call variable. The Whisper Announcement variable causes a whisper to play and specifies the audio file it should use. Typically, you use a single whisper prompt for a single call type. As a result, you use only one Whisper Announcement set node for each script. However, as needed, you can set the variable at multiple places in your scripts to allow different announcements to play for different endpoints. For example, for skills-based routing, you can specify the variable at each decision point used to select a particular skill group or Precision Queue.
Only one Whisper Announcement can play for each call. If a script references and sets the WhisperAnnouncement variable more than once in a single path through a script, the last value to be set is the one that plays.

Use these settings in the Set Variable node for Whisper Announcement:

- **Object Type:** Call.
- **Variable:** Must use the WhisperAnnouncement variable.
- **Value:** Specify the filename of the whisper file. For example: “my_whisper.wav” or “my_whisper”.
  - Specify the filename only, not its path.
  - You must enclose the filename in quotation marks.
  - The filename is not case sensitive.
  - The filename cannot include spaces or characters that require URL encoding.
  - The `.wav` extension is optional. If you omit it, Unified CVP adds it automatically in the HTTP request.

### Specify Unified CVP Media Server Information

If you define a default media server in your CVP Operations Console and it is the server from which you serve your whisper files, then you need not specify the media server in your routing scripts. However, if you do not define a default media server, or if you store your whisper file on a server other than the default, then your scripts must include a Set Variable node that identifies that server.

To specify your media server, use the following settings in the Set Variable node:

- **Object Type:** Call.
- **Variable:** Must use the user.microapp.media_server ECC variable.
- **Value:** Specify the HTTP path to the server. For example: “http://myserver.mydomain.net.” You must enclose the path in quotes.
- Alternately you can specify an IP address in place of a DNS. Include the listening port number if the media server web server listens on a port other than 80 (for HTTP) or 443 (for HTTPS).

### Specify Whisper File Locale and Application Directories

CVP uses a default storage directory for media files: `<web_server_root>/en-us/app`. To take advantage of this, Unified CCE call routing scripts automatically add “en-us/app,” to the server name when constructing HTTP requests for media files. For example:

- If the script node that defines the media server has a value of “http://myserver.mydomain.com” and...
- The script node that defines which audio file to play has a value of “en_sales.wav,” then...
- The HTTP request for the file is automatically constructed as

Specify Locale Directory

If your whisper audio files are stored in a different locale directory, you must add a Set Variable node to your script that identifies the locale directory. Similarly, if your whisper files are stored in a different application directory, you must add a Set Variable node that identifies that directory.

Specify Locale Directory

Use these settings in the Set Variable node to specify your locale directory:

- **Object Type**: Call.
- **Variable**: Must use the `user.microapp.locale` ECC variable.
- **Value**: Specify the directory name. For example: “pt-br,” You must enclose the path in quotes.

Specify Application Directory

Use these settings in the Set Variable node to specify your application directory:

- **Object Type**: Call.
- **Variable**: Must use the `user.microapp.app_media_lib` ECC variable.
- **Value**: Specify the directory name. For example: to use a directory “wav_files” in place of the default directory “app,” enter “wav_files.” To use a sub-directory “wav_files” “app,” enter “app/wav_files.” You must enclose the path in quotes.

Variable Length for Media Server Locale and Application Directory Variables

If you do include Set Variable nodes for the media server, locale, or application directories, ensure that the values you set for them do not exceed the Maximum Length settings for their corresponding ECC variables.

For example, if you include a Set Variable node for the media server with a value of “http://mysubdomain.mydomain.co.uk,” the string is 33 characters long. Therefore, the Maximum Length setting for the `user.microapp.media_server` ECC variable must be 33 or greater. If it is not, you must increase the Maximum Length setting. Otherwise, the server name is truncated in the HTTP request for the file and the file is not found. You configure ECC variables in the Unified CCE Configuration Manager at List Tools > Expanded Call Variables List.

Specify Whisper File Locale and Application Directories

CVP uses a default storage directory for media files: `<web_server_root>/en-us/app`. To take advantage of this, Unified CCE call routing scripts automatically add “en-us/app,” to the server name when constructing HTTP requests for media files. For example:

- If the script node that defines the media server has a value of “http://myserver.mydomain.com” and...

- The script node that defines which audio file to play has a value of “en_sales.wav,” then...

- The HTTP request for the file is automatically constructed as


If your whisper audio files are stored in a different locale directory, you must add a Set Variable node to your script that identifies the locale directory. Similarly, if your whisper files are stored in a different application directory, you must add a Set Variable node that identifies that directory.
Specify Locale Directory

Use these settings in the Set Variable node to specify your locale directory:

- **Object Type:** Call.
- **Variable:** Must use the user.microapp.locale ECC variable.
- **Value:** Specify the directory name. For example: “pt-br,” You must enclose the path in quotes.

Specify Application Directory

Use these settings in the Set Variable node to specify your application directory:

- **Object Type:** Call.
- **Variable:** Must use the user.microapp.app_media_lib ECC variable.
- **Value:** Specify the directory name. For example: to use a directory “wav_files” in place of the default directory “app,” enter “wav_files.” To use a sub-directory “wav_files” “app,” enter “app/wav_files.” You must enclose the path in quotes.

Variable Length for Media Server Locale and Application Directory Variables

If you do include Set Variable nodes for the media server, locale, or application directories, ensure that the values you set for them do not exceed the Maximum Length settings for their corresponding ECC variables.

For example, if you include a Set Variable node for the media server with a value of “http://mysubdomain.mydomain.co.uk,” the string is 33 characters long. Therefore, the Maximum Length setting for the user.microapp.media_server ECC variable must be 33 or greater. If it is not, you must increase the Maximum Length setting. Otherwise, the server name is truncated in the HTTP request for the file and the file is not found. You configure ECC variables in the Unified CCE Configuration Manager at List Tools > Expanded Call Variables List.

Test Whisper Announcement File Path

To test the path to the whisper file that you defined in your script variables, enter the complete URL into a browser. The .wav file should play. For example:

- If your script includes: default media server + default locale + default application directory + whisper.wav, then the path is “http://<default_media_server>/en-us/app/whisper.wav”

- If your script includes: http://my_server.my_domain.com + default locale + “app/wav_files” + whisper.wav, then the path is “http://my_server.my_domain.com/en-us/app/wav_files/whisper.wav”

Other Script Settings That Are Required for Whisper Announcement

These additional settings are required for Whisper Announcement to work:

- Enable Target Requery on all script nodes that follow the WhisperAnnouncement variable and target an agent. These include Queue (to Skill Group or Precision Queue), Queue Agent, Route Select, and Select. If Target Requery is not enabled, the Whisper Announcement does not play.

- When you run an agent transfer or a conference script, use a SendToVRU, a TranslationToVRU, or a Run Script Request node before you target an agent.
Fail-Safe Timeout for Whisper Announcement in Unified CCE

Unified CVP sends one message to Unified CCE each time a Whisper Announcement begins and a second message when the announcement ends. The time stamps from these messages are used to calculate Whisper Announcement data in Unified CCE reports.

If Unified CVP fails to send a Whisper Announcement end message to Unified CCE, the following occurs:

- Unified CCE cannot accurately calculate the whisper length, thus skewing report data.
- The agent cannot control the call (for example, put it on hold or transfer it) because these controls are disabled while a Whisper Announcement is playing.

To prevent this, Unified CCE has a Whisper Announcement timeout setting. The value for this setting represents the maximum Whisper Announcement play time that Unified CCE uses to calculate its report data.

The default is 20 seconds. This default is based on the default Whisper Announcement play time (specified in Unified CVP) of 15 seconds. The extra 5 seconds in the Unified CCE fail-safe timeout is a buffer against latency. If you modify the maximum Whisper Announcement play time in Unified CVP, modify the Unified CCE Whisper Announcement fail-safe timeout accordingly.

The Unified CCE Whisper Announcement fail-safe timeout value should be equal to or greater than the maximum Whisper Announcement play time setting in Unified CVP. Otherwise, Whisper Announcement play time in Unified CCE reports are under-reported.

To change the fail-safe timeout value, complete the following steps for the Unified CCE peripheral by using the PG explorer tool:

**Procedure**

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>In Unified CCE Configuration, select <strong>Tools &gt; Explorer Tools &gt; PG Explorer</strong>.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Click <strong>Retrieve</strong> to return a list of PGs (Peripheral Gateways).</td>
</tr>
<tr>
<td>Step 3</td>
<td>Double-click the agent PG to expand it, and select the peripheral with client type <strong>CUCM</strong> or <strong>UCCE system</strong>.</td>
</tr>
<tr>
<td>Step 4</td>
<td>On the <strong>Peripheral</strong> tab, enter the following text in the <strong>Configuration Parameters</strong> field:</td>
</tr>
<tr>
<td></td>
<td>/WHSTMOUT &lt;value in seconds&gt;</td>
</tr>
<tr>
<td>Step 5</td>
<td>Once you are finished, click <strong>Save</strong>.</td>
</tr>
</tbody>
</table>

Whisper Announcement Sample Scripts

Unified CCE includes sample routing scripts that demonstrate Whisper Announcement. You can use them as learning tools and as models for your own Whisper Announcement scripts. They are the following:

- **WA.ICMS**—This script plays a Whisper Announcement.
- **WA_AG.ICMS**—This script plays both a Whisper Announcement and an Agent Greeting to play on the same call flow.

The script files are located in the **c:\icm\bin** directory. In Unified CCE Script Editor, they are installed to the application root directory.
To use these scripts you must have a default media server configured in Unified CVP, and have the Whisper file stored in the default location on the media server. For that reason, they do not include variables that specify the media server, locale, or application directories.

**WA.ICMS Script**

This script sets up a Whisper Announcement by setting the Whisper Announcement variable to the desired wave file and then queuing the call to a skill group or Precision Queue. After an agent is selected from the skill group or Precision Queue and the call routed to the agent, the whisper plays to the agent.

**WA_AG.ICMS Script**

This script causes both a Whisper Announcement and an Agent Greeting to play.

**Import Sample Whisper Announcement Scripts**

To view or use the sample Whisper Announcement scripts, you must first import them into Unified CCE Script Editor. Follow this procedure to import the scripts:
## Procedure

**Step 1** Open Script Editor.

**Step 2** Select File > Import Script and select the first of the two scripts to import.

In addition to importing the script, Script Editor tries to map imported objects. Some objects that are referenced in the sample scripts, such as the external Network VRU scripts or the skill groups or Precision Queues, do not map successfully. You must create these maps manually or change these references to point to existing Network VRU scripts, skill groups, and Precision Queues in your system.

**Step 3** Repeat steps 2 and 3 for the remaining script.

## Reporting and Serviceability

Whisper time is not specifically broken out in Unified CCE reports. In agent, skill group, and Precision Queue reports, the period during which the announcement plays is reported as Reserved agent state time. In the Termination Call Detail records, it is treated as Ring Time.

Serviceability for Whisper Announcement includes system events to indicate reasons for Whisper Announcement failures and counters to track the number of failed whisper events.

## Component Failure and Whisper Announcement

### Failure to Access CVP Media Server

If the connection to the CVP media server fails, or if a requested whisper audio file cannot be found, the call proceeds normally without Whisper Announcement.

## Whisper Announcement in Agent Desktop Software

No configuration is needed to integrate Whisper Announcement with agent desktop software. While a whisper is playing, software on the agent desktop shows the call in the Ring state. Desk phones show the call in the Talking state.

## Using Agent Greeting with Whisper Announcement

You can use Agent Greeting along with the Whisper Announcement feature. Consider the following when you use them together:

- On the call, the Whisper Announcement always plays first before the greeting.

- To shorten your call-handling time, you may want to use shorter whispers and greetings than you might if you were using either feature by itself. A long whisper followed by a long greeting means a long wait before an agent handles a call.

- Usually, agents that use Whisper Announcement handle different types of calls: for example, "English, Gold Member, Activate Card, Spanish, Gold Member, Report Lost Card, English, Platinum Member,"
Account Inquiry." Ensure the greetings your agents record are generic enough to cover the range of customer calls they handle.
Using Agent Greeting with Whisper Announcement